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Chapter 1. Introduction

This document demonstrates how you can use the WebSphere Adapter for SAP Software could be
used to provide business integration connectivity to SAP systems.

The BAPI outbound sample demonstrates how the WebSphere Adapter for SAP Software can be
used to discover BAPI objects from SAP systems and create Business Objects corresponding to
them. The sample shows how to generate a SCA component and, once deployed, how to invoke it
to create a Customer object in SAP by invoking the BAPL

The ALE Inbound sample demonstrates how the WebSphere Adapter for SAP Software can be
used to receive events from the SAP EIS by taking a sample IDoc in to consideration. The sample
scenario shows how to configure the adapter as an SCA component and, once deployed, how to
configure an endpoint to receive a SAP invoked IDoc asynchronous event.

The Structured Query sample scenario demonstrates a query object being created and query data is
sent to SAP (Outbound process) and receive a response as a result set based on the query.

Additional scenarios such as BAPI Work Unit, ALE Outbound and ALE inbound for a non-split
IDoc are provided explaining about a few scenarios related to ALE and BAPI interfaces.
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Chapter 2. Hardware and software
prerequisites

Please refer to the following link for a listing of hardware and software requirements to run the
WebSphere Adapter for SAP Software

IBM WebSphere Adapter for SAP Software HW/SW requirements
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Chapter 3. Installing the adapter

WebSphere Adapters are packaged along with products like WebSphere Integration
Developer and Rational Application Developer. When used with WebSphere
Integration Developer, the adapter Resource Archives(RAR) can be located at

<WID_installation> | Resource Adapters/ SAP_7.0.0.0 directory.

Note:

The Resource Archive file (RAR) file has support for running the New External Service wizard as
well as to process requests coming into the SCA module.

Use the CWYAP_SAPAdapter.rar file if you want to perform ALE, BAPI, SQI & AEP
processing without Local Transaction support. When using the RAR without Local Transaction
support, the adapter is in an auto-commit configuration.

Use the CWYAP_SAPAdapter_Tx.rar file if you want the container (WebSphere Process Server)
to appropriately invoke the commit and rollback methods implemented for the Local Transaction
support in the adapter. This is applicable for BAPI transaction and ALE outbound transaction
processing scenarios. When using this RAR, the adapter is capable of participating in Local
Transactions managed by the container.

The CWYAP_SAPAdapterExt.jar file available at
<WID_installation> | Resource Adapters/ SAP_7.0.0.0/ ext contains the JCo 3 provider implementation
for use by the adapter

UNIX® and Windows platforms share the same installed directory and file structure, with the
only difference being the directory path designation (forward slash ¢/” for UNIX, backslash “\” for
Windows).

Deployment prerequisites
You must install these products before you can deploy the adapter:
WebSphere Integration Developer7.0 (WID)
WebSphere Process Server 7.0 administrative console

For WebSphere Process Server installation instructions, see the WebSphere Process Server
documentation.
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After you complete these steps, make sure you have the following information with you to access
the SAP application:

SAP User Name

SAP Password
SAP Host name (or IP address)
SAP System number (usually 00)

SAP Client number (usually 100)

Obtain the SAP JCo3 from SAP Marketplace at https://websmpl01.sap-ag.de/ . Please
obtain the userID/Password for this URL from your BASIS respectively.

Configuring the Authentication Alias on the process server

Before you install an application onto WebSphere Process Server, you must create an
Authentication Alias for use with your SAP instance. Once an Authentication Alias has been
created, other SAP application project modules can use it as well.

Starting the WebSphere Process Server Administrative console:
Open the Business Integration perspective in WebSphere Integration Developer.

Under the Server tab right click on your server instance, for example, WebSphere Process Server
v7.0>Administration and select Run administrative console.

ﬁﬂ View and publish the changes to the server

Server configuration +
Universal test dient r
Launch WebSphere administration command

Add and Remove Integration Solution Projects Run administrative script...

Properties Alt+Enter —

¥
¥
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In the administration console of WebSphere Process Server, click Security > Global Security.

Select Java Authentication and Authorization Service > J2C authentication data.

Security Configuration Report |

Authentication

ive user roles Authentication mechanisms and expiration
ive group ral
ive group roles ® LTeA

ive authentication
Kerberos and LTPA

Kerberos configuration

D SwWaM (deprecated): No authenticated communication bel

Authentication cache settings

Web and SIP security
55 to local resources

RMI/IIOP security
permissions

| data E Java Authentication and Authorization Service

Application legins
System logins
J2C authentication data

D Use realm-gqualified user names

In the Authentication column, if an alias named SAP_Auth_Alias does not already exist, create
it now.

Click New. The General properties screen appears.
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Global security T =

Global security > JAAS - 12C authentication data
> New

Specifies a list of user identities and passwords
for Java(TM) 2 connector security to use.

General Properties

* Alias

* User ID

* Password

Description

Apply I OK| | Reset Cancel

In the Alias field, specify SAP_Auth_Alias (Remember this authentication alias can be used while
generating inbound\outbound setvices using the adapter ).

Specify the User ID and password that are required to connect to the SAP system.

Click OK.

Click Save.
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Chapter 4. Tutorial 1: Retrieving data from
SAP (outbound processing) using
the simple BAPI Interface

Business Case

A Customer Relationship Officer needs to retrieve a customer’s information from
the SAP server after being notified of a customer complaint raised on the Customer Services
Portal.

Scenario

The following scenario illustrates a simple BAPI outbound processing using
Synchronous RFC calls.

Customer Services Portal L

ustomer Services Porta ‘\O\’ %
Y \‘*’ A

L ] 9

Officer
A4

SAPOutboundlinterfacelmport

A 4

WebSphere Adapter for SAP

L o

SAP

Figure: Scenario illustrating simple BAPI outbound processing
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1. The Customer Services portal notifies the Officer of a new complaint.

2. The Officer logs into the Customer Services portal and requests details of the
customet.

3. The Customer Services portal will in turn invokes an SCA module using the
WebSphere Adapter for SAP Software to execute the
BAPI _CUSTOMER_GETDETAIL BAPI.

L. The adapter module receives a request from the client
application in the form of a
BAPI_CUSTOMER_GETDETAIL Business Object.
The adapter sends this data to SAP server.

1. The adapter then converts the data in the Business Object
into a native BAPI object and sends it to the SAP server.

4. The SAP server responds with the details of the customer in native object format.

The adapter handles the response from SAP, converts it into a Business Object
format as required by the client application and is returns the response.

6. The Customer Services portal returns the response to the officer.

Configuration prerequisites
You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector interface is an external dependency that the adapter requires in
order to connect to the SAP systems. The adapter uses SAP JCo to call to the SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library interface to the
imported project. You must copy all external libraries and JAR files must first be copied to the
appropriate locations on WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTALL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
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Copy the sapjco3.jar file to the <WPS_INSTALIL>/lib ditectory.

When working with WebSphete Process Server on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.
<WPS_INSTALIL> represents the WebSphere Process Server installation directory.
Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTAILIL>/lib directory.
When working with WebSphere Application Server on z/OS, add
${WAS_INSTALL _ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY_server_region_classpath

<WPS_INSTAILIL?> represents the WebSphere Process Server installation directory.

Configuring the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration to
be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration.
Start the New External Service wizard by choosing: File-> New -> External

1. Select Adapters > SAP in the Select the Service Type of Registry screen and click
Next.
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&+ New External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: | type filter text

¥

Available Types:

=@ Adapters

o CICS

B E-mail

Flat File

ftp FTP

I IMS

Ei iseries

JOE 1D Edwards
[@ JoBC

E Lotus Domino
Eﬁé Oracle

& Peoplesoft

‘o Siebel

—

(>

[ £

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding, During outhound processing, services running on WebSphere

Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the

SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

I3

I Cancel

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) in the Select an Adapter screen and click Next.

&= New External Service

Select an Adapter
Select the adapter you want to use,

-~
‘:J

o

E

@p IEM WebSphere Adapter for SAP Software (IEM : 7.0.0.0)

IBM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction support

7 [ < Back H Mex{z l Finish
W

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the
current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3. Specify a Connector Project name in the Import a RAR File screen and
click Next.

&= New External Service El[z|
I

Import a RAR File

Import a resource adapter archive (RAR) from the file system to create a connector project for the @ l
adapter. A

Archive file; CWIDT\ResourceAdapters\SAP_7.0.0.0VCWYAP_SAPAdapter_Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |

Target runtime enviroment: |'|."'.|'EI:|5|:-herE Process Server w7.0 b |

® e |

Figure: Import a RAR file screen




WebhSphere. Bl E (=

4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

# New External Service

Locate the Required Files and Libraries (T‘-\
Connector projects require system-spedific libraries and JAR files.
When deploving the application to a stand-alone server, these files must be configured on the server, Mare ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo \sapico-nintel-3.0. 3\sapjco3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo \sapjco-nintel-3.0, 3sapjca 3. dil | [Brnwse... ]

® = JHT]

5. Click Next.

0. In the Select the Processing Direction screen, select the Outbound radio button and click
Next.
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#= New External Service |Z|E]

Select the Processing Direction

Select the direction of adapter processing at run time,

) Inbound

>

(*) Outbound

=

7 = Back ]MEH =

—
L

Inbound processing passes data from the adapter to yvour service expart.

Quthound processing passes data from your service import to the adapter.

Cancel

Setting connection properties for the New External Service wizard

You must provide the following information in the Discovery Configuration screen:

User name

Password

Host name

System number

SAP Client connection

Click Select to change the default Language code from English
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Use the drop down option to change the default Code page from 1100.
Select BAPI as the SAP Interface name.

Click Next.

# New External Service

Specify the Discovery Properties —

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (English) | | select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srhandur |
Password: = | e |
SAP interface name: | NN - |

[ ] change the logging properties for the wizard

@ <gack || next> | Enish
Ml

Figure: Select BAPI asthe interface

Selecting the Business Objects and services to be used with the adapter

1. In the Find objects in the Enterprise System screen, click on RFC node. Then

—*|
. 2,
click the #" button to enter a filter.
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# Mew External Service

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects. Use filtering, if necessary, to ::LJ
limit number of objects displayed. o

Discovered objects: Selected objects:

&) rFC
8 BOR

Cancel

Figure: Object Discovery and Selection

2. Enter BAPI_ CUSTOMER_GET* (the name of the BAPI in SAP plus an asterisk as a wild card
character) in the Filter Properties for ‘RFC’ screen.

#= New External Service

Filter Properties for "RFC’ 1
Specify the properties. [
Object attribute to use for discovery: |Disc-:u~.rer objects by name A |
Find objects with this pattern: = | BAPI_CUSTOMER _GET* |
Maximum number of objects to retrieve: | 25 A |
@ l Ok ] [ Cancel ]

Figure: Filter Propertiesfor RFC
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3. Click OK.

4. Expand the RFC node.

4= Mew External Service

Find Objects in the Enterprise System
The default number of objects to retrieve is 25. To retrieve more objects, select ::L-_J
the filter icon to change the default setting. o
Discovered objects: Selected objects:
—+|
v

ERGNRFC (filtered)
(D) BAPI_CUSTOMER_GETCONTACTLIST
(0) BAPI_CIUSTOMER_GETDETAIL
(@) BAPI_CUSTOMER_GETDETAILL 1
(@) BAPI_CUUSTOMER_GETDETAILZ
(@) BAPI_CUSTOMER_GETINTNIUMBER
(@) BAPI_CUSTOMER_GETLIST
(@) BAPI_CUSTOMER_GETPWREG
(@) BAPI_CUSTOMER_GETSALESAREAS
(@) BAPI_CUUSTOMER_GET_CHILDREN
(0) BAPI_CUUSTOMER_GET_ROOT
(@) BAPI_CUUSTOMER_GET_ROOT_LIST
3 BOR

=

=

®

Figure: Retrieved BAPIs based on search criteria

5. Select the BAPI_CUSTOMER_GETDETAIL from the metadata tree.

6. Click the Z==i button.

7. A popup will appear containing the Configuration properties for the
BAPI_CUSTOMER_GETDETAIL object.

8. Check the Use SAP filed names to generate attributes names checkbox if you want the
Business Object attribute names to be generated using SAP field Names.
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9. You can choose to create attributes in the Business Object for any optional parameter in the
BAPIL.

Click OK.

d= New External Service El

Configuration Properties for 'BAPL_CUSTOMER_GETDETAIL"
e
Specify configuration properties for the selected object. "\_:;"

Attribute names of discovered objects can be generated from either SAP field names or from SAP field descriptions, which are
more understandable,

[ ]Use SAF field names to generate attribute names

The selected ohject has optional RFC import, export, or table parameters. If selected, the optional parameters will be
generated as child objects of the selected object.

—+l

T

= 8 Cntional parameters
< Optional impart parameters
[] < oOptional export parameters

[ Select All ][Deselect .-5.III

@ [ o»g%_][ Cancel |

Figure: Setting configuration parameters for the BAPI selected

10. Click Next.

Generating Business Object definitions and related artifacts

In the Specify Composite Properties screen, you can enter a business object folder name where the
Business Objects should be created instead of the default location.

Enter bodefs as the folder name.
Check the Generate BAPI Business Objects within a wrapper.
Enter Cust_GetDetail in the Business object for service operations field.

Under Service Operations, click Add and add the Retrieve operation.
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#+ Mew External Service

Specify Composite Properties
Specify properties that apply to all selected objects. |

Select the checkbox option to generate BAPI business objects contained in a wrapper. You are allowed
to configure @ maximum number of four BAPI business objects. If you do not select this option, top-evel
business objects are automatically generated for each BAPI selected and the adapter internally assigns
the Execute operation to it. There is no limit on the number of BAPI business objects that you can
configure.

Generate BAPI business objects within a wrapper

Business object namespace: = | http:waw.il:nm.camfxmlnsfprn:-dﬁnehspﬂ

Specify the relative folder for the generated business object:
Folder: | bodefs |

[ ]Enable dynamic authentication function

SAP Remote Function Call (RFC) type: |Synchru:unu:uus RFC w |

|:| Ignore errors in BAPI return object
Map service operations to RFC functions

Business object name for service operations:= | Cust_GetDetail |

Service operations: ™

Add...

RFC function for selected operation: BAPI_CUSTOMER _GETDETAIL W

@ | <Back || met> | mnien

M

Figure: Specify Composite Properties

Click Next.

In the Service Generation and Deployment Properties screen, enter the connection properties
and deployment properties.
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&+ New External Service

Specify the Service Generation and Deployment Properties
Specify properties for generating the service and running it on the server, "'\:)

>

Service Operations

Tg mod_iﬁ-' the names, or add a description to the operations to be generated in the interface file, Edit Operations. ..
dick Edit Operations.

Deployment Properties
How do you want to specify the security credentials?
(") Using an existing JAAS alias {recommended)

{(*) Using security properties from the managed connection factory:

The properties will be stored as plain text; no encryption is used.

User name: * | srnandur |

Pzl o [ |

() Other

The quality of service to join the transaction provides a higher dearee of data intearity, espedally in the event of &
failure. As the adapter only supports local transactions, it must be the only one phase commit capable resource in
the transaction. Mare ...

Join the transaction {recommended)

Deploy connector project: |'u."'.n'iﬂ'| module for use by single application A

Specify the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection information
[]use load balanding

To use load balancing, specify the load balancing properties in the Additional connection configuration
panel under the Advanced tab. =,

Host name: = | owd31.svl.ibm.com |

System number: | 01 |

Client: | 100 |

Language code: | EM (English) | lSelect... ]

Code page: | 1100 w |

[ %

@ | <sack | Wt > | | Enih

Figure: Service Generation and Deployment Confignration
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Note: You can either the user can enter an Authentication Alias previously created using the
Administrative Console of the WebSphere Process Server or simply enter the username and

password used to login in to the SAP system.

Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field

to create a new module.

When the New Business Integration Project screen appears, select the Module radio button

and click Next.

4= New Business Integration Project

Select a Business Integration Project Type
Select the type of business integration project that you want to create.

") Mediation module

|

/A

IUse a madule to integrate business applications and services. A module
can contain any type of companent and can be deployed on WebSphere
Process Server. More...

IUse a mediation module to integrate and connect services. A mediation
module can contain mediation flows and can be deployed on WebSphere
ESE or WebSphere Process Server, Mare...

In the New Module screen, type BAPI_CUST_GETDETAIL in the Module Name field, and

then click Finish.
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& New Module

Create a Module

IJse @ module to integrate business applications and services. A module can
contain any type of companent and can be deployed on WebSphere Process

Module name: | BAPI_CUST GETDETAILL

Lse default location

Open module assembly diagram

l [ Cancel

Click Finish on the Specify the Location Properties screen.
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&= New External Service

Specify the Location Properties Al
Specify location properties for where you want to save the service, [DJ

Properties for service

Module: | BAPI_CUST_GETDETAL v | [new... |

Use default namespace

Folder: | | [ Browse... ]

Mame: ® | SaPOuthoundInterface |

[ ]5ave business objects to a library

Description: |

®

[ Ff=ish l [ Cancel
L4

Verify the results.
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ERE62P1_CUST_GETDETAIL |

= '?8] Assembly Diagram
E_ﬁ? SAPCQuthoundInterface
ﬂ Dependencies
E’ Integration Logic
= ._'n) Data Types
== bodefs
| SapBapiCustomerGetdetail
| SapCust_GetDetailVWrapper
[ SapPeAddress
I':] SapReturn
-l DuplicateRecordFault
=l InvalidRequestFault
(2] MatchesExceededLimitFault
= MissingDataFault
| MultipleMatchingRecordsFault
I':I PrimarykeyPairType
[Z] RecordNotFoundFault
(2] WEIFault
= .j' Interfaces
@ SAPQuthoundInterface
E Transformations

Figure: Artifacts created after the EMD run for the Smple BAPI Module

Deploying the module in the test environment
After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration

Developer’s Test Client.

Right click on your server node in the Server tab and add the module
BAPI_CUST_GETDETAIL by selecting Add and Remove Projects.

The project BAPI_CUST_GETDETAILApp will be listed under Available projects.
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4= Add and Remove Projects

Add and Remove Projects
Madify the projects that are configured on the server
[==]

Maove projects to the right to configure them on the server
Available projects: Configured projects:

-5 BAPI_ADDRESS_UPDATE_WORKUNITApD
(B BAPI_CUST GETDETAIL_INApp

ISNBAPL CUST GETDETAILApp 49>
-(F BAPL_CUSTOMER_GETDETAIL_AliasApp
- (& BAPI_GET_DETAIL_RESULTSETApp

B EE-E-E

|
m

[ Add All >>

If server is started, publish changes immediately

@ Bac et Finish l ’ Cancel

Click on the project name and Add it to the list of Configured Projects. Click Finish to deploy
the SCA module.

4~ Add and Remove Projects

Add and Remove Projects =
Modify the prajects that are configured on the server —

Mave projects to the right to configure them on the server
Available projects: Configured projects:

-(F BAPI_ADDRESS_UPDATE_WORKUNITApD B (5 BAPT CLST GETDETALADD
{5 BAPL_CUST GETDETAIL INApp

{F BAPL CUSTOMER_GETDETAIL_AliasApp
-(F} BAPL_GET DETAIL RESULTSETApp

WO

[ Add All 3> |

[ << Remove All ]

If server is started, publish changes immediately

@ < Back lext | Finiﬁ [ Cancel
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Testing the assembled adapter application

Test the assembled adapter application using the WebSphere Integration Developer integration
test client.

1. After you have deployed the module to the server, right click the module
BAPI_CUST_GETDETAIL in the Projects view and select Test > Test Module from the pop-

up menu.

2. Enter values in the Test Client as shown in the following figure.

= 8
Mame Value
= %g retrieveSapCust_GetDetailWrapperInput L fad
= %g SapBapiCustomerGetdetail L
i} CustomerToBeRequired * ' 0000000001
T pistributionChannel ¥ 01
I Division ¥ 01
[ PassBuffer v
[ SalesQrganization = + 001 B
= %g SapPeAddress v
) FormOfAddressForContactPersonMrMrsEtc v
[ Firstiame v
1 Name1 L
1 Name3 L
1 Namea v
1 DateOfBirth ' 2009-10-03+0530
[ HouseNumberaAndstreet v
1 PostalCode Pos v b

| ™

Figure: Entering the Input values

3. Click the Continue button B .

When the Select Deployment screen appears, select the WebSphere Process Server to which you
added the project and click the Finish button.

4. If security is enabled, type in the username and password in the popup User Login screen that
appears and click OK.




4= User Login - Default Module Test

Sign in to continue the test,
User ID:*

Security is enabled on the selected runtime environment{s).

| Edrmin

Password: *

[ Juse the authentication settings in the preference and never ask again

[ O, ][ Cancel ]
M

5. Check the output of the service in the test client.

ue Editor | XML Source |

EE= =
Mame | Type Value
= ri.'|:= retrieveSapCust GetDetailWrapp... | SapCust_GetDetalWwrapper « el
IE!%; SapBapiCustomerGetdetail SapBapiCustomerGetdetail «
i CustomerToBeRequired CustomerToBeRequired <string = H,
1 DistributionChannel DistributionChannel <string > H,
I Division Division<string > H,
1 PassBuffer PassBuffer <string = H,
-1 salesOrganization SalesOrganization <string = H,
EI %: SapPeAddress SapPeAddress «
N 1 FormOfaddressForConta FormOfaddressForContactPersonMrMrsE...  « Mr.
Firstiame <string = « NX33
Mame 1<string> « IBM
Mame3<string > H, =
Mame4-<string = H,
date L
HouseMumberAndStreet<string > ' 577 airport blvd
PostalCode <string = + 20108
City <string=> H,
II_I RegionStateProvinceCou RegionStateProvinceCounty <string > + CA
II_I Countrykey Country <string > + LS
[ FieldForDismantingCount FieldForDismantingCountrylsoCodeFields... #e
[ FieldForDismantingCount FieldForDismantingCountrylsoCodeFields... #e
[ InternetAddressOfPartne InternetAddressOfPartnerCompanyClerk... #e L
1 FaxMumber FaxMumber <string = H,
[ FirstTelephoneMumber  FirstTelephonetumber <string = H,
1 SecondTelephoneMumber SecondTelephonelumber <string = H,
II_I Languagekey Languagekey <string > + E
II_I LanguageAccordingTolsc LanguageAccordingTolso639 <string = + EM
II_I Currencykey Currencykey <string > H,
II_I IsoCodeCurrency IsoCodeCurrency <string = B
[ CountryIsaCode CountrylsoCode <string = + LS
F— L

B

0. Check that the data retrieved in the Test Client matches your EIS data.

7. Login to the SAP GUI using the credentials for the given SAP server

8. Open the BAPI Explorer (tcode — se37)
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9. Enter the BAPI name BAPI_CUSTOMER_GETDETAIL in the Function Module field,
10. Press F8 to execute the BAPI.

11. Enter the values provided in step (2) above for Test Function Module: Initial screen, under
Import parameters

12. Press I8 to Execute the BAPI using the values that are entered.

13. Check that the values in Export Parameters in the Test Function Module: Result screen
and match the values returned in step (5) above

To read the documentation pertaining to any BAPIL.

1. Open the BAPI Explorer using tcode — se37.

2. Enter the name of the BAPI in the Function Builder: Initial Screen.
3. Click Display.

4. Click Function Module Documentation or press Ctrl + F4

Clearing the sample content

No clean up is required after this tutorial.
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Chapter 5. Tutorial 2: Updating data in SAP
(outbound processing) using the
BAPI Work Unit Interface

Business Case

A Manager has to update an employee’s address in an SAP system when informed of

a change.

Scenario

The following scenario illustrates outbound processing of BAPI units of work. A
BAPI work unit consists of a set of BAPIs that are processed in sequence to complete a task.

— 0
HRMS Portal — o —
\
3 x’ AN
o Vo Manager

SAPOutboundinterfacelmport

A 4

WebSphere Adapter for SAP

SAP

Figure: Scenario illustrating BAPI Work Unit outbound processing

1. The HRMS portal notifies the Manager with the details of the address change of an employee
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2. The Officer logs in to the administrative console of the HRMS Portal and submits the address
change request for the employee.

3. The HRMS portal will invoke the SCA Import configured to update an employee record using
the WebSphere Adapter for SAP Software . This is accomplished by calling the three BAPIs, in
the same work unit sequentially:

BAPI_EMPLOYEE_ENQUEUE
BAPI_EMPLOYEE_DEQUEUE
BAPI_EMPLOYEE_CHANGE

4. The first BAPI locks the employee record. The second updates the record, and the third
approves the update.

Note: The advantage of using the BAPI Work Unit interface is that the client application can
request the employee record change with a single call, though the work unit consists of three
separate functions. Also, the BAPI Work Unit interface can be used if your SAP system requires
that certain BAPIs are to be processed in a specific sequence for a business flow to complete
correctly.

5. The adapter receives a request from the client application as a wrapper Business Object that
contains these three child BAPI objects.

BAPI_ADDRESSEMP_ENQUEUE
BAPI_ADDRESSEMP_DEQUEUE
BAPI_ADDRESSEMP_CHANGE

0. The adapter sends this data to the SAP system which responds with the details of the three
BAPIs.

7. The adapter handles the SAP response, converts it into a Business Object format as required by
the client application and returns it.

8. The HRMS portal returns the appropriate response to the Manager.

Configuration prerequisites

You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.
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Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTAILL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALIL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Server v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.

Copy the sapjco3.jar file to the <WPS_INSTALIL>/lib ditectory.

When working with WebSphete Process Server on z/OS, add
${WAS_INSTALL_ROOT}/lib/the sapjco3.jar file to
WAS_SERVER_ONLY_server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.
<WPS_INSTALIL?> represents the WebSphere Process Server installation directory.
Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTAILIL>/lib directoty.
When working with WebSphere Application Server on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY _server_region_classpath

<WPS_INSTAILIL> represents the WebSphere Process Server installation directory.

Configuring the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&+ New External Service

Select the Service Type or Registry

p
Select the type of service to create or registry to browse. 3
Filter: | type filter text | B
Available Types:
=@ Adapters L
o CIcs
£ E-mail
Flat File
ttr FTP
I IMS
|1? iSeries
JOE 1D Edwards
[@ JoBC
E Lotus Domino =
Eﬁé Oracle
& Peoplesoft
7 Siebel "
Description:
Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding, During outhound processing, services running on WebSphere
Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the
SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

(7 < Back Finish Cancel

Figure: Select the Service Type or Registry screen

2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.
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& New External Service

Select an Adapter

Select the adapter you want to use. .

]|

4

@p IEM WebSphere Adapter for SAP Software (IEM : 7.0.0.0)

IEM WehSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction suppaort

(o [ oge ] e
hA]

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the

current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.

3. Specify a Connector Project name in the Import a RAR File screen and proceed by
clicking on Next.
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& New External Service

Import a RAR File

Impart a resource adapter archive (RAR) from the file system to create a connector project for the
adapter.

Archive file; C:WIDT\ResourceAdapters\SAP_7.0.0.00CWYAP_SAPAdapter_Tx.rar

= | CWYAP_SAPAdapter_Tx |

Connector project:

Target runtime enviroment: |'n.fu'eI:|5|:-here Process Server w70 b |

® o]

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries Screen, provide the location of
sapjco3.jar and sapjco3.dll or libsapjco3.so files.

&= New External Service

=13

Locate the Required Files and Libraries

Connector projects require system-specific libraries and JAR files. Specify the location
of these files.

When deploving the application to a stand-alone server, these files must be configured on the server, Mare ...

Specify the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo'\sapico3-nintel-3.0. 2\sapjco3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo\sapjco3-nintel-3.0, 2\sapjco3.dil | |§Brnwse... |

Cancel

5. Click Next.

0. In the Select the Processing Direction screen, select the Outbound radio button and click

Next.
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4= New External Service |:.®

Select the Processing Direction ?
Select the direction of adapter processing at run time, ;
() Inbound

Inbound processing passes data from the adapter to your service expart.

>

(*) Outbound

Cuthound processing passes data from your service impart to the adapter.

=

2 < Back ]MEH}

Setting connection properties for the External Service wizard

You must provide the following information in the Discovery Configuration screen:

User name

Password

Host name

System number

SAP Client connection

Click Select to change the default Language code from English
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Use the drop down option to change the default Code page from 1100.
Select BAPI Work Unit as the SAP Interface name.

Click Next.

&+ New External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (Engish) || select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Password: + | EEm—— |

SAP interface name; EAF'I work unit w |

] change the logging properties for the wizard

@ (<o ez ]| e
40

Figure: Select BAPI Work Unit as the interface
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Selecting the Business Objects and services to be used with the adapter

1. In the Find objects in the Enterprise System screen, click expand RFC node.

Then click on the ** button.

&= New External Service

Expand nodes to view and select discovered objects., Use filtering, if necessary, to
limit number of objects displayed. o

Find Objects in the Enterprise System ::L

Discovered objects: Selected objects:

) rFC
9 BoR

Cancel

Figure: Object Discovery and Selection

2. Enter BAPI_EMPLOYEE_ENQUEUE (the name of the BAPI in SAP plus an asterisk as a
wild card character) in the Filter Properties for Discover by Name screen.



TGN software

#= New External Service

Filter Properties for 'RFC’
Specify the properties.

Object attribute to use for discovery: Disr:clver objects by name

Find ohjects with this pattern: = | BAPI_EMPLOYEE_ENQUELE |

Maximum number of objects to retrieve: |25 W |

)
=]
=
1
o
3
o

Figure: Filter Propertiesfor RFC

3. Click OK.

4. Expand the RFC node.
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#= Mew External Service

Find Objects in the Enterprise System

(i) The default number of objects to retrieve is 25. To refrieve more objects, select the filter icon to ﬂ.__]
change the default setting. ¢ |

Discovered objects: Selected objects:

‘&0 RFC (fitered)
@)

@-£3) BOR

L

|.ﬁ.dd selected discovered objects to selected objects,

Figure: Retrieved BAPI based on search criteria

5. Select the BAPI_ EMPLOYEE_ENQUEUE.

6. Click the i===i button.

7. A popup will appear containing the Configuration properties for the
BAPI_EMPLOYEE_ENQUEUE object.

Check the Use SAP filed names to generate attributes names checkbox if you want the
Business Object attribute names to be generated using SAP field Names.
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8. You can choose to create attributes in the Business Object for any optional parameter in the
BAPIL.

9. Click OK.

4= New External Service

Configuration Properties for 'BAPT_EMPLOYEE_ENQUEUE'
Specify configuration properties for the selected ohject. 1@\}

Attribute names of discovered objects can be generated from either SAP field names or from SAP field descriptions, which are
more understandable.

[Juse SaF field names to generate attribute names

The zelected object has optional RFC import, export, or table parameters. If selected, the optional parameters will be
generated as child objects of the selected object.

-+
£

= \=B Optional parameters [%

# <» Optional export parameters

[ Select Al ][Deselect AII]

@ [ oK, ] [ Cancel

l

Figure: Setting configuration parameters for the BAPI s selected

10. Click OK.
11. Repeat steps 1 to 6 for the following BAPIs —
BAPI ADDRESSEMP_CHANGE

BAPI_EMPLOYEE_DEQUEUE
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4+ New External Service

limit number of objects displayed.

Discovered objects:

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects. Use filtering, if necessary, to

Selected objects:

=) RFC (fitered)
- (0 BAPI_EMPLOYEE_DEQUELE
#-£3) BOR

--(0) BAPI_ADDRESSEMP_CHANGE
(D) BAPI_EMPLOYEE_DEQUELE
“--({) BAPI_EMPLOYEE_ENQUEUE

3

)

< Back

Finish Cancel

][ Mext =

12. Click Next.

Generating Business Object definitions and related artifacts

In the Specify Composite Properties screen, enter the Business Object name for service operations
as BAPI_EMPLOYEE_ENQUEUE.

Under Service Operations, click Add and add the Create as an operation
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#= Add Value

Select values from the list below:

Delete
Retrieve
Update

|:?:| |
s [ q:% ] [ Cance

Associate the Business Object BAPI_ADDRESSSEMP_REQUEST to the Create operation by
clicking Add under Sequence of RFC functions for the selected operation.

% Add Value =T

Select values from the list below:

BAPI_ADDRESSEMP_CHAMGE
BAPT_EMPLOYEE_DEQUEUE

BAPI_EMPLOYEE ENQUELE

COMMIT

@ [ Ok H Cancel ]

The Specify Composite Properties screen will now look like the following screen.
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4 Mew External Service

Specify Composite Properties
Specify properties that apply to all selected objects. | {

==
Map service operations to RFC functions
Business object name for service operations: = | BAPT_EMPLOYEE_ENQUELE |
Service operations:™
Create Add...

Remowve

Sequence of RFC functions for the selected operation: ™

BAPI_EMPLOYEE_ENCUEUE Add...

Remowve

Business object namespace:; = | htu:u:f,n"-\'ww.ibm.cnmfxmlnsfprud,.’websphere,I

Specify the relative folder for the generated business object:

Folder: | |

[ | Enable dynamic authentication function
|:| Ignore errors in BAPI return object

(7 = Back ][ Mext = ] Finizh

&
=
()
i

Under Service Operations, click Add and add the Update as an operation
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4= Add Value

Select values from the list below:

Delete
Retrieve

.:'E:. [ 0 l [ Cancel
My

Associate the Business Object BAPI_ADDRESSSEMP_CHANGE to the Update operation by
clicking Add under Sequence of RFC functions for the selected operation.

Select values from the list below:

BAPI_ADDRESSEMP_CHANGE
BAPI_EMPLOYEE_DEQUEUE
BAPI_EMPLOYEE_ENQUEUE
COMMIT

&

Ok H Cancel ]
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The Specify Composite Properties screen will now look like —

&= New External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

Map service operations to RFC functions

Business object name for service operations:= | BAPT_EMPADDRESS_LIPDATE |

Service operations:

Create
pdate

Remove

Sequence of RFC functions for the selected operation:®
BAPI_ADDRESSEMP_CHANGE add..

Remove

Business object namespace: & | htu:u:ff'n"n"n'.iI:um.cnmfxmlnsfpru:udf'n'el:uspl'|

Specify the relative folder for the generated business object:

Folder: | |

[ |Enable dynamic authentication function
|:| Ignore errors in BAPI return object

Cancel

(2] < Back ” Mext = l

Under Service Operations, click Add and add the Retrieve as an Operation.
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4 Add Value M=

Select values from the list below:

Delete
Retrieve

(7 [ i l [ Cancel
a1

Associate the Business Object BAPI_ADDRESSSEMP_APPROVE to the Retrieve operation by
clicking Add under Sequence of RFC functions for the selected operation.

4 Add Value M=
Select values from the list below:
BAPI_ADDRESSEMP_CHAMGE
BAPL EMPLOYEE DEQUELIE
BAPI_EMPLOYEE ENQUELE
COMMIT
@ [ oK ] [ Cancel ]

Optionally, enter the Business Object folder name for the folder in which the business objects are
created. bodefs has been used as the folder name for this example.

The Specify Composite Properties screen will now look like —
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4= New External Service i:,|E||Z|

Specify Composite Properties
Specify properties that apply to all selected objects.

i

[

Map service operations to RFC functions

Business object name for service operations: = ! BAPI_FMPLOYEE_ENQUELE |

Service operations:™

Creats add...
Update
F'.EtI'iE'u'E REmﬂ'U'E

Sequence of RFC functions for the selected operation:
BAPI_EMPLOYEE_DEQUELE Add...

Remowve

Business object namespace: ® | htn:-:f,."n"-x'w.il:-m.n:n:nm,.fxmlns,.fprn:ndfwel:-sph|

Specify the relative folder for the generated business ohject:
Folder: | bodefsz |

[ ]Enable dynamic authentication function
[ |tgnore errors in BAPI return obiect

I [ |

@ <Back || Next> | Ersh Cancel

To verify the selections, click any service operation selected and its corresponding Business Object
should be displayed automatically in the text box below it.

Click Next.

In the Service Generation and Deployment Configuration screen, enter the connection
properties and deployment properties.
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&+ New External Service

Specify the Service Generation and Deployment Properties
Specify properties for generating the service and running it on the server, "'\:)

>

Service Operations

Tg mod_iﬁ-' the names, or add a description to the operations to be generated in the interface file, Edit Operations. ..
dick Edit Operations.

Deployment Properties
How do you want to specify the security credentials?
(") Using an existing JAAS alias {recommended)

{(*) Using security properties from the managed connection factory:

The properties will be stored as plain text; no encryption is used.

User name: * | srnandur |

Pzl o [ |

() Other

The quality of service to join the transaction provides a higher dearee of data intearity, espedally in the event of &
failure. As the adapter only supports local transactions, it must be the only one phase commit capable resource in
the transaction. Mare ...

Join the transaction {recommended)

Deploy connector project: |'u."'.n'iﬂ'| module for use by single application A

Specify the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection information
[]use load balanding

To use load balancing, specify the load balancing properties in the Additional connection configuration
panel under the Advanced tab. =,

Host name: = | owd31.svl.ibm.com |

System number: | 01 |

Client: | 100 |

Language code: | EM (English) | lSelect... ]

Code page: | 1100 w |

[ %

@ | <sack | Wt > | | Enih

Figure: Service Generation and Deployment Confignration



WebhSphere. Bl E (=

Note: You can either enter an Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP system.

Click Next.

In the Specify the Location Properties screen, click the New next to the Module field to create
a new module.

When the New Business Integration Project screen appears, select Module radio button and
click Next.

4= New Business Integration Project

Select a Business Integration Project Type =M

Select the type of business integration project that you want to create, m

@Huduleg IIse a module to integrate business applications and services. A module
can contain any type of component and can be deployed on WebSphere
A | Process Server. Maore. ..

i) Mediation module  Use a mediation module to integrate and connect services. A mediation
medule can contain mediation flows and can be deployed on WebSphere

A~ ESE or WebSphere Process Server, More...

/A

®

In the New Module screen, type BAPI_ADDRESS_UPDATE_WORKUNIT in the Module
Name field, and click Finish.
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4= New Module

Create a Module

IUse a module to integrate business applications and services, A module can contain any type of '
component and can be deployed on WebSphere Process Server.,

Module name: | BAPI_ADDRESS_UPDATE_WORKUNIT] |

LIse default location

Dpen module assembly diagram

() Mext = [ Firfsh l [ Cancel

Click Finish on the Specify the Location Properties screen.
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# New External Service

Specify the Location Properties o
Specify location properties for where you want to save the service. h:lj
Properties for Service

Modue: |BAPI_ADDRESS_UPDATE_WORKUNIT v || new. |
IUse the default namespace

Folder: | | [Eiruwse... ]

Mame: = | SAPQOutboundInterface |
[ ]save business objects to a library

Description: |

® o> | e ] (o
&)

Verify the results.
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=12 BAPI_ADDRESS_UPDATE_WORKUNIT

BT bl oo
: E_Hr SAPOutboundInterface

ﬁ Dependencies
f_% Integration Logic
-:-_r_ﬂ1 Data Types
== bodefs
() SapBAPI_EMPLOYEE_EMQUELUETxn
= SapBapiAddressempChange
I:l SapBapiEmployeeDequeus
C] SapBapiEmployeeEngueus
I'.:'J SapReturn
(£] SapReturn203510914
(C] SapReturn619647890
| DuplicateRecordFault
(=) InvalidRequestFault
(2] MatchesExceededLimitFault
[=d MissingDataFault
: = MultipleMatchingRecordsFault
El PrimarykeyPairType
(2] RecordNotFoundFault
- [C] WBIFault
= .__ri, Interfaces
@ SAPQuthoundInterface
_:J'_'_:, Transformations

Figure: Artifacts created after the EMD run for BAPI Work Unit Tutorial

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module
BAPI_ADDRESS_UPDATE_WORKUNIT by selecting Add and Remove Projects.

The project BAPI_ADDRESS_UPDATE_WORKUNIT App will be listed under Available
projects.
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&= Add and Remove Projects

Add and Remove Projects
Madify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects:

- E BAPI_ADDRESS _UPDATE _WORKUNITApp

Configured projects:

IE BAPI_CUST_GETDETAILApp [

s Add >
(B} BAPI_CUSTOMER _GETDETAIL _AliasApp

Add All »=

If server iz started, publish changes immediately

[ Finish ][ Cancel

The project you added will appear under the Configured projects. Add the SCA module to the

server by clicking Finish.

4= Add and Remove Projects

Add and Remove Projects
Maodify the projects that are configured on the server

Mave projects to the right to configure them on the server
Available projects:

(] BAPI_CUST_GETDETAILApp
& (& BAPI_CUSTOMER_GETDETAIL_AliasApp

[ Add All > >

[ << Remove All

If server iz started, publish changes immediately

Configured projects:

B (8 BAPI ADDRESS LFDATE WORKLMITARD

| [ Cancel

next> | [ Fireh
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Testing the assembled adapter application
Test the assembled adapter application using the WebSphere Integration Developer’s Test Client.
1. Once the module is deployed to the Server, right click the module
BAPI_ADDRESS_UPDATE_WORKUNIT from the Projects view and select Test > Test
Module from the pop-up menu.
2. Enter values in the Test Client as shown below.

3. Navigate to the SapBapiCustomerCreatepwreg node of Initial request

parameters field and expand it if it is not expanded. Enter the customer number 0000000001.

=

Mame | Type | Value
= %g SapBapiCustomerCreatepwreg SapBapiCustomerCreate,.., +
[ customertumber merMumber <st
%g SapReturn
= %g SapBapiCustomerDeletepwreg
1 customerMumber
=7 SapReturn519647330 Sz
| MessageTypeSSucoessEErrorWW Messa
1 MeszageCode '

T MaceanaTawt

4. Click the Continue button B .

When the Select Deployment screen appears, select the WebSphere Process Server instance to
which you added the project and click the Finish button.

5. If security is enabled, type in the username and password in the popup User Login screen that
appears and click OK.

4= User Login - Default Module Test

Security is enabled on the selected runtime environment(s).
Please sign in to continue the test,

User ID:
| Edmin |

Password:

[ ] Use the authentication settings in the preference and never ask again.

Ok H Cancel ]
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0. Check the output of the service, and check the data in the EIS to ensure it matches expected
values.

Clearing the sample content

No clean up is required after this tutorial.
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Chapter 6. Tutorial 3: Sending data to an SAP
system (outbound processing)
using the BAPI ResultSet Interface

Business Case

The Audit team requires details of all customers of the company. Every customer
record has a unique customer number which should be used to lookup their details.

Scenario

The following scenario illustrates simple BAPI outbound processing using
Synchronous RFC calls.

Customer Services Portal \2
\o\
A
. N
G Audit Personnel
v

SAPOutboundlinterfacelmport

A 4

WebSphere Adapter for SAP

o o

SAP

Figure: Scenario illustrating simple BAPI Result Set outbound processing

1. The Audit team logs in to the Customer Services portal and accesses the details of all
the customers.
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2. The Customer Services portal invokes the SCA Import configured to retrieve
information of all the customers with WebSphere Adapter for SAP. This is
accomplished by using the BAPI Result Set interface.

BAPI Result Sets use the GetList and GetDetail functions to retrieve an array of data
from the SAP server. The information returned from the GetList function is used as
input to the GetDetail function.

Here, the set of customers are retrieved using BAPI_CUSTOMER_GETLIST,
which acts as a query BAPI, and BAPI_CUSTOMER_GETDETAIL, which acts as
the result BAPI

The BAPIs perform the following steps:

1. BAPI_CUSTOMER_GETLIST call returns the list of Customer
Numbers

1. Each Customer Number is mapped dynamically to the Business Object
for BAPI_CUSTOMER_GETDETAIL

1. BAPI_CUSTOMER_GETDETAIL is processed multiple times for
every Customer Number, so that an array of customer information is
returned

3. The adapter receives a request from the client application in the form of a BAPI
Result Set Business Object. The adapter sends this data to SAP server

4. The SAP server responds with the details of the customer records.

The adapter handles the response from SAP, converts it back to a Business Object
format as required by the client application and is returned.

6. The Customer Services portal returns the response to the Auditing Personnel.

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTAILL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALL_DIR>/runtimes/bi_v7).
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When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.

Copy the sapjco3.jar file to the <IWPS_INSTALIL>/lib ditectory.

When working with WebSphere Process Server on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to

WAS_SERVER_ONLY _server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.
<WPS_INSTAILIL?> represents the WebSphere Process Server installation directory.
Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTAILL>/lib directory.

When working with WebSphere Application Setver on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY_server_region_classpath.

<WPS_INSTAILIL?> represents the WebSphere Process Server installation directory..

Configuring the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen
and click Next.
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&+ New External Service

Select the Service Type or Registry

p
Select the type of service to create or registry to browse. 3
Filter: | type filter text | B
Available Types:
=@ Adapters L
o CIcs
£ E-mail
Flat File
ttr FTP
I IMS
|1? iSeries
JOE 1D Edwards
[@ JoBC
E Lotus Domino =
Eﬁé Oracle
& Peoplesoft
7 Siebel "
Description:
Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding, During outhound processing, services running on WebSphere
Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the
SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

(7 < Back Finish Cancel

Figure: Select the Service Type or Registry screen

2. Select the IBM WebSphere Adapter for SAP Software with transaction
support (IBM: 7.0.0.0) from the Select an Adapter screen and click Next.
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3.

& New External Service

Select an Adapter
Select the adapter you want to use.

]|

4

@p IEM WebSphere Adapter for SAP Software (IEM : 7.0.0.0)

IEM WehSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction suppaort

(o [ oge ] e
hA]

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard eatlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the current
workspace, you can choose one from a list of configurations cached by WebSphere
Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node

Specify the Connector Project name in the Import a RAR File screen and
proceed by clicking Next.




WebhSphere. Bl E (=

&= New External Service

Import a RAR File

Impart a resource adapter archive (RAR) from the file system to create a connector project for the
adapter.

Archive file: C:\WID7\ResourceAdapters\SAP_7.0.0.0\CWYAP_SAPAdapter_Tw.rar

= | CWYAP_SAPAdapter_Tx |

Connector project:

Target runtime enviroment: |'n.fu'el:15phere Process Server w7.0 A |

Cancel

@ [ <Back || et J

Figure: Import a RAR file screen
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4,

In the Locate the Required Files and Libraries screen, provide the locations of
sapjco3.jar and sapjco3.dll or libsapjco3.so files.

4 New External Service |:| E|[Z|
Locate the Required Files and Libraries IT,"_|

Connector projects require system-specific libraries and JAR files. Specify the location
of these files. l—‘

When deploving the application to a stand-alone server, these files must be configured on the server, Mare ...

Specify the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo'\sapico3-nintel-3.0. 2\sapjco3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo\sapjco3-nintel-3.0, 2\sapjco3.dil | |§Brnwse... |

TN T

5. Click Next.
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0. In the Select the Processing Direction screen, select the Outbound radio button and click
Next.

#= New External Service |:|E]

Select the Processing Direction ?
Select the direction of adapter processing at run time., I;
() Inbound

Inbound processing passes data from the adapter to yvour service export.

=

(*) Outbound

CQuthound processing passes data from your service import to the adapter.

=

s ]

Setting connection properties for the New External Service wizard
You must provide the following information in the Discovery Configuration screen:
User name
Password
Host name

System number



WebhSphere. Bl E (=
SAP Client connection
Click Select to change the default Language code from English
Use the drop down option to change the default Code page from 1100.
Select BAPI result set as the SAP Interface name.

Click Next.

&+ New External Service

Specify the Discovery Properties —

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (Engish) || select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Password: + | EEm—— |

SAP interface name; EAF'I result set w |

] change the logging properties for the wizard

@ <gack || NP> |
W

Cancel

Figure: Select BAPI Result Set as the interface

Selecting the Business Objects and services to be used with the adapter
1. In the Find objects in the Enterprise System screen, expand the RFC node. Then

click the

—+*i
=,
=+ button.
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&+ New External Service

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects, Use filtering, if necessary, to ::L__]
limit number of objects displayed. o

Discovered objects: Selected objects:

Q) RFC
3 Bor

Mext = Einish Cancel

Figure: Object Discovery and Selection
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Enter BAPI_CUSTOMER_GET* (the name of the BAPI in SAP and an asterisk as a wild card
character) in the Filter Properties for ‘RFC’ screen.

#= Mew External Service

Filter Properties for 'RFC' -’1
Specify the properties, 4_,')
COhject attribute to use for discovery: |Disu:|:|'-rer objects by name W |
Find objects with this pattern: = | BAPI_CUSTOMER_GET* |
Maximum number of objects to retrieve: | 25 W |
"E" [ QK ] [ Cancel ]

Figure: Filter Properties for RFC
Click OK.

Expand the RFC node.
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d= New External Service

Find Objects in the Enterprise System
@ The default number of objects to retrieve is 25, To retrieve more objects, select ::LJ
the filter icon to change the default setting. Select two BAPIs for the ResultSet d
Discovered objects: Selected objects:
B |

=-£9) RFC (filtered)
(D) BAPI_CUSTOMER_GETCOMTACTLIST
e cusrover_ceroerat
(@) BAPI_CUSTOMER_GETDETAIL1
(0) BAPI_CUSTOMER_GETDETAIL2
(@) BAPI_CUUSTOMER_GETINTNUMBER
()} 54PL_CUSTOMER_GETLIST |
(0) BAPI_CIUSTOMER_GETPWREG
(0) BAPI_CIUSTOMER_GETSALESAREAS
(@) BAPI_CUSTOMER_GET_CHILDREN
(0) BAPI_CUSTOMER_GET_ROOT
(@) BAPI_CUSTOMER_GET ROCT LIST
) BoR

e

=

@

Figure: Retrieved BAPIS based on search criteria

Select both the BAPI_CUSTOMER_GETDETAIL and BAPI_CUSTOMER_GETLIST BAPIs’
from the list of discovered BAPIs’.

Click the 2 | button.

A popup will appear containing the Configuration properties for the
BAPI_CUSTOMER_GETDETAIL object.

Check the Use SAP filed names to generate attributes names checkbox if you want the
Business Object attribute names to be generated using SAP field Names.

You can choose to create attributes in the Business Object for any optional parameter in the
BAPL
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Click OK.

4 New External Service @

Configuration Properties .

el
Specify configuration properties for the selected object. \D/

EN Properties:
S

o [ — :;g:;‘;:nn‘ggli:, of discovered objects can be generated from either SAP field names or from SAP field descriptions, which are more

@
BAPL LU B GEILLS [Juse 5AP field names to generate attribute names

The selected object has optional RFC import, export, or table parameters. If selected, the optional parameters will be generated as child
objects of the selected object.

D
+

& [¥] ¢ Optional parameters

==

Figure: Setting configuration parameters for the BAPIs selected

Click Next.

Generating Business Object definitions and related artifacts
In the Specify Composite Properties screen,
a) Enter the name of the Business Object as CustomerDetail.

b) Map the field in Query BAPI to BAPI_CUSTOMER_GETLIST. The Result BAPI field will
be mapped to BAPI_CUSTOMER_GETDETAIL
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&= Mew External Service

Specify Composite Properties
Specify properties that apply to all selected objects,

Type the name of the business object.:= | CustomerDetail |

Query BAPT: |BAF‘I_CLI5TOMER_GI:‘I‘LIST v |

Result BAPT: BAPI_CUSTCOMER._GETDETAIL

Specify one or mare foreign key relationships between the query BAPI and the result BAPT. :

SapBapiCustomerGet...  SapBapiCustomerGetlist

Business object namespace: . | http: ffwewewy.ibm. comxmins fprod 'Ebspherefjkafse|

Spedfy the relative folder for the generated business object:

Folder: | |

[]Enable dynamic authentication function
|:| Ignore errors in BAPT return ohject

L] [ < Back ][ Mext =

Cancel

Figure: Specify Composite Properties

¢) Click Add button. This brings up a pop-up screen, Add/Edit properties in which both the
BAPISs required for the result set are displayed.

Click the Select button corresponding to SapBapiCustomerGetdetail and choose
SapBapiCustomerGetdetail/ CustomerToBeRequired.

Similarly click the Select button corresponding to SapBapiCustomerGetlist and choose
SapBapiCustomerGetlist/SapAddressdata/CustomerNumberl.

Click Finish.
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4 Add/Edit

Add/Edit properties
Specify the properties,

SapBapiCustomerGetiist:

SapBapiCustomerGetdetail; | SapBapiCustomerGetdetail {CustomerToBeRequired

| [ Select... ]

| SapBapiCustomerGetist/SapAddressdata/CustomerMumber 1 | |§Select... |

l [ Cancel

l £

d) Enter the folder name for the generated Business Object as bodefs.
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& New External Service

Specify Composite Properties

Type the name of the business ohject. ;= | CustomerDetail

Specify properties that apply to all selected objects.

Query BAPT: |BAPI_CU5TOMER_GI:‘I‘LIST v

Result BAPT: BAPT_CUSTOMER _GETDETAIL

Spedfy one or more foreign key relationships between the query BAFI and the result BAPL. :

SapBapiCustomerGetdetail SapBapiCustomerGetlist Add...
SapBapiCustomerGetdetail [CustomerToBeRequired  SapBapiCustomerGetist/SapAddressdata /CustomerMumber 1
Edit...

Remove

Business object namespace: = | http: { fwww.ibm. comfxmins/prod/websphere fj2cafzap |

Specify the relative folder for the generated business object:
Falder: | bodefs |

[1Enable dynamic authentication function
|:| Ignore errors in BAPI return object

@ [ <Back | tpe > ][ Ensh

Figure: Specify Composite Properties

Click Next.

In the Service Generation and Deployment Configuration screen enter the connection
properties and deployment properties.
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&= New External Service

Specify the Service Generation and Deployment Properties
Specify properties for generating the service and running it on the server. \J

|

Service Operations

Tp I'I'Iod.iﬁ‘ the names, or add a description to the operations to be generated in the interface file, Edit Operations...
dick Edit Operations.

Deployment Properties
How do you want to specify the security credentials?
() Using an existing JAAS alias (recommended)

(*)Lsing security properties from the managed connection factory:

The properties will be stored as plain text; no encryption is used.

User name: * | srnandur |

Password: N |

() Other

The quality of service to join the transaction provides a higher degree of data integrity, espedally in the event of a
failure. As the adapter only supports local transactions, it must be the only one phase commit capable resource in
the transaction. More ...

Join the transaction {recommended)

Deploy connector project: |WiH1 madule for use by single application w

Specify the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection information
[ ]use load balancing

To use load balandng, specify the load balancing properties in the Additional connection configuration
panel under the Advanced tab.

Host name: = | cwd31.svl.ibm.com |

System number: | 01 |

Client: | 100 |

Language code: | EM (English) | [Select... l

Code page: | 1100 v |

|

@ | <Back | > |

Figure: Service Generation and Deployment Configuration
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Note: You can either enter an Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP system.

Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select Module radio button and
click on Next.

4= New Business Integration Project

Select a Business Integration Project Type =

Select the type of business integration project that you want to create. m

IUse a module to integrate business applications and services. A module
can contain any type of companent and can be deployed on WebSphere
Process Server. Maore...

(") Mediation module  Use a mediation module to integrate and connect services. A mediation
module can contain mediation flows and can be deployed on WebSphere

A~ ESE or WebSphere Process Server, Maore...

/A

®

In the New Module screen, type BAPI_GET_DETAIL_RESULTSET in the Module Name
field, and then click Finish.
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#= New Module

Create a Module

lUse a module to integrate business applications and services. A module can contain any type of T
component and can be deployed on WebSphere Process Server,

Module name: | BAPI_GET_DETAIL_RESULTSET] |

Use default location

Open module assembly diagram

':':’:' Mext = % ish l [ Cancel

Click Finish on the Specify the Location Properties screen.
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#= New External Service

Specify the Location Properties o
Specify location properties for where you want to save the service, h:lj

Properties for service

Module: |BAPI_GET_DETAIL_RESULTSET v | [New... |

| |

IUse default namespace
Folder: | | [Bruwse... ]
Mame: = | SAPQOutboundInterface |

[]save business objects to a library

Description: |

Verify the results.
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BAPI_GET DETAIL RESULTSET
= ‘?&:ﬂ Assembly Diagram
E_ﬁ? SAPQuthoundInterface
ﬂ Dependencies
E’ Integration Logic
= ._'nj Data Types
=== bodefs
I:J QueryBO
| SapAddressdata
| SapBapiCustomerGetdetail
= SapCustomerDetailResultset
o Sapldrange
| SapPelddress
| SapReturn
(2] SapReturn519547330
| SapSpedaldata
| DuplicateRecordFault
= InvalidRequestFault
(2] MatchesExceededLimitFault
-l MissingDataFault
=l MultipleMatchingRecordsFault
= PrimarykeyPairType
[2) RecordMotFoundFault
(ZJ WEIFault
= 3 Interfaces
@ SAPQuthoundInterface
E Transformations

Figure: Artifacts created after the EMD run for the BAPI Result Set Module

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module
BAPI_GET_DETAIL_RESULTSET by selecting Add and Remove Projects.

The project BAPI_GET_DETAIL_RESULTSETApp will be listed under Available projects.

After adding the project, the added project should appear under the Configured projects. Add the
SCA module to the server. Click Finish.
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4~ Add and Remove Projects

Add and Remove Projects =
Modify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects: Configured projects:

(] BAPI_ADDRESS_UPDATE_WORKLNITADD [ (B BAPL_GET. DETAIL_RESLLTSETARD
B (5 BAPI_CUST_GETDETAILApp
- (5 BAPI_CUSTOMER_GETDETAIL_AliasApp

[ Add All >> |

[ << Remove Al ]

If server is started, publish changes immediately

@ Bz ext Firtigh Cancel

Testing the assembled adapter application

Test the assembled adapter application using the WebSphere Integration Developer integration
test client.

1. Right click the module “BAPI_GET_DETAIL_RESULTSET” and select Test > Test
Module from the pop-up menu.

2. Enter values as shown in the figure below:

3. Right click SapBapiCustomerGetDetail and select AddElements and enter 1 as the value in the
popup screen.

a)Enter the following values for the added element SapBapiCustomerGetDetail[0]

CustomerToBeRequired= 0000000001 DistributionChannel=01 Division=01
SalesOrganization=0001

b) Under QueryBO set the following data
MaximumNumberOfCustomers= 3

©) In QueryBO we have another element with name SapIldRange. Right click SapIdRange and
select AddElements and enter 1 as the value in the popup screen.
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InclusionExclusionCriterionSignForRangeTables= E SelectionOperatorOptionForRangeTables=
EQ CustomerNumber1=10 CustomerNumber2217378=25

d) Under the QueryBO we also have SapAddressData. Right click SapAddressData and select
AddElements and enter 1.

CustomerNumber=0000000001

& =] B

Mame

Value

<
1=

= [E] SapBapiCustomerGetdetail
= %: SapBapiCustomerGe tdetail[0]
[ customerToBeRequired =
[ pistributionChannel
[ Division
[ PassBuffer
1 salesOrganization =
%: SapPeAddress
%: SapReturn
=] %: QueryBO
71 ControlIndicatorReadCneTime
1 MaximumMumberOfcustomers int
B, sapReturns 19647830
(=) [E] SapAddressdata
= %: SapAddressdata[0]
71 CustomerMumber 1
[ SearchTerm1
ll_n Name1l
| CountryKey
= CountrylsoCode
Diciy
[ CityPostalCode
ll_n RegionStateProvinceC Regions
[0 street E
= FirstTelephoneNoDial
= FirstFaxMoDialingCode
[ Address
=-[E] sapldrange *
= %: Sapldrange(0]
[ IndusionExdusionCrite Inc
[ SelectionOperatorOpti
1 CustomerMumber 1
1 customerMumber 1221 ¢

+ 0000000001
« 01

« 01

v

+ 001

(o)

0000000001

A AL UL L AL UL U S VL SE UL UL UL UL - AL UL UL UL UL UL

<
A
=

4. Click the Continue button B .
When the Select Deployment screen appears, select the WebSphere Process Server instance to
which you added the project and click the Finish button.

5 .If security is enabled, type in the username and password in the popup User Login
screen that appears and click OK.
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0. Check the output of the service, and check the data in the EIS to ensure it matches expected

values.

4= User Login - Default Module Test

Security is enabled on the selected runtime environment(s).
Please sign in to continue the test,

User ID:

| Edmin

Password:

[ Juse the authentication settings in the preference and never ask again.

[ oK l [ Cancel

]

Clearing the sample content

No clean up is required after this tutorial.
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Chapter 7. Tutorial 4: Sending data from SAP
(INBOUND processing) using BAPI

Business Case

The Sales department of an organization stores the information related to new
customers in their SAP system and later updates the Accounts department after verifying the
details.

Scenario

The following scenario illustrates BAPI inbound processing synchronously (in which
both the client application and the adapter must be available during processing). In
synchronous processing, the client application waits for a response from the adapter.

End Point

— o To
\/ SAPInboundInterfaceExport

A

\4
o

WebSphere Adapter for SAP

SAP

4N
\/ Sales

Figure: Scenario illustrating simple BAPI inbound processing

1. The Sales department of an organization stores the details of a new customer in SAP
system.
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2. The WebSphere Adapter for SAP is configured for synchronous BAPI Inbound
processing. The adapter starts event listeners, which listen for RFC-enabled function
events (specified with the REFCProgramlD property) from the SAP server.

3. The customer details are to be fetched using BAPI_ CUSTOMER_GETDETAIL by
providing a customer number.

4. 'This RFC enabled function event is pushed to the adapter by the way of the event
listeners. The adapter resolves the operation and Business Object name using the
received RFC-enabled function name.

5. The adapter sends the Business Object to the configured end-point in a synchronous
manner. The end point might be any application that updates the accounts department.

6. The adapter receives the response Business Object from the end point.

7. 'The adapter maps the response Business Object to an RFC-enabled function and
returns it to the SAP Server

Configuration prerequisites
Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTAILL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALIL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Server v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <WPS_INSTALIL>/lib ditectory.
When working with WebSphete Process Server on z/OS, add

${WAS_INSTALL_ROOT}/lib/the sapjco3.jar file to
WAS_SERVER_ONLY_server_region_classpath
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The sapjco3.jar is required to run the New External Service wizard.
<WPS_INSTALIL> represents the WebSphere Process Server installation directory.
Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTALIL>/lib directory.

When working with WebSphere Application Server on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY _server_region_classpath

<WPS_INSTALIL?> represents the WebSphere Process Server installation directory..

Configuring the adapter for inbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and click
on Next.
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&= New External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: |type filter text

¥

Available Types;

=@ Adapters
o CIcs
£ E-mail
Flat File
fte FTP
I IMS
EE iSeries
JOE 1D Edwards
[@] JoBC
B Lotus Domino .
E'@ Orade
& PeopleSoft

' Siebel

[>

(£

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding. During outhound processing, services running on WebSphere

Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the

SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

T
w

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

4 New External Service

Select an Adapter
Select the adapter you want to use,

o

L]

el

@p 1BM WebSphere Adapter for SAP Software (IBM : 7.0.0.0)
@p 16M WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IBM WebSphere Adapter for SAP Software with transaction support

) < Back ” ﬂexhg_] Finish

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the

current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3. Specify a Connector Project name in the Import a RAR File screen and proceed by
clicking Next.

&= New External Service |:.®
I

Import a RAR File

=
Import a resource adapter archive (RAR) from the fille system to create a connector @ I
project for the adapter. |
Archive file: C:WID_new'\RekourceAdapters\SAP_7.0.0.0\CWYAP_SAPAdapter Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'L"'.I'E|35|:I|'IEFE Process Server 7.0 W |

(2 [ < Back ” Mext = \ Finish

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries Screen, provide the locations of the

sapjco3.jar and sapjco3.dll or libsapjco3.so files

& New External Service

Locate the Required Files and Libraries

Connector projects require system-specific libraries and JAR files. Specify the location
of these files.

administrator to download these files from the SAP Web site,

When deploying the application to a stand-alone server, these files must be configured on the server, Mare ...
Spedfy the location of the filles required to access the SAP server, You might first need to contact your SAP system

- [B)X]

SAP sapjco3.jar file: = | C:\84PICo'sapjco3-nintel-3.0. 2\sapjco3.jar | ’Browse... I

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo sapico 3nintel-3.0, 2'sapjco3.dll | |§Browse... |

7 < Back ” Next, > ‘
My

Figure: Locate the required files and 1ibraries screen

5. Click Next.

6. In the Select the Processing Direction screen, select the Inbound radio button, then

click Next.
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4= New External Service |:| E'E'
Select the Processing Direction ?

Select the direction of adapter processing at run time, ;

Inbound processing passes data from the adapter to your service export,

") Outbound

QOutbound processing passes data from your service import to the adapter.

=

':':’:' [ < Back ” Mext = I

Setting connection propertiesfor the New External Service wizard
You must provide the following information in the Discovery Configuration screen:
User name
Password
Host name
System number
SAP Client connection
Click Select to change the default Language code from English

Use the drop down option to change the default Code page from 1100.
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Select BAPI as the SAP Interface name.

Then click Next.

4= New External Service

Specify the Discovery Properties (=]

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
System number: | 01 |
Client: | 100 |
language code: | EN (Engiish) | [select.. |
Code page: | 1100 v|

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |
Password: * | e |
SAP interface name: LT NN |

[ ]change the logging properties for the wizard

@ <Back || Meqt> | Ene
iy

Figure: Select BAPI asthe interface

Selecting the Business Objects and services to be used with the adapter

Under Find Obijects in the Enterprise System, click on RFC node. Then click the + button.
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&~ New External Service |: E]

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects. Use filtering, if necessary,
to limit number of objects displayed.

-3

-

Discovered objects: Selected objects:

58 RFC
53 Bor

Y
]
’

Cancel

fa
[

%

Figure: Object Discovery and Selection

Enter BAPI_CUSTOMER_GET* (the name of the BAPI in SAP and an asterisk as a wild card
character) in the Filter Properties for ‘RFC’ screen.

#= Mew External Service

Filter Properties for "RFC’ B
specify the properties, [
Object attribute to use for discovery: |Disc-:u'-.-'er objects by name b |
Find objects with this pattern: = | BAPI_CUSTOMER_GET= |
Maximum number of objects to retrieve: | 25 A |
':':’:' [ OK ] [ Cancel ]

Figure: Filter Propertiesfor RFC

Click OK.

Expand RFC node.
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&= New External Service

Find Objects in the Enterprise System
@ The default number of ohjects to retrieve is 25, To retrieve more objects, select ::L.__J
the filter icon to change the default setting. 4
Discovered objects: Selected objects:
i

ERGNRFC (filtered)
(0) BAPI_CUSTOMER_GETCONTACTLIST
(@) BAPI_CUSTOMER_GETDETAILL
(@) BAPT_CUUSTOMER,_GETDETAIL 1
(@) BAPI_CUSTOMER,_GETDETAIL2
(@) BAPI_CUSTOMER_GETINTNUMBER
(@) BAPI_CUSTOMER_GETLIST
(@) BAPI_CUSTOMER_GETPWREG
(@) BAPI_CUSTOMER_GETSALESAREAS
(D) BAPI_CUSTOMER_GET_CHILDREN
(@) BAPI_CUSTOMER_GET_ROOT
(@) BAPI_CUUSTOMER_GET ROOT LIST
9 BoR

=

@

Figure: Retrieved BAPIS based on search criteria

Select the BAPI_CUSTOMER_GETDETAIL from metadata tree.

Click the ‘= button.

A popup will appear containing the Configuration properties for the
BAPI_CUSTOMER_GETDETAIL object.

Check the Use SAP filed names to generate attributes names checkbox if you want the
Business Object attribute names to be generated using SAP field Names.

You can choose to create attributes in the Business Object for any optional parameter in the
BAPIL.
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Click OK to go back to Find Objects in the Enterprise System screen.

#= New External Service

Configuration Properties for 'BAPI_CUSTOMER_GETDETAIL'
Specify configuration properties for the selected object. "‘-.J

Attribute names of discovered objects can be generated from either SAP field names ar from SAP field descriptions, which are
more understandable.

[Juse saF field names to generate attribute names

The selected object has optional RFC import, export, or table parameters, If selected, the optional parameters will be
generated as child objects of the selected object.

—*l,

v

= LB Cptional parameters
< Optional import parameters
[] < ©Optional export parameters

[ Select All ”Deselect.ﬁ."]

)] OE[ Cancel

Figure: Setting configuration parameters for the BAPI selected

Click Next.

Generating Business Object definitions and related artifacts

In the Specify Composite Properties screen, associate the RFC-enabled function name with an
end-point operation Create.

Enter the name of the folder where the Business Objects are to be created as bodefs.
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& New External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

The inbound BAPI interface enables the adapter to act as an RFC server, This allows an RFC
client an the SAP system to invake an RFC-enabled function through the adapter to the endpaint.
Assodate the RFC-enabled function name below with an endpoint operation.

Operations: | Create b |
Business object namespace: = | http:/ fwwow.ibm. comxmins fprod fwebsphere fi2cafsap |
Specify the relative folder for the generated business object:

Folder: | bodefe| |

[ ]Enable dynamic authentication function

SAP Remote Function Call (RFC) type: |Synd'|rn:|nn:|us RFC w |

'\'E':' [ < Back ” Mext = ]

Figure: Specify Composite Properties

Click Next.

In the Service Generation and Deployment Configuration screen enter the connection
properties and deployment properties. Click Next.
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d= New External Service

Service Generation and Deployment Configuration

N 4 s
Specfy properties for generating the service and running it on the server, b -
T
~
Service Operations =
To_modiﬁd Hje names, or add a description to the operations to be generated in the interface file, dick Edit Operations...
Edit Operations.
Deployment Properties
How do you want to specify the security credentials?
() Using an existing JAAS alias {recommended)
(¥) Using security properties from the activation spedfication
The security properties will not be encrypted and will be stored as plain text.
User name: ® | srnaridur |
Password: * | RS |
) Other
Deploy connector project: |Wiﬂ1 module for use by single application A4 |
Specify the settings used to connect to SAP Software at run time:
Connection Properties
SAP system connection information
[ ]Use load balandng
To use load balancing, spedfy the load balancing properties in the Additional connection configuration panel
under the Advanced tab.
Host name: = | owd31.svl.ibm.com |
RFC program ID:= | JCO3RFCSERVER3 |
Gateway host: | owd31.svl.ibm.com |
Gateway service: | sapgwi 1 |
Client: | 100 |
Language code: | EN (English) | [5elect... ]
Code page: | 1100 v|
System number: | 01 |
The user name and password will not be encrypted and will be stored as plain text.

|

@ [ <Back | N> ]

Figure: Service Generation and Deployment Confignration
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Note: You can either enter an Authentication Alias previously created using the administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP.

Enter the RFCProgramlID (as shown in figure). This must have been previously configured in the
SAP system.

Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select Module radio button and
click Next.

4= New Business Integration Project

Select a Business Integration Project Type =

Select the type of business integration project that you want to create, m

LIse @ module to integrate business applications and services, A
module can contain any type of component and can be deployed
on WebSphere Process Server, More. ..

") Mediation module Use a mediation module to integrate and connect services. A
mediation module can contain mediation flows and can be
A deployed on WebSphere ESE or WebSphere Process Server,

®

In the New Module screen, type BAPI_CUST_GETDETAIL_IN in the Module
Name field, and then click Finish.
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& New Module

Create a Module

Use @ module to integrate business applications and services. A
module can contain any type of component and can be deployed on

Module name: | BAPI_CUST_GETDETAIL_IM|

Lse default location

Open module assembly diagram

Finish

I

Cancel

Click Finish on the Specify the Location Properties screen.
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d= New External Service

Specify the Location Properties )
Spedfy location properties for where you want to save the service. h:lj

Properties for service

Madule: | BAPI_CUST_GETDETAILL _IN | [New...]

| |

IUse default namespace
Folder: | | [Brnwse... ]
MName: * | SAPInboundInterface |

[[]save business objects to a library

Description: |

':?:' Mext = Einish ] [ Cancel

Verify the results.
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BB AP CUST_GETDETAIL_IN.
= ?;C;' Aszembly Diagram
?dp SAPInboundInterface
@E Dependencies
E’ Integration Logic
=] D Data Types
E-E bodefs
-l SapBapiCustomerGetdetail
=l SapBapiCustomerGetdetailWrapper
= SapPelddress
I:l SapReturn
= .'_,ﬁ Interfaces
@ SAPInboundInterface
E Transformations

Figure: Artifacts created after the EMD run fore BAPI Inbound Module

Generating Reference Bindings

In the Business Integration Perspective of WebSphere Integration Developer, expand the
“BAPI_CUST_GETDETAIL_IN” SCA module, and double click the Assembly Diagram.
The Assembly Diagram screen appears with the module‘s Export component in view.

1. To create a new component, click the button of the required java component
from the Palette.

‘T:ISJ BAPI_CUST_GETDETAIL_IM - Assembly Diagram -2

< nF Palette
[,‘\3 ) (=) o, )

[ ] L ]
(= Favarites €9:| ?dp SAPInboundInterface
.

[== Components

'-T'é, Untyped Component
4=] Human Task

'-_",ﬂ Java

‘_I‘i;‘l_‘ Mediation Flow

52 Process

E= Rule Group

S State Machine

[ 8 Import
% Export

[l pEFEFERTEE
[-=- Outbound Imports

[-=- Inbound Exports
=L Cthonind Adantere

Figure: BAPI Inbound interface in the Assembly editor

(D There is
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Click and drag the Java component to add the new component to the Assembly Diagram screen.

Add a Wire between the SAPInboundlInterface and the Java component.

(D) There is a new element that has been added ¢

@ ?\'l_HF SAPInboundInterface

@Fﬂﬁl ﬂr

% I}.ﬂ Componentl
L]

Figure: BAPI Inbound interface being wired to a target Component(end-point)

1. In the Add Wire screen, click OK.
4 Add Wire ]

This action wil allow the target service to be used in other modules. The
\:’) service interface from the export will be added to the target, Do you want to
continue?

[] always create without prompt

| Ok | [ Cancel

Figure: Add Wire Screen

2. Right-click the new component and select Generate Implementation. This
creates a Java component that will act as an endpoint.
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7 =r Add... k
% ik Cc Change Type... L

[ ]
Generate Export. .. L

Generate Implementation k
Select Implementation

Synchronize Interfaces and References. ., *
Refactor... L
Merge Components

of Cut
[i=| Copy
rver Logs | 47k Sery 8

Stals | ¢ pelete

i

Figure: Creating Java implementation for the target Component.

In the Generate Implementation screen, select the package in which the Java code will be
created and click OK. A Java file in an editor screen appears.

Edit the Java file if you may wish to write code to print trace and log messages or Data Object.

Ensure that the package com.ibm.j2ca.base.AdapterBOUtil is imported.

in

* Method generated to support inmplementation of operation "emitCreateAfterImageSapBapiCustomerGetdetailWrapper” defined for WSDL port type
* named "SAPInboundInterface”.
* The presence of commonj.gdo.Datalbject a3 the return type and/or a3 a parameter
* type conveys that it is a complex type. Please refer to the WSDL Definition for more information
* on the type of input, output and fault(s).
public DataObject emitCreateAfterImage3apBapiCustomerGetdetailWrapper |
DataObject emitCreateAfterImageSapBapiCustomerGetdetailWrapperInput) {
try {
3yatem.out.princln{AdapterBOUcil, serializeData0bject (emitCreatehfterImageSapBapiCustomerGetdetailirapperInput));
} catch (Exception e) {
e.printStackTrace();

return emitCreateAfterImageSapBapiCustonerGetdetailWrapperInput;

Save the Java file and the assembly diagram.
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Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration

Developer’s Test Client.

Right click on your server node in the Server tab and add the module
BAPI_CUST_GETDETAIL_INby selecting Add and Remove Projects.

The project BAPI_CUST_GETDETAIL_INApp will be listed under Available projects.

& Add and Remove Projects

Add and Remove Projects =
Maodify the projects that are configured on the server

Move projects to the right to configure them on the server
Configured projects:

@ (F BAPI_GET DETAIL_RESULTSETApp

Available projects:

[-(F BAPI_ADDRESS_UPDATE_WORKLNITApp

P cust ceroeraw vio | =
L&

[-(F BAPI_CUST_GETDETAILApp
(5 BAPI_CUSTOMER_GETDETAIL_AliasApp

[ Add All >> |

’ << Remove Al ]

If server is started, publish changes immediately

2) Fiish | [ cancel

The project that you added should appear under the Configured projects. Add the SCA module
to the server by clicking Finish.
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&= Add and Remove Projects

Add and Remove Projects
Modify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects: Configured projects:

[ (5] BAPI_ADDRESS_LIPDATE _WORKLUNITADD ® (5] BAPL CLIST_GETDETAIL_INARD
[# |E BAPI_CUST_GETDETAILApD ([ BAPI_GET_DETAIL_RESULTSETApp
- (F BAPI_CUSTOMER_GETDETAIL_AliasApp

| Add All >> |

’ << Remove All ]

If server is started, publish changes immediately

@ gk | tiext> [ mpeh ][ cance
K

Testing the assembled adapter application
Launch the SAP GUL
Start the Transaction SE37.
Enter the BAPI name as BAPI_CUSTOMER_GETDETAIL and execute the BAPI

Enter the RFC target sys as JCO3RFCSERVER’ (as this is the RFC Program ID used when we
configured the module)

Enter the other data as shown in the figure below

Execute the BAPI
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=
Function modules  Edit Goto  Utilities(M) System Help

& 2l a0 e CHB Ohon AR @m

Test Function Module: Initial Screen

@P@ Debugging || Test data directory |

Test for function group V2D
Function module BAPI_CUSTOMER_GETDETAIL
ppercase/Lowercase ]
RFC target sys: JCO3RFCSERVER
Import parameters Value
CUSTOMERND
PI_SALESORG

PI_DISTR_CHAN
PI_DIVISION
PI_PASS_BUFFER

S —

In the console of WebSphere Integration Developer, you could see the
BAPI_CUSTOMER_GETDETAIL Business Object dump.

Clearing the sample content

No clean up is required after this tutorial.
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Chapter 8. Tutorial 5 Sending Structured
Query to SAP — Query Outbound
Processing

This tutorial demonstrates how the WebSphere Adapter for SAP Software’s QISS interface can be
used to retrieve data from tables directly (in this example, we will retrieve data from SAP’s table
Knal).

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTAILL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Server v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <WPS_INSTALIL>/lib ditectory.

When working with WebSphere Process Setver on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.

<WPS_INSTALIL> represents the WebSphere Process Server installation directory.
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Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTALL>/lib directory.

When working with WebSphere Application Setver on z/OS, add
${WAS_INSTALL_ROOT} /lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY _server_region_classpath

<WPS_INSTALIL?> represents the WebSphere Process Server installation directory.

Configuring the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.



WebhSphere. Bl E (=

&= New External Service

Select the Service Type or Registry
p
Select the type of service to create or reqistry to browse. 3

Filter: |type filter text =

Available Types:

=-@" Adapters

e CIcs

[ E-mail

Flat File

tte FTP
IS TMS
E iSeries
JOE 1D Edwards
[8] 1oBC
E Lotus Domina —
@g Orade
& PeopleSoft

' Siebel

[

[

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedal coding. During outbound processing, services running on WebSphere
Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the
SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

m

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

&= New External Service

Select an Adapter
Select the adapter you want to use,

A
{__J'

]|

|

@p IEM WebSphere Adapter for SAP Software (IBM ; 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction support

@ e ey ]| oo

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the

current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3. Specify a Connector Project name in the Import a RAR File screen and click Next.

4 New External Service

Import a RAR File -

Import & resource adapter archive (RAR) from the file system to create a connector project for the @ l
adapter, A
Archive file; C:\WID7\ResourceAdapters\SAP_7.0.0.0\CWYAP_SAPAdapter_Tw.rar

Connector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'|.f'.fel:u5|:uhere Process Server w7.0 W |

Cancel

':?:' [ < Back I HEEt > |

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries Screen, provide the locations of the
sapjco3.jar and sapjco3.dll or libsapjco3.so files.

&= New External Service

Locate the Required Files and Libraries LTX
L4
Connector projects reguire system-specific lbraries and JAR files,
When deploying the application to a stand-alone server, these files must be configured on the server, Maore ...

Specify the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C\SAPICo'sapico-nintel-3.0. 3\sapjco 3. jar | [Brnwse... ]

System library file (sapjco3.dll or ibsapjco3.so):* | C:\SAPICo'\sapjco-nintel-3.0. 3\sapjco 3.dl | [Brnwse... ]

@ o (o] o

5. Click Next.
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0. In the Select the Processing Direction screen, select the Outbound radio button and click

Next.
d= New External Service |._|®
Select the Processing Direction ?
Select the direction of adapter processing at run time. ;
) Inbound
Inbound processing passes data from the adapter to your service export.
(%) 0utbound:

Cuthound processing passes data from your service import to the adapter.

=

@ T W

Setting connection properties for the New External Service wizard
You must provide the following information in the Discovery Configuration screen:
User name
Password
Host name

System number
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SAP Client connection

Click Select to change the default Language code from English

Use the drop down option to change the default Code page from 1100.
Select Query interface for SAP Software (QISS) as the SAP Interface name.

Click Next.

4 New External Service

Specify the Discovery Properties ——

Connection properties

SAP system connection information

Host name: w | cwd31,svl.ibm.com

System number: | 01

Client: ' 100 |
Language code: | EN (English) | [Select... I
Code page: ‘ 1100 v‘

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Password: "

SAP interface name: Quer}' interface for SAP Software (QIS5)

[ ]change the logging properties for the wizard

Cancel

@ | <Back ]%w |

Figure: Select QISSasthe interface
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Selecting the Business Objects and services to be used with the adapter

+1
In the Find objects in the Enterprise System screen, click the QISS node. Then click the i
button.

&+ New External Service

Find Objects in the Enterprise System
@ The default number of objects to retrieve is 25, To retrieve more objects, select the filter ::LJ
ican to change the default setting. o
Discovered objects: Selected objects:
—+
S &)
155
=

Figure: Object Discovery and Selection
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Enter KNA1 (the name of the QISS object) in the Filter Properties for ‘QISS’ screen.

Click OK.

#+ Mew External Service

Filter Properties for "QISS' .

e A
Specify the properties. #_
COhject attribute to use for discovery: Discm'er objects by name w |
Find ohjects with this pattern: = | KNA1 |
Maximum number of objects to retrieve: | 25 w |
@ [ fIK l [ Cancel
M

Figure: Filter Propertiesfor RFC

Expand the QISS node.
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&= New External Service

Find Objects in the Enterprise System

@ The default number of objects to retrieve is 25, To retrieve more objects, select the filter ::LJ
icon to change the default setting.

Discovered objects: Selected objects:

= ) QIS (fitered)

@

i.ﬁ.dd selected discovered objects to selected objects. l

Figure: Retrieved QISSinterface based on search criteria

Click ik

to select KNA1 into Selected Objects.
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#= New External Service @

Specify the Configuration Properties for 'KNA1' e
A
Add a WHERE dause. .
Table KMA1: KUMNR. = fCustomerMumber 1
[iise SAP field names to generate attribute names;
Select a parent table. )
Map the primary key columns to the parent-table foreign key reference columns.
[Jselect or deselect all columns
Choose columns to be selected in your query.
LAND 1{Country Key)
MAME1{MName 1)
MAME2{Mame 2)
ORTOL{City)
PSTLZ{Postal Code)
REGIO(Reqion (State, Province, County))
SORTL(Sort field)
STRAS{House number and street)
TELF1(First telephone number)
TELFX(Fax Mumber)
¥CPDK(Indicator: Is the account a one-time account?)
ADRMR {Address) Z
@ [ O‘k_, [ Cancel

Accept the defaults and click OK.

=+l

Click the QISS node and then the _** button again.

Repeat Steps 4-7above for the pattern ADRC.

In Specify the Configuration Properties for ADRC -

Under Select a Parent Table for Table ADRC, select KNA1 from the drop down list.

Under the Map the primary key columns to the parent-table foreign key reference columns
section, choose the following from the drop down list:

CLIENT ADRNR
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ADDRNUMBER NONE

DATE_FROM NONE

NATION NONE

Select the defaults for Choose columns to be selected in your query.

Click OK.

d= New External Service @

Specify the Configuration Properties for 'ADRC' T

Add a WHERE dause. 45
Table ADRC: | CLIENT = /Client AND ADDRNUMEER = AddressNumber AND DATE_FROM = ,.'\-'al|

[[] Use SAP field names to generate attribute names

Select a parent table.

Table ADRC: [kra1 |

Map the primary key columns to the parent-table foreign key reference columns.

CLIENT{Client); | aDANR |
ADDRMNUMBER (Address number): [NONE |
DATE_FROM(Valid-from date - in current Release only 00010101 possible): !NONE A | i

E—

NATION(International address version ID):
[ select or deselect all columns

Choose columns to be selected in your query.
DATE_TO(valid-to date in current Release only 99991231 possible)
TITLE(Form-of-Address Key)
MAME 1(Name 1)
NAME 2(Name )
MAME3{Name 3)
MAME4{Name 4)
MAME_TEXT (Converted name field (with form of address))
NAME_CO(c/o name)
CITY 1{(City)
CITY2(District)
CITY_CODE(City code for dtystreet file)
CITYP_CODE(District code for City and Street file)
HOME_CITY (City (different from postal city))
CITYH_CODE(Different city for dty/street file)
CHCKSTATUS(City file test status)
REGIOGROURP(Regional structure grouping)

':i' [fgl{ Cancel

| £

Click Next.
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Generating Business Object definitions and related artifacts

In the Specify Composite Properties screen, use the default value for the Business object
namespace.

Name the relative folder name for generated Business Objects as bodefs.

#+ Mew External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

Business object namespace: = | http: /fwwewe.ibm, comxminsfprod fwebsphere fj2ca/sap |
Specify the relative folder for the generated business object:

Folder: | bodefs |
[ |Enable dynamic authentication function

Specify a custom retrieve function module instead of the standard retrieve function module:

Custom retrieve function name:

@ T T

b

Figure: Specify Composite Properties

Click Next

In Specify the Service Generation and Deployment Configuration screen enter the
connection properties and deployment properties.
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#+ New External Service

Specify the Service Generation and Deployment Properties
Specify properties for generating the service and running it on the server. "-\:)

23

Service Operations

TQ mod_iﬁ-' the names, or add a description to the operations to be generated in the interface file, Edit Operations...
dick Edit Operations.

Deployment Properties
Howe do you want to specfy the security credentials?
(") Using an existing JAAS alias {recommended)

(%) Lsing security properties from the managed connection factory:

The properties will be stored as plain text; no encryption is used.

User name: * | srnandur |

Password: + | PE— |

() Other

The quality of service to join the transaction provides a higher degree of data integrity, espedally in the event of a
failure. As the adapter only supparts local transactions, it must be the only one phase commit capable resource in
the transaction. Mare ...

Join the transaction (recommended)

Deploy connector project: |".".n'iﬂ'| madule for use by single application w

Specify the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection information
[Juse load balandng

To use load balancing, specify the load balancing properties in the Additional connection configuration
panel under the Advanced tab. 4

Host name: = | cwd31.svl.ibm.com |

System number: | 01 |

Client: | 100 |

Language code: | EM (English) | lSelect... ]

Code page: | 1100 w |

[ £

@ <Back || tpat= || Erish
4o
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Figure: Service Generation and Deployment Confignration

Note: You can enter an Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to

login in to the SAP system.

Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field to

create 2 new module.

In the New Business Integration Project screen, select Module radio button and click Next.

4= New Business Integration Project

Select a Business Integration Project Type
Select the type of business integration project that you want to create.,

() Mediation module

I

[/

IUse a module to integrate business applications and services. A module
can contain any type of compenent and can be deployed on WebSphere
Process Server. Mare. ..

IIse a mediation module to integrate and connect services, A mediation
module can contain mediation flows and can be deployed on WebSphere
ESE or WebSphere Process Server, More..,

In the New Module screen, type QISSKnalAdrcSample in the Module Name field, and then

click Finish.
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4= New Module |:-®

Create a Module

IJse & module to integrate business applications and services, A module can contain
any type of component and can be deployed on WebSphere Process Server,

Module name: | QIS5Kna1Adrcsample |

Lise default location

Open module assembly diagram

(2 Mext = Finish H Cancel

Click Finish on the Specify the Location Properties screen.
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&= New External Service

Specify the Location Properties

|4 1]
Specify location properties for where you want to save the service, h:lj
Properties for Service
Module: |QISSKna 1AdrcSample w | [ Mew.. i

Use the default namespace

Folder: | | [Bruwse. o ]

Mame: = | SAPCOuthoundInterface |

[]save business objects to a library

Description: |

':'E':' Mext = Fimish ] [ Cancel
g

Verify the results.
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SR Sl 155kna 1Adrcsample
=] ?DD] Assembly Diagram
E_ﬁ SAPCutboundInterface
ﬁ Dependencies
f Integration Logic
= ._'n) Data Types
== bodefs
= SapAdrc
=l SapAdrcContainer
= SapAdrcQuerybo
If] Sapknal
If] Sapkna 1Container
| Sapkna1Querybo
- DuplicateRecordrFault
| InvalidRequestFault
(] MatchesExceededLimitFault
| MissingDataFault
| MultipleMatchingR.ecordsFault
If] PrimarykeyPairType
[2J RecordNotFoundFault
(2] WBIFault
= .j, Interfaces
@ SAPQutboundInterface
E Transformations

Figure: Artifacts created after the EMD run for the QISS outbound module

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module QISSKnalAdrcSample by
selecting Add and Remove Projects.

The project QISSKnalAdrcSampleApp will be listed under Available projects.

After adding the project, the added project will appear under the Configured projects. Add the
SCA module to the server by clicking Finish.
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4= Add and Remove Projects

Add and Remove Projects =
Modify the projects that are configured on the server

Move projects to the right to configure them on the server

Available projects: Configured projects:
¥ (] BAPI_ADDRESS_UPDATE _WGRKUNITApD # (5 QISsKna JAdrcSampiedon
[ -_T_:ﬁ BAPT_CUST_GETDETAIL_INApp
[ (F BAPI_CUST_GETDETAILApp e
[#F] BAPI_GET_DETAIL_RESULTSETApp

[ Add All > 1

[ << Remove Al ]

If server is started, publish changes immediately

@ Bad Mext F'Eish Cancel

Testing the assembled adapter application

Test the assembled adapter application using the WebSphere Integration Developer’s Test Client.

Once the module is deployed to the Server, right click the module QISSKnalAdrcSample from
the Projects view and select Test > Test Module from the pop-up menu.

Enter the values for the input Business Objects as below —
Select the Operation as retrieveallSapknal

Set the value of CustomerNumberl as 0000000001
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= Detailed Properties

Spedify the component, interface, operation, and input parameter values for the Invoke event, then dick the Continue icon in the Events area to run the test.

More...
Configuration: | Default Module Test A |
Module: | QISSKna tAdreSample v|
Component: | SAPOutboundInterface ~ |
Interface: | SAPOutboundInterface w |
Operation: | retrieveallSapknal “ |

Initial request parameters:
() Value editor () ¥ML editor

L m]
MName | Type | Value |
= %: retrieveallSapkng 1Input Sapknal L Ll
21 Customerhumber 1 CustomerNumber 1<string > +' 0000000001 =
Countrykey <string> ' b
Name 1l<string> v
Mame2 <string > 4
City <string> v
PostalCode <string = '
RegionStateProvinceCounty <string = '
SortField <string = L
[ HouseMNumber AndStreet HouseNumber AndStreet<string = s
1 FirstTelephoneMNumber FirstTelephoneMumber <string > s
1 FaxMumber FaxMumber <string = L
[ IndicatorlsTheAccountACGneTimi IndicatorlsTheAccountAOnETimeAccoun, .. +
1 Address Address <string = v
[ SearchTermForMatchcodeSeard SearchTermForMatchoodeSearch<string>  «
[ SearchTermForMatchcodeSeard SearchTermForMatchcodeSearch731851...  «
[ SearchTermForMatchcodeSeard SearchTermForMatchoodeSearch731851...  +
[ Title Title <string = "
1 centralorderBlodForCustomer - CentralOrderBlockForCustomer <string = s hal

Add a child object ADRC by right clicking on SapAdrc Business Object and adding 1 element by
clicking Add Elements.

Click the Continue button B .

When the Select Deployment screen appears, select the WebSphere Process Server instance to
which you added the project and click the Finish button.

If security is enabled, type in the username and password in the popup User Login screen that
appears and click OK.
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B software

Check the

Value Editor | XML So

&= User Login - Default Module Test

Sign in to continue the test,
Usger ID:*

Security is enabled on the selected runtime environment(s).

| Edmin

Passward: *

[ Juse the authentication settings in the preference and never ask again

[ Ok, l [ Cancel ]
My

output of the service in the test client

urce |

[EE/B: | B R =
—|— MName L\} | Type | Value |
apkna 1Container ' o]
=-[@] Sapknal = Sapknaif] oy
B%: Sapkna1[0] Sapknal '
----- I customerNumber 1 CustomerNumber 1<string> + 000
Country string = v LS
MName 1<string > v =
Mame2<string = v
R
PostalCode <string= + 20108
----- lim] RegionStateProvinceCounty RegionStateProvinceCounty - v CA =
----- [ sortField SortField <string = + IEM
----- [ HouseNumberAndStreet HouseMumberAndStreet<string = + 577 airport blvd
----- [ FirstTelephoneNumber FirstTelephoneMumber <string = '
I FaxNumber FaxMumber <string = '
----- I IndicatorIsTheAccountACneTime IndicatorlsTheAccountAOneTimeAccount<string>  +
----- [ Address Address<string = '
----- [0 searchTermForMatchcodeSeardt SearchTermForMatchcodeSearch <string > '
----- [ searchTermForMatchcodeSeard SearchTermForMatcheodeSearch73185191<strin... + )
----- [ searchTermForMatchcodeSeard SearchTermForMatcheodeSearch73185192<strin,.. +
----- 1 Title Title <string> v Mr
----- 1 CentralorderBlockForCustomer ~ CentralOrderBlockForCustomer <string = '
lim] ExpressTrainStation ExpressTrainStation <string > R
----- [ Trainstation TrainStation <string '
----- [ InternationalLocationMNumberPar v
----- [ InternationalLocationMNumberPar v
----- [ AuthorizationGroup '
----- [ Industrykey '
----- 1 CheckDigitForThelnternationalle CheckDigitForThelnternationallocationumber<... + 0
----- [ DataCommunicationLineNo DataCommunicationLineMo <string > R
----- {0 DateOnWhichTheRecordWasCre DateOnWhichTheRecordWasCreated <string> '
----- 2 NameOfPersonWhoCreatedThet NameOfPerson\WhoCreatedTheObject<string > v
----- [0 IndicatorUnloadingPaintsExist  IndicatorlnloadingPointsExist <string = '
----- {3 centralBilingBlockForCustomer ~ CentralBillingElockForCustomer <string = '
----- I AccountiumberOfTheMasterRe: AccountiumberOfTheMasterRecordWithTheFisc...  +
----- [ workingTimeCalendar WorkingTimeCalendar <string = Hy
----- I AccounthumberOfAnAlternative AccounthlumberOfanAlternativePayer <string = '
----- lim] GroupKey Groupk string = '
----- lim] CustomerAccountGroup CustomerAccountGroup <string > + 0001
----- [ customerClassification CustomerClassification <string = '

£

Check that the data in the EIS matches the above output —
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Login to the SAP GUI using the credentials for the given SAP server
Start the Transaction SE16N

Enter the table name as KNA1, Press Enter and Execute (F8). Double clicking on
CustomerNumber ‘1’ will display the Customer details.

Repeat the (c) above for table ‘ADRC’.

Clearing the sample content

There is no clean up required after following this tutorial.
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Chapter 9. Tutorial 6: Sending data from an
SAP system (inbound processing)
using the ALE Interface

Sending IDoc data From SAP — ALE Inbound Processing

This tutorial demonstrates how to use the New External Service to generate Business Objects
based on the IDoc, and create an SCA module using the WebSphere Adapter for SAP Software
7.0.0.0 and deploy the module to the test environment of WebSphere Integration Developer 7.0.

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTAILL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALIL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <IWPS_INSTALIL>/lib ditectory.
When working with WebSphere Process Server on z/OS, add

${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath
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The sapjco3.jar is required to run the New External Service wizard.
<WPS_INSTALIL> represents the WebSphere Process Server installation directory.
Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTALIL>/lib directory.

When working with WebSphere Application Server on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY_server_region_classpath.

<WPS_INSTAILIL> represents the WebSphere Process Server installation directory.

Configuring the adapter for inbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&= New External Service

Select the Service Type or Registry

p
Select the type of service to create or registry to browse. g}
Filter: |type filter text | B
Available Types;
=@ Adapters A
oL C1cs
£ E-mail
Flat File
ttr FTP
I TS
EE iSeries
JOE 1D Edwards
[@] JoBC
B Lotus Domino .
E'@ Orade
& PeopleSoft
' Siebel "
Description:
Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding. During outhound processing, services running on WebSphere
Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the
SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

T
w

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

&= New External Service |:.®

Select an Adapter

L
=
Select the adapter you want to use, ek
i d
Y
L1} =
@P IEM WebSphere Adapter for SAP Software (IEM : 7.0.0.0)
IBM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)
b,

[
[/

T

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard eatlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the
current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3. Specify the Connector Project name in the Import a RAR File screen and click
Next.

# New External Service

Import a RAR File !

=
Import a resource adapter archive (RAR) from the file system to create a connector @ I
project for the adapter. |
Archive file: C:\WID_new'\RekourceAdapters\SAP_7.0.0.0VCWYAP_SAPAdapter Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'|."'.n'el:u5|:uhere Process Server v7.0 b |

® [(<mo Jmex> ]| e

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

& New External Service |:||E”z|
Locate the Required Files and Libraries QL

Connector projects require system-specific libraries and JAR files. Specify the location
of these files. l—‘

When deploying the application to a stand-alone server, these files must be configured on the server, Mare ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo'\sapjco3-nintel-3.0, 2\sapjco3. jar | [Brnwse... I

System library file (sapjoo3.dll or ibsapjco3.so):= | C:\SAPICo\sapjco3-nintel-3.0. 2isapjco3.di | |§Brnwse... |

TN W
M

Figure: Locate the required files and 1.ibraries screen

5. Click Next.

0. In the Select the Processing Direction screen, select Inbound radio button, then click Next.
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4= New External Service |;|'E|f'5__<|
Select the Processing Direction *

Select the direction of adapter processing at run time., ;
(©iInbound

Inbound processing passes data from the adapter to your service export.

) Dutbound

Outbound processing passes data from your service import to the adapter.

AN

':?:' < Back “ Mext = ]

Figure: Select the processing direction

Setting connection properties for the New External Service wizard

You must provide the following information in the Discovery Configuration screen:
e User name
e Password
e Host name
e System number

e SAP Client connection
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Click Select to change the default Language code from English

Use the drop down option to change the default Code page from 1100.

Select ALE as the SAP Interface name.

&= Mew External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Passmord: e |

saP interface name: |GG

[] change the logging properties for the wizard

(2 < Back ” Mext = ]

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (English) || select... |
Code page: | 1100 v|

Cancel

Figure: Select ALE asthe interface
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Selecting the Business Objects and services to be used with the adapter

Under Find Objects in the Enterprise System, expand the ALE node and click the Discover
IDoc From System.

# Mew External Service

Find Objects in the Enterprise System
Expand nodes to view and select discovered objects. Use filtering, if necessary, to limit number of ::LJ
objects displayed. o
Discovered objects: Selected objects:
7@
= & AE

@'._3\' Discover IDoc From System

é.'_j_\' Discover IDoc From File

Figure: Object Discovery and Selection

g

Click the #™ button.

Enter Alereq01 (the name of the ALE in SAP system) in the Filter Properties for Discover IDoc
From System screen.



We

GRT I C8 software

&+ New External Service

Filter Properties for 'Discover IDoc From System’

q i
Specfy the properties. [

#,
Object attribute to use for discovery: |Disu:u:wer objects by name W |
Find ohjects with this pattern: = | ALEREQD1 |
IDoc type to use for discovery: |Basi|: IDocs W |

Maximum number of objects to retrieve:

@ | g«

] [ Cancel

]

i

Figure: Filter Properties for ‘Discover IDoc from Systens

Click OK.

Expand the Discover IDoc From System node.

Select ALEREQO1 and click the ‘=== button
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&= Mew External Service

Find Objects in the Enterprise System
The default number of pl:ujeu:ts to retrieve is 25, To retrieve more objects, select the filter icon to ::LJ
change the default setting. o
Discovered objects; Selected objects:
A
= &) ALE

= é.'j\' Discover IDoc From System (filtered)

)} ALEREQOL

@'j\' Discover IDoc From File

Add selected discovered objects to selected objects,

Figure: Discovered ALEREQO1 IDoc

Cancel

In the Configuration Parameters screen, choose the default values and click OK.



WebhSphere. Bl E (=
4= Mew External Service @

Specify the Configuration Properties for "ALEREQO1' n
I"nll\-)

Attribute names of discovered objects can be generated from either SAP field names or from SAP
field descriptions, which are more understandable.

[ ]i=e SAP field names to generate attribute names!

The adapter can process the inbound IDoc packet as one business object or send each IDoc in the
packet as an individual business object,

[ ]send an IDoc packet as one business object

The adapter can directly exchange IDocs with components that have IDoc parsing capabilities.
[ ]send IDoc with unparsed data record

Specify the appropriate release version. If the release version is not in the list, enter the value by
editing the list. By default, the release version is set to the SAP system release version.

IDoc release version: | 700 LY

|\?z| |
L [ Ee.f‘ l [ Cance

Figure: Setting configuration parameters for the ALE selected

ALEREQO1 has now been added to the list of Business Objects to be imported.
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&= Mew External Service

Find Objects in the Enterprise System
Expand nodes to view and select discovered objects. Use filtering, if necessary, to limit number of ::LJ

objects displayed. o
Discovered objects: Selected objects:
B |
= &) ALE (@) ALEREQD1
=3 Discover IDoc From System (filtered)
(0) ALEREQOD1

@*3' Discover IDoc From File

@ <Back || mewt> | Fosh
by

Figure: Selected ALE added to the Objects to be imported

Click Next.

Generating Business Object definitions and related artifacts
In the Specify Composite Properties screen —
Select the Service operation as Create

Add MessageType=ALEREQ); MessageCode=; MessageFunction=; as IDoc Identifiers for the
service operation by clicking on Add button
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Enter bodefs as the name of the relative folder for the generated Business Object.

& New External Service

Specify Composite Properties
Specify properties that apply to all selected objects.
==

Configure IDoc inbound service operations —
[Docs selected
}:} Properties:
& ALEREQODL Egi'oﬁe IDoc selected, select existing service operations or add new ones in the field
Service operation:= | Create = |

Ensure IDocs corresponding to selected identifiers have been configured for outbound
processing from SAP, for the receiving partners assodated with RFC Program ID

IDoc Identifiers for the service operation:™®

MessageType=ALEREQ; MessageCode=; MessageFunction=; Add...

Remave

Business object namespace: = i http:ffwww.ibm. comfxmins fprod fwebsphere fj2cafsap |
Specify the relative folder for the generated business object:

Falder: Q| bodefs |
[]Enable dynamic authentication function

Finish Cancel

@ [ <Back || mext> |
gy

Figure: Specify Composite properties

Click Next

In the Service Generation and Deployment Configuration screen enter the connection
properties and deployment properties.
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d= New External Service

Specify the Service Generation and Deployment Properties

Specify properties for generating the service and running it on the server.

=)

Cees ez ] =

Deployment Properties — o
How do you want to specify the security credentials?
() Using an existing JAAS alias (recommended)
O, Jawa Aut AT 5 184
et |
(%) Using security properties from the activation spedfication
The properties will be stored as plain text; no encryption is used.
User name: = | srnandur |
Password: * | LA |
() Other
Deploy connector project: ‘With module for use by single application b
Specify the settings used to connect to SAP Software at run time:
Connection Properties
SAP system connection information -
[JUse load balancing
To use load balancing, specify the load balancng properties in the Additional connection configuration panel under the Advanced tab.
Host name: = | owd31.svl.ibm.com |
RFC program ID: = | JCO3RFCSERVERS |
Gateway host: | owd31.svl.ibm.com |
Gateway service: ! sapgwil |
Client: | 100 |
Language code: | EM (English) | [Select. & J
Code page: | 1100 v|
System number: | 01 |
The user name and password will not be encrypted and will be stored az plain text.
Event persistence configuration
Select this option to retain the events in-memory. This ensures a once-only delivery of the inbound events, If this option is not
selected, performance increases; but there is a risk of losing the events in transit if an unexpected shutdown occurs.
[CJEnsure assured-once event delivery (may reduce performance ) T

[<

Cancel

Figure: Service Generation and Deployment Configuration
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NOTE: You can enter an Authentication Alias already previously created using the
Administrative Console of the WebSphere Process Server or simply enter the username and
password used to login in to the SAP.

Enter the RFCProgramlID (as shown in figure). This must have been already configured in the
SAP system.

Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field to
create a2 new module.

When the New Business Integration Project screen appears, select Module radio button and
click Next.

4= New Business Integration Project

Select a Business Integration Project Type =M

Select the type of business integration project that you want to create, m

IIse a module to integrate business applications and services, A
module can contain any type of component and can be deployed
on WebSphere Process Server. More. ..

i) Mediation module  Use a mediation module to integrate and connect services. A
mediation module can contain mediation flows and can be
e deployed on WebSphere ESE or WebSphere Process Server,

®

1. In the New Module screen, type ALEIN_ALEREQO01 in the Module Name field, and
then click Finish.
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#= New Module

Create a Module

IJse @ module to integrate business applications and services. A module can contain any type of T
component and can be deployed on WebSphere Process Server,

Module name: | ALEIN_ALEREQO1| |

Use default location

Dpen module assembly diagram

() MNext = Fipish l [ Cancel

Click Finish on the Specify the Location Properties screen.
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&= New External Service

Specify the Location Properties il
Specify location properties for where you want to save the service, [DJ

Properties for Service

Module: | ALEIN_ALEREQD1 v | [ New...

| |

Use the default namespace
Folder: | | [Bruwse... ]
Mame: = | SAPInboundInterface |

[]save business objects to a library

Description: |

®

[ Eir["gh H Cancel

Verify the results.
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EREYALEIN_ALEREQD1 |

=] j'-'gl Assembly Diagram
?ﬁ_ﬁp SAPInboundInterface
ﬁ Dependencies
E’ Integration Logic
= D Data Types
== bodefs
= SapAleregol
| Sapaleregl 1DataRecord
| SapAlereql 1E2alegl
(2] SapAlereq0 1EZaler 1001
| SapAlereq0 1IDocBO
-l SaplDocControlRecord
= J Interfaces
@ SAPInboundInterface
E Transformations

Figure: Artifacts created after the EMD run fore ALE Inbound Module

Generating Reference Bindings

In the Business Integration Perspective of WebSphere Integration Developer, expand the
BAPI_CUST_GETDETAIL_IN SCA module, and double click the Assembly Diagram. The
Assembly Diagram screen appears with the module‘s Export component in view.

1. To create a new component, click the button of the Java component from the
Palette.

%-) ALEIN_ALEREQO1 - Assembly Diagram &

< | ne Palette

[23 (=) O, )
(= Favorites @ ?\'|_np SAPInboundInterface

(= Components

'-Té Untyped Component
Pfj Human Task

'-T'ﬂ Java

TE_L Mediation Flow

2 Process

B Rule Group

5= State Machine

Figure: ALLE Inbound interface in the Assembly editor

Click and drag the Java component to add the new component to the Assembly Diagram screen.
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Add a Wire between the SAPInboundlInterface and the Java component.

(D) There is a new element that has been added ¢

@ ?\'|_np SAPInboundInterface

Figure: ALE Inbound interface being wired to a target Component (end-point)

In the Add Wire screen, click OK.

4= Add Wire

<P ) This action will allow the target service to be used in other modules. The
\t!) service interface from the export will be added to the target. Do you want to
continue?

[ ] always create without prompt

| ok [ Cancel

Figure: Add Wire Confirmation Dialog

Right-click on the new component and select Generate Implementation. This creates a Java
component that will act as an endpoint.
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7 = Add... k
% ik Cc Change Type... r

L]
Generate Export. .. ¥

Select Implementation !

Synchronize Interfaces and References.., #
Refactor... »
Merge Components

of Cut
2 Copy
irver Loge | #1b Serv 8

StES | 59 pelete

T

Figure: Creating Java implementation for the target Component.

In the Generate Implementation screen, select the package in which the Java code will be
created and click OK. A Java file in an editor screen appears.

Edit the Java file if you may wish to write code to print trace and log messages or Data Object.

Ensure that the package com.ibm.j2ca.base.AdapterBOUtil is imported.

* Method generated to support implementation of operation "emitCreateAfterImageSaplAlereq0l"™ defined for WSDL port type
* named "S5APInboundInterface™.
* The presence of commonj.sdo.DataObject as the return type and/or as a parameter
* type conveys that it is a complex type. Please refer to the WSDL Definition for more information
* on the type of input, cutput and fault(s).
public void emitCreateAfterImageSapilereg0l |
Datalbject emitCreateAfterImageSaplAlereq0lInput) [
try {
System.out.println(AdapterBOUtil.serializeDatadbject (emitCreatedfterImageSapalereq0linput))
} catch (Exception e) {
J/ TODO Auto-generated catch block
e.printStackTrace():

Save the Java file and the assembly diagram.
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Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module
BAPI_CUST_GETDETAIL_INby selecting Add and Remove Projects.

The project BAPI_CUST_GETDETAIL_INApp will be listed under Available projects.

¢+ Add and Remove Projects |:_'@

Add and Remove Projects
Modify the projects that are configured on the server

(I

=)

Mave projects to the right to configure them on the server
Available projects: Configured projects:

a8

[E7] 'E BAPI_ADDRESS_UPDATE_WORKUNITApp
- (] BAPI_CUST_GETDETALL_INApp A.d.l}f
- (] BAPI_CUST_GETDETALLAPD

- 'Tj BAPI_GET_DETAIL_RESULTSETApp
[E7] ITE| QI55KnalAdrcSampleApp

Add All >

If server is started, publish changes immediately

@ Finish ” Cancel

The project that you added should appear under the Configured projects. Add the SCA module to
the server by clicking Finish.
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4~ Add and Remove Projects

Add and Remove Projects
Madify the projects that are configured on the server =

Mave projects to the right to configure them on the server
Available projects: Configured projects:

- (5 BAPI_ADDRESS_UPDATE_WORKUNITAPD & (G ALEIN_ALEREQOIADD
(5 BAPI_CUST_GETDETAIL_INApp
(5} BAPI_CUST_GETDETAILApp

'l% BAPI_GET_DETAIL_RESULTSETApp
- =E| QISSKna 1AdrcSampleApp

|

i Add All > |

’ << Remove Al l

If server is started, publish changes immediately

Testing the assembled adapter application
Launch the SAP GUIL
Start the Transaction WE19.
Choose the radio button Existing IDoc
Select an existing IDoc ALEREQO1 that you want to send
Set appropriate values in IDoc.
Click Standard Outbound Processing button
Select Continue in the pop-up box
This creates an ALE inbound event for the ALE inbound application deployed eatrlier.

In the console of WebSphere Integration Developer, you will see the ALEREQO1 Business
Object printed (as we entered a print statement in the Component implementation above).
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Chapter 10. Tutorial 7: Sending data to an SAP
system (Outbound processing)
using the ALE Interface

Sending IDoc data to SAP — ALE Outbound Processing

This tutorial demonstrates how to use the New External Service wizard to generate Business
Objects based on the IDoc, and create an SCA module using WebSphere Adapter for SAP
Software 7.0.0.0 deploy the module on to the WebServer Process Server to finally create IDoc in
SAP system. This tutorial uses the Basic IDoc ALEREQO1.

Scenario

The scenario explains how ALE outbound processing can be used in a real business case.
A user requests for information regarding a material through a website.
The website requires you to provide an email id to send the information to.

The whole communication model is asynchronous, and hence ALE interface is used.

Customer Services Portal — o

o o \OE’%\

Web user

|

\ 4

SAPOutboundInterfacelm: SAPInboundinterface Export
ort
P A
A 4
WebSphere Adapter for SAP WebSphere Adapters for SAP

SAP

T T
i
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Note: The tutorial only covers the part of the scenario marked in red colored rectangule in the
above picture.

1. The user submit request for a Material information in the Customer Services Portal using
Material number

2. The customer services portal will invoke the SCA Import using the with WebSphere Adapter
for SAP Software for ALEREQO1 IDoc.

3. The adapter receives a request from the client application in the form of a Business Object. The
adapter sends this data to SAP server in asynchronous form.

4. The SAP server after receiving the IDoc, tries to fetch the requested material Master data and
responds with a transaction id. The one way transaction with the SAP server ends here.

5. Then SAP system later returns the requested data to the request sender asynchronously.

6. The SCA export configured with WebSphere Adapter for SAP Software listening for events
pushed from the SAP system is active.

7. The adapter handles the response from SAP, converts it back to a Business Object format as
required by the client application and sends it.

8. The Customer Services Portal returns the response to the user through email.

Configuration prerequisites
Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTAILL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.
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When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.

Copy the sapjco3.jar file to the <WPS_INSTALIL>/lib ditectory.

When working with WebSphete Process Server on z/OS, add
${WAS_INSTALL_ROOT}/lib/the sapjco3.jar file to
WAS_SERVER_ONLY_server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.
<WPS_INSTALIL?> represents the WebSphere Process Server installation directory.
Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTAILIL>/lib directoty.
When working with WebSphere Application Server on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY _server_region_classpath

<WPS_INSTALIL> represents the WebSphere Process Server installation directory.

Configuring the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click on Next.
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&= New External Service

Select the Service Type or Registry
p
Select the type of service to create or registry to browse. 3
Filter: |type filter text | B
Available Types;
=@ Adapters ~
e C1es
B E-mail
Flat File
ftr FTP
e IMS
E iSeries
JOE 10 Edwards
[@] 1DBC
E Lotus Damino .
E'@ Crade
& PeopleSoft
‘a7 Siebel "
Description:
Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding, During outhound processing, services running on WebSphere
Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the
SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

T
i

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

#= New External Service

Select an Adapter
Select the adapter you want to use,

~4
{_J

L]

|

@p IEM WebSphere Adapter for SAP Software (IEM : 7.0.0.0)

IBM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction support

i3] [ < Back ” Mex|z l Finish
W

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the
current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node
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3. Specify a Connector Project name in the Import a RAR File screen and click Next.

4= New External Service E'E'
Import a RAR File ' >
Impart a resource adapter archive (RAR) from the file system to create a connector project for the @ l
adapter. r
Archive file: C:\WID7\ResourceAdapters\SAP_7.0.0.0\CWYAP_SAPAdapter_Tw.rar
Connector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'n.fu'el:15phere Process Server w7.0 A |

@ |

Figure: Import a RAR file screen
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4.

In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

& New External Service

Locate the Required Files and Libraries (T‘-h
Connector prajects require system-spedific libraries and JAR files.
When deploying the application to a stand-alone server, these files must be configured on the server, More ...

Specify the location of the files reguired to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo'sapjco-nintel-3.0. 3\sapjco3.jar | [Brnwse... ]
System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo \sapjco-nintel-3.0, 3sapjca3.dll | [Brnwse... ]

Cancel

5. Click Next.

0. In the Select the Processing Direction screen, select the Outbound radio button and click
Next.
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#= New External Service |Z|E]

Select the Processing Direction

Select the direction of adapter processing at run time,

) Inbound

Inbound processing passes data from the adapter to yvour service expart.

>

(*) Outbound

Quthound processing passes data from your service import to the adapter.

=

[ < Back ]MExt:b

—
L

Cancel

Setting connection properties for the New External Service wizard

You must provide the following information in the Discovery Configuration screen:

User name

Password

Host name

System number

SAP Client connection

Click Select to change the default Language code from English

Use the drop down option to change the default Code page from 1100.

Select ALE as the interface name




WebhSphere. Bl E (=

Click Next.

#= New External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
language code: | EN (English) || select... |
Code page: | 1100 v|

The user name and passward will not be encrypted and will be stored as plain text.

User name: * | srmandur |
Password: * | S |
SAP interface name: | =N |

[ ]change the logging properties for the wizard

@ | <Back || next> | Enish

b
Figure: Select ALE as the interface

Selecting the Business Objects and services to be used with the adapter

In the Find objects in the Enterprise System screen, expand ALE under Discovered objects,
—+l

click Discover IDoc From System and then click the 7 button.
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#= New External Service

Find Objects in the Enterprise System
Expand nodes to view and select discovered objects. Use filtering, if necessary, to limit number of ::LJ
objects displayed. d
Discovered objects: Selected objects:
ﬁ [a
= &) AE

e
.E;'._j.' Discover IDoc From System

£9) Discover IDoc From File

Figure: Object Discovery and Selection

Cancel

Enter Alereq01 (the name of the ALE in SAP system) in the Filter Properties for Discover
IDoc From System screen.
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Click OK.

#+ Mew External Service

Filter Properties for 'Discover IDoc From System’ 1
Specify the properties, #-_.
4
COhject attribute to use for discovery: |Disc::-'-.eer objects by name w |
Find ohjects with this pattern: = | ALEREQO1 |
IDoc type to use for discovery: |Eiasiu: IDocs w |

Maximurn number of objects to refrieve: |_ h |

]

'i?:' [ O, l [ Cancel
&)

Figure: Filter Propertiesfor ‘Discover IDoc From System’

Expand the Discover IDoc From System node and select ALEREQO1.
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# New External Service

Find Objects in the Enterprise System

@ The default number of objects to retrieve is 25. To retrieve mare objects, select the filter icon to ::LJ
change the default setting.

Discovered objects: Selected objects:

= & AE
= é.'j' Discover IDoc From System (filtered)

(9] AL EREQD1

@'j' Discover IDoc From File

|.-5.|:||:| selected discovered objects to selected objects,

Figure: Retrieved ALEREQOL IDoc based on search criteria

Click the i===idbutton.

In the Configuration Properties screen, accept the default values by clicking on OK.
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#+ Mew External Service E

Specify the Configuration Properties for "ALEREQOD1’

Attribute names of discovered objects can be generated from either SAP field names or from SAP
field descriptions, which are more understandable.

[ ]use SAP field names to generate attribute names

gRFC enables systems to send serialized outhound data using a queus, which guarantees a
once-only delivery of interdependent function modules in the correct order.

[ ]Use gRFC to serialize outbound data using a queue

Specify the appropriate release version. If the release version is not in the list, enter the value by
editing the list. By default, the release version is set to the SAP system release version.

IDoc release version: 00 “

@ | qe [ Cancel
W

Figure: Setting configuration parameters for the IDoc ALEREQO1

ALEREQO1 has now been added to the list of Business Objects to be imported. Click Next.
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&= New External Service

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects, Use filtering, if necessary, to limit number of ::LJ

objects displayed. d
Discovered objects: Selected objects:

@
ERGIT: (@ ALEREQO1
=-&3) Biscover IDoc From System (filtered)
(@) ALEREQD1

@@' Discover IDoc From File

':':’:' [ < Back ” Mext = l Finish

53

Figure: Selected ALEREQO1 added

In the Specify Composite Properties screen, enter bodefs as the name of the Folder Name for
the generated Business Object.
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&+ New External Service

Specify Composite Properties
Spedfy properties that apply to all selected objects.

Business object namespace: = | http:/fwewowe.ibm. comxminsfprod fwebsphere fi2cafsap |
Spedify the relative folder for the generated business object:

Falder: | bodefs |
[ ] Enable dynamic authentication function

@ o o] o

Figure: Specify Composite Properties

Click Next.

In the Service Generation and Deployment Configuration screen enter the deployment
and connection information.
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&= New External Service |:IE]

Specify the Service Generation and Deployment Properties

Specify properties for generating the service and running it on the server, “\_)

|

Service Operations

Tg n1-::ud_i1’5l the names, or add a description to the operations to be generated in the interface file, Edit Operations...
dick Edit Operations.

Deployment Properties
How do you want to specify the security credentials?
() Using an existing JAAS alias {recommended)

(¥) Using security properties from the managed connection factory

The properties will be stored as plain text; no encryption is used.

User name: * | srnandur |

Password: * | [US— |

() other

The quality of service to join the transaction provides a higher degree of data integrity, espedally in the event of a
failure. As the adapter only supports local transactions, it must be the only one phase commit capable resource in the
fransaction. More ...

Join the transaction (recommended)

Deploy connector project: With module for use by single application w

Spedify the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection information
[]Use load balanding

To use load balancing, spedfy the load balancing properties in the Additional connection configuration
panel under the Advanced tab.

Host name: = | cwd31.svl.ibm.com |

System number: | 01 |

Client: | 100 |

Language code: | EN (English) | [Select... l

Code page: | 1100 L |

158

@ [ < Back “ Newt> | Finish

kg

Figure: Service Generation and Deployment Confignration
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Note: You can either enter an Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP system.

Click Next

In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select the Module radio button
and click Next

4= New Business Integration Project

Select a Business Integration Project Type
Select the type of business integration project that you want to create.

) Mediation module

1]

/A

@Huduleg IUse a madule to integrate business applications and services. A module
can contain any type of component and can be deployed on WebSphere
| Process Server. Maore. ..

IUse a mediation module to integrate and connect services. A mediation
madule can contain mediation flows and can be deployed on WebSphere
ESE or WebSphere Process Server, Mare..,

In the New Module screen, type ALEOUT_ALEREQO1 in the Module Name field and click

Finish.
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4= Mew Module |:

Create a Module

s

IUse a module to integrate business applications and services. A module can contain any type of T
component and can be deployed on WebSphere Process Server.,

Module name: | ALEOUT_ALEREQO1] |

Lse default location

Open module assembly diagram

() Mext = [ Einf=h H Cancel

Figure: Specify the Location Properties

Click Finish on the Specify the Location Properties screen.
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&= New External Service

Specify the Location Properties T
Specfy location properties for where you want to save the service. [DJ

Properties for Service

Module: |.-5.LEOLI'I'_ALEREQIZIl v| | Mew... |

Uze the default namespace

Folder: | | [ Browse. .. ]

Mame: = | SAPOutboundInterface |

[]5ave business objects to a library

Description: |

@ Mext = Eirish ] [ Cancel

My

Verify the results
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ERAN A EQUT ALEREQO1
=] k- Assembly Diagram

E_n:? SAPCOuthoundInterface
ﬁ Dependencies
.f"_: Integration Loagic
= ._':IJ Data Types
== bodefs
= Sapéleregdl
= Sapéleregl1DataRecord
=l Sapalereql1E2aleql
(2] SapalereqD1E2aler 1001
] Sapalereqd 1IDocBO
| SapIDocControlRecord
[ DuplicateRecordFault
| InvalidRequestFault
[] MatchesExceededLimitFault
| MissingDataFault
| MultipleMatchingR ecordsFault
I':] PrimarykeyPairType
[ZJ RecordMotFoundFault
(2] WBIFault
= ._I, Interfaces
@ SAPQOutboundInterface
E Transformations

Figure: Artifacts created after the EMD run for the ALE outbound Module

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module ALEOUT_ALEREQO1 by
selecting Add and Remove Projects.

The project ALEOUT_ALEREQO1App will be listed under Available projects.
After adding the project, it should appear under the Configured projects.

Add the SCA module to the server by clicking Finish.
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4+ Add and Remove Projects

Add and Remove Projects =
Modify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects: Configured projects:

(3 ALEIN_ALEREQO1App ® (B ALEOUT ALEREQD 40D
[ (B BAPI_ADDRESS_UPDATE_WORKUNITADD
(5 BAPL_CUST_GETDETAIL_INApp

(5 BAPL_CUST_GETDETAILApp

(5 BAPL_GET_DETAIL_RESULTSETApp

[ ITj QIS5Kna1AdrcSampledpp

[ Add All 2> |

[ << Remove Al ]

If server is started, publish changes immediately

'::':’::' Bach ext Fifsh Cancel

Testing the assembled adapter application
Test the assembled adapter application using the WebSphere Integration Developer’s Test Client.

Once the module is deployed to the Server, right click the module ALEOUT_ALEREQO1 from
the Projects view and select Test > Test Module from the pop-up menu.

To test this tutorial, you use data from your SAP server. If you have not already done so, obtain
actual values for the following data. If necessary, contact your SAP administrator to obtain the
data.

Client

IdocNumber

SenderPort

PartnerNumberofSender

ReceiverPort

PartnerNumberofRecipient

Enter values in the Test Client as follows —
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a) Enter the IDoc Control record data - Right-click SapAlereq01IDocBO and click Add Element
b) Type the following values in the associated fields:
ReceiverPort

PartnerTypeOfSender

NameOfBasicType

PartnerNumberOfSender

NameOfTableStructure

Client

LogicalMessageType

PartnerNumberOfRecipient

SenderPort

IdocNumber

PartnerTypeOfRecipient

c) Set the IDoc Data Record level property values.
Logicalmessagetype - ALEREQ

Messagetype - ALEREQ

Right-click SapAlereq01E2aleql and click Add Element
IncludingExcludingindicator - E
RelationaloperatorEqNeGtLtGele - LT
Lowetlimitforfieldcontents - 0

Uppetlimitforfieldcontents - 1
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b General Properties

+ Detailed Properties

Configuration: | Default Module Test

Maodule: | ALEOUTS2mple
Component:  |5APOutboundInterface 1
Interface: | SAPQuthoundInterface 1
Operation: | executeSapaleregil

Initial request parameters

i~ SAPTransactior string

Marne | Type
= %: executeSapAlereqliIn SapAleregliBG
[ verb verb<string >
EI%: Sapaleregdl SapAlereqil

""" 2 Copy Value
@ Paste Value

Select Al

SetTo

k

Add value to Pool,.,
IUse Value from Poal, ..
Import from XML File. .

|Use Derived Type...

T4 s&E

Show Change Summary

Click the Continue button B .

When the Select Deployment screen appears, select the WebSphere Process Server instance to

which you added the project and click the Finish button.

If security is enabled, type in the username and password in the popup User Login screen that
appears and click OK.
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Chapter 11. Preparing to run through the AEP
tutorial

Configuration prerequisites

Import the sample transports supplied along with the adapter into your SAP system.

The following is a list of the SAP R/3 version 4.7/ERP transport files necessary to support AEP

module.

To ensure that all necessary tables are created before the data for those tables is added, the
transports must be installed in the order listed. These files can be found in the directory
<WID_INSTALLATION_DIRECTORY>\ResourceAdapters\SAP_7.0.0.0\transports

File name Transport Number
47_Primary VELK900031
47_Infrastructure ERPK900137

The adapter requires the following libraries which are supplied by SAP.
Get the latest OS specific SAP JCO 3 libraries from the SAP Service Marketplace.

They should be copied to a folder on the system where the WebSphere Integration Developer’s
EMD will be executed.

SAP JCO files

sapjco3.jar

sapjco3.dll
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Extracting the sample files

Replicas of the artifacts that you create when using the New External Service wizard are
provided as sample files for your reference. Use these files to verify that the files you create with
the New External Service wizard are correct.

Go to the samples folder and unzip Tutorial AEP.zip into a directory of your choice (you may
want to create a new directory).

File name Description

AEPOutBoundSample/ Contains the SCA import for the resource

SAPOutboundInterface.import| adapter.

AEPOutBoundSample/ Service interface to invoke the resource

SAPOutboundlnterface.wsdl | adapter.

AEPOutBoundSample/ Business Object definition for the

SapYxrv5b01.xsd SapYxrv5b01.

AEPOutBoundSample/ Business Object definition for the Business

SapYxrv5b01BG.xsd Object graph.

AEPOutBoundSample/ Business Object definition for the
SapYxrv5b01Z2xrv51000.

SapYxrv5b01Z2xrv51000.xsd

AEPOutBoundSample/ Business Object definition for the

SapYxrv5b01Z2xrv52000.
SapYxrv5b01Z2xrv52000.xsd

AEPOutBoundSample/ Business Object definition for the

SapYxrv5b01Z2xrv53000.
SapYxrv5b01Z2xrv53000.x5d

AEPOutBoundSample/ Business Object definition for the

SapYxrv5b01Z2xrv54000.
SapYxrv5b01Z2xrv54000.xsd
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AEPOutBoundSample/

SapYxrv5b01Z2xrv55000.x5d

Business Object definition for the
SapYxrv5b01Z2xrv55000.

AEPOutBoundSample/

SapYxrv5b01Z2xrv56000.x5d

Business Object definition for the
SapYxrv5b01Z2xrv56000.

AEPOutBoundSample/

SapYxrv5b01Z2xrv57000.xsd

Business Object definition for the
SapYxrv5b01Z2xrv57000.

AEPOutBoundSample/

SapYxrv5b01Z2xrv58000.xsd

Business Object definition for the
SapYxrv5b01Z2xrv58000.

AEPOutBoundSample/

SapYxrv5b01Z2xrv59000.xsd

Business Object definition for the
SapYxrv5b01Z2xrv59000.

AEPOutBoundSample/

SapYxrv5b01Z2xrv52000.xsd

Business Object definition for the
SapYxrv5b01Z2xrv5a000.

AEPOutBoundSample/

SapYxrv5b01Z2xrv5b000.xsd

Business Object definition for the
SapYxrv5b01Z2xrv5b000.

AEPOutBoundSample/

SapYxrv5b01Z2xrv5c000.xsd

Business Object definition for the
SapYxrv5b01Z2xrv5c000.

AEPOutBoundSample/

DuplicateRecordFault.xsd

Fault Schema

AEPOutBoundSample/

MatchesExceededLimitFault.xs

Fault Schema

AEPOutBoundSample/

MissingDataFault.xsd

Fault Schema
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AEPOutBoundSample/ Fault Schema

MultipleMatchingRecordsFault.

AEPOutBoundSample/ Fault Schema

PrimaryKeyPairType.xsd

AEPOutBoundSample/ Fault Schema

RecordNotFoundFault.xsd

AEPOutBoundSample/ Fault Schema

WBIFault.xsd

Triggering of events in the SAP System
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Chapter 12. Tutorial 8: AEP Interface outbound
processing

This tutorial demonstrates how the WebSphere Adapter for SAP 7.0.0.0 uses the
AEP interface to create, update, delete and retrieve a record from the Customer
Master table. This tutorial explains how you can configure the adapter for outbound
processing deploy and test the module for processing.

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTAILL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <IWPS_INSTALIL>/lib ditectory.

When working with WebSphere Process Server on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.

<WPS_INSTALIL> represents the WebSphere Process Server installation directory.
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Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTALL>/lib directory.

When working with WebSphere Application Setver on z/OS, add
${WAS_INSTALL_ROOT} /lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY _server_region_classpath.

<WPS_INSTALIL?> represents the WebSphere Process Server installation directoryConfiguring.

the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service.

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&= Mew External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: | type filter text

Available Types:

=@ Adapters
o C1es

1 E-mail

Flat File

tte FTP

g 1Ms

EE iseries

JOE 1D Edwards
8] JoBC

E Lotus Domino
F@ COrade

& PeopleSoft

' Siebel

[*

[

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without special coding. During outhound processing, services running on WebSphere
Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the
SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS,

Einish Cancel

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

#+ New External Service

Select an Adapter
Select the adapter you want to use.

(%

]|

rl

@p I6M WebSphere Adapter for SAP Software (IBM : 7.0.0.0)

IBM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IBM WebSphere Adapter for SAP Software with transaction suppart

@ oo ) oty

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard eatlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the

current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.

3. Specify a Connector Project name in the Import a RAR File screen and click Next.
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&= New External Service Elfgl
I

Import a RAR File

Import a resource adapter archive (RAR) from the file system to create a connector project for the @ I
adapter, |

Archive file: C:AWID7\ResourceAdapters\SAP_7.0.0,.0\CWYAP_SAPAdapter_Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |

Target runtime enviroment: |'L"'.I'E|35|:I|'|EI'E Process Server v7.0 W ‘

® s

Figure: Import a RAR file screen

4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.
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d= New External Service

Locate the Required Files and Libraries LTX
L4
Connector projects require system-spedific libraries and JAR files,
When deploying the application to a stand-alone server, these files must be configured on the server, Maore ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
sdministrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo'\sapjco-nintel-3.0. 3\sapico 3.jar | [Brnwse... ]

System library file (sapjco3.dll or ibsapjco3.so):* | C:\SAPICo'\sapjco-nintel-3.0. 3\sapjco 3.dl | [Brnwse... ]

Cancel

@ < Back I Mﬁt} {

5. Click Next

0. In Select the Processing Direction screen, select the Outbound radio button and click Next.
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#= New External Service |Z|E]

Select the Processing Direction *
Select the direction of adapter processing at run time, ;
) Inbound

Inbound processing passes data from the adapter to yvour service expart.

>

(*) Outbound

Quthound processing passes data from your service import to the adapter.

=

s ]

Setting connection properties for the External Service wizard

You must provide the following information in the Discovery Configuration screen:

e [User name

e Password

e Host name

e System number

e SAP Client connection

e Click Select to change the default Language code from English
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Use the drop down option to change the default Code page from 1100.

Select Advanced event processing (AEP). as the SAP Interface name.

Click Next.

& New External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (English) | | select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

PESSWﬂrd: = | EEEEEEEE |
SAP interface name: Adn‘anced event processing (AEF) 3 |

[ ]change the logging properties for the wizard

Cancel

@ <Back || Nepts |
iy

Figure: Select AEP astheinterface
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Selecting the Business Objects and services to be used with the adapter

In the Find Objects in the Enterprise System screen, expand AEP node under
+I
Discovered objects, sclect Discover IDoc From System, then click the + button.

# New External Service

Find Objects in the Enterprise System
Expand nodes to view and select discovered objects. Use filtering, if necessary, to limit ::LJ
number of objects displayed. o
Discovered objects: Selected objects:

31'3&[1:1

|Create or edit filter.

= 9 aep

F i =
il Discover IDoc From System

Figure: Find Objects in the Enterprise System
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Enter Y* in the Filter Properties for Discover IDoc From System screen.

&= New External Service E]
Filter Properties for "Discover IDoc From System’ _}~
Spedfy the properties. -
Object attribute to use for discovery: |Disu:u:wer objects by name b |
Find objects with this pattern: *l“'| Y+ |
IDoc type to use for discovery: |Eiasi|: IDocs W |
Maximum number of objects to retrieve: | 25 W |
(7 [ QK l [ Cancel ]
M,

Figure: Filter Propertiesfor RFC

Click OK.

Expand the Discover IDoc From System node, select YXRV5BO01 and click button.
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#+ Mew External Service

Find Objects in the Enterprise System

@ The default number of objects to retrieve is 25. To retrieve more objects, select the filter ::LJ
icon to change the default setting. o

Discovered objects: Selected objects:

EE]
= &) aep
= é'j' Discover IDoc From System (filtered)

(@) YSHP_IBDLV_CONFIRM_DECENTRALO1
(@) v¥RVSBO1

Figure: Retrieved IDocs based on search criteria

In Specify the Configuration Parameters for YXRV5BO0Y’, click Deselect All button and then

select only KUNNR (Customer Number 1) field. The Customer Number 1 is the Primary Key
field. Click OK.
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&= New External Service

Specify the Configuration Properties for "YXRV5B0O1'

Attribute names of discovered objects can be generated from either SAP field names or from
SAP field descriptions, which are more understandable.

[ ]use SAP field names to generate attribute names

Specify the appropriate release version, If the release version is not in the list, enter the value
by editing the list. By default, the release version is set to the SAP system release version.

IDoc release version: | 700 W

The leaf nodes represent fields in the selected IDoc child segments. Select one or more nodes
to be used as the primary key for the IDoc for updating or retrieving SAP data.

R
=@o ~
= < Z1XRVSD(5AP4_CustomerMaster [ SAP4_CustomerPartner)
[]% MSGFN{Function) —
< KUNMR{Customer Mumber 1}
[[] ¢ ANRED(Title)
[] < aUFsSD{Central order block for customer)
[] < BAHME(Express train station)
[] % BAHNS(Train station)
[] % BBBMR{Character Field With Field Length 7}
[] BBSMR{R/2 table)
[]% BEGRU{Authorization Group)
[] < BRSCH(Industry key)
[] % BUBKZ(Character field of length 1) w

[ Select All ”Deselect AII]

'i?:' [ Qi H Cancel ]
by

Figure: Setting configuration parameters for the IDoc YXRV5BO01 selected

Click Next on the Find objects in the Enterprise System screen.

Generating Business Object definitions and related artifacts

In the Specify Composite Properties screen, click the Add button and select Create from the Add
Value pop up.

Enter the ABAP function module name and the relative folder for the generated Business Object
as shown below.
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#+ Mew External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

Configuration properties for wrapper objects
IDocs selected:™

YXRV5B01 Add

Service operations for selected IDoc: ™

Create add...

Remove

ABAP function module name for selected operation:= | ¥_X¥R_CUSTOMERMASTER_C1 |

Business object namespace: = | htu:u:;"fwww.iI:um.cu:umfxmlnsfpru:udf'n'el:|

Specify the relative folder for the generated business object:
Folder: | bodefs |

[ |Enable dynamic authentication function

® (<o J[ s ]| oo

Repeat the steps (a) and (b) above for Update, Delete and Retrieve operations. Give the ABAP
function module name as mentioned below.

Update - Y_XR_CUSTOMERMASTER_C2
Delete - Y_XR_CUSTOMERMASTER_C3
Retrieve - Y_XR_CUSTOMERMASTER_C4

These are custom Function Modules in SAP system provided as samples by the adapter installer,
which were called based on the operation.

Click Next.
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#= Mew External Service

Specify Composite Properties
Spedify properties that apply to all selected objects,

Configuration properties for wrapper objects
[Docs selected: ™

YXRV3E01 dd

Service operations for selected IDoc:®

Create Add
Update

ABAP function module name for selected operation: = | Y_X¥R_CUSTOMERMASTER_C4 |

Business object namespace: = | htu:u:ff'n"n"n'.ihm.cnmfxmlnsfprndf'n'el:|

Spedfy the relative folder for the generated business ohject:
Folder: | bodefs |

[ ]Enable dynamic authentication function

@ <Back || Mert> | Fnsh
o

On the Service Generation and Deployment Configuration screen, enter the connection and
deployment information.
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4= New External Service |:I®

Specify the Service Generation and Deployment Properties
Specify properties for generating the service and running it on the server, N‘J

|

Service Operations

Tp rnod_iﬂf the names, or add a description to the operations to be generated in the interface file, Edit Operations...
click Edit Operations.

Deployment Properties
How do you want to spedify the security credentials?
() Using an existing JAAS alias (recommended)

(¥)Lsing security properties from the managed connection factory:

The properties will be stored as plain text; no encryption is used.

User name: * | srnandur |

ERR o [ |

() Other

The quality of service to join the transaction provides a higher dearee of data inteqrity, espedially in the event of &
failure. As the adapter only supports local transactions, it must be the only one phase commit capable resource in
the transaction. More ...

Join the transaction (recommended)

Deploy connector project: |Wiﬂ1 module for use by single application w

Specify the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection information
[ use load balanding

To use load balancing, specify the load balancing properties in the Additional connection configuration
panel under the Advanced tab.

Host name: = | cwd31.svl.ibm.com |

System number: | 01 |

Client: [ 100 |

Language code: | EM (English) | lSeIect... l

Code page: | 1100 v |

|

@ | <Back | e > || Enih

Figure: Service Generation and Deployment Confignration
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Note: You can either enter an Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP.

Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select Module radio button and click
Next.

4= New Business Integration Project

Select a Business Integration Project Type

[
Select the type of business integration project that you want to create., m

G}Huduleg IJse & module to integrate business applications and services, A module
can contain any type of component and can be deployed on WebSphere
] Process Server, Mare...

) Mediation module Use a mediation module to integrate and connect services, A mediation
module can contain mediation flows and can be deployed on WebSphere
A ESE or WebSphere Process Server, Maore. ..,

/A4

®

In the New Module screen, type AEPOUT_YXRV5B01 in the Module Name field, and then
click Finish.
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4 New Module

Create a Module

s

IJse & module to integrate business applications and services. A module can contain any type of T
component and can be deployed on WebSphere Process Server,

Module name: | AEPOUT_YXRVSB01 |

Lise default location

Open module assembly diagram

(2 Mext = i Firf | [ Cancel

o
n
=5

Click Finish on Specify the Location Properties screen.
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#+ Mew External Service

Specify the Location Properties

[l
Specify location properties for where you want to save the service, h:lj
Properties for Service
Module: | AEPOUT_YXRVSBO1 v || new.. |

IUse the default namespace

Folder: | | [Eiru::wse. . ]

Mame: = | SAPCutboundInterface |

[ ]save business objects to a library

Description: |

@ vec - | [eren ][ conce

Verify the results.
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SRS AEPOUT_YXRVSEOL |

= ?.;%’J Assembly Diagram
E_ﬁ SAPCOuthoundInterface
ﬁ Dependencies
E’ Integration Logic
= S Data Types
== bodefs
= Sapfurvshol
(2] Sap¥xrv5h01Z 2xrv51000
[C] SapYurvShi 12 2xrv52000
(2] SapYrvSh01Z2xry53000
(2] Sap¥xrv5bi 12 2xrv 54000
(=) Sap¥xrv5b01Z2xrv55000
(2] Sap¥xrv5h01Z2xrv 55000
(2] Sap¥xrv5h01Z 2xrv 57000
(2] Sap¥xrv5h01Z 2xrv 58000
(2] Sap¥xrv5h01Z 2xrv 55000
(2] Sap¥xrv5h01Z 2xrv 53000
[C] SapYrvShi 12 2xry 5000
(2] SapYrvShi1Z 2xry5c000
| DuplicateRecordFault
| InvalidRequestFault
(2] MatchesExceededLimitFault
| MissingDataFault
| MultipleMatchingRecordsFault
If] PrimarykeyPairType
(2] RecordMotFoundFault
(2] WBIFault
= B Interfaces
@ SAPQutboundInterface
E Transformations

Figure: Artifacts created after the EMD run for the AEP outbound Module

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module AEPOUT_YXRV5B01 by
selecting Add and Remove Projects.

The project AEPOUT_YXRV5B01App will be listed under Available projects.
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4+ Add and Remove Projects

Add and Remove Projects
Modify the projects that are configured on the server =

Move projects to the right to configure them on the server
Available projects: Configured projects:

] aerouT viRvSBD 1ARD
|:é| ALEIN_ALEREQOD1App &>
(F§ ALEOUT_ALEREQO1App

(F7 BAPI_ADDRESS_UPDATE_WORKUNITApp
(5 BAPI_CUST_GETDETAIL_INApp < Remove
(B BAPI_CUST_GETDETAILApp

(8 BAPI_GET_DETAIL_RESULTSETApp
-IE QI55Kna1AdrcSampledpp

[ T

[ Add Al >> |

If server is started, publish changes immediately

®

Finish ” Cancel

After adding the project, the added project should appear under the Configured projects. Add the
SCA module to the server by clicking Finish.

¢+ Add and Remave Projects

Add and Remove Projects
Modify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects: Configured projects:

[ ALEIN_ALEREQQ1App B (0 ABPOUT_ VIRVEO 14pp
(51 ALEOLUT_ALEREQD1App 2
(5 BAPI_ADDRESS_UPDATE_WORKUNITApD
(3 BAPI_CUST_GETDETAIL_INApp
(5 BAPL_CUST_GETDETAILAPp < Remave
(Fy BAPL_GET_DETAIL_RESULTSETApp
(5 QIssknaladresampleapp

-

( Add Al >> |

[ << Remove Al ]

If zerver is started, publish changes immediately

o
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Testing the assembled adapter application
Test the assembled adapter application using the WebSphere Integration Developer’s Test Client.

1. Once the module is deployed to the Server, right click on the module
BAPI_CUST_GETDETAIL from the Projects view and select Test > Test Module from the
pop-up menu.

2. Enter values in the Test Client as shown in the figure below
For Retrieve operation

Operation: Retrieve (retrieveSapYxrv5b01)
Customernumberl: 0000000802 (of BO SapYxrv5b01)

Verb: Create or Update or Delete

5' Detailed Properties

Specify the component, interface, operation, and input parameter values for the Invoke event, then dick the Continue icon in the Events area to run the test.

Configuration: | Default Module Test A4 |
Madule: [aEPOUT_vxrysBO1 |
Component: |5APOuﬁaoundInterface w |
Interface: |5APOutboundInterface w |
QOperation: | retrieveSapyurvsb01 W |

Initial request parameters;
(®) Value editor () XML editor

% [=| |
MName Value
= By retrieveSapysxrysho nput

1 Function
11 Customernumber 1
T Title
[ Centralorderblockforcustomer
i Expresstrainstation
[ Trainstation
[ Characterfieldwithfieldliength?
1 r2table
[ authorizationgroup
[ tndustrykey
1 Characterfieldofiength 1
|I_| Datacommunicationlinena
= Centralbilingblockforcustomer
[ Accountnumberofthemasterrecor 2
1 Accountnumberofanalternativep: 2
[ Groupkey
| Customeraccountgroup
[ customerdassification

>

0000000302

L0 LR et tities

€

(@ To edit values, start typing or press F2,
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For the Create operation

Title: Mr

Namel: Sample Test

City: Burlingame

Sorttield: IB

Customeraccountgroup: 0001

Characterfieldoflength11: EN
Transportationzonetoorfromwhichthegoodsaredelivered: 0000000001
Countrykey: US

ii. Add an element to SapYxrv5b01Z2xrv51000, and populate the following
Salesorganization: 0001

Distributionchannel: 01

Division: 01

Shippingconditions: 01

iii. Add an element to SapYxrv5b01Z2xrv54000, and populate the following
Nameofglobalcompanycode: 0001

Reconciliationaccountingeneralledger: 120000

¢) For Update operation

Customernumberl: 0000000815

Title: Mrs

3. Click the Continue button = .

When the Select Deployment screen appears, select the WebSphere Process Server instance to
which you added the project and click the Finish button.

4. If security is enabled, type in the username and password in the popup User Login screen that
appears and click OK.



Login - Default Module Test

Security is enabled on the selected runtime environment{s).
Sign in to continue the test,

IJser IDn*
| Edrmin |

Password: *

[ Juse the authentication settings in the preference and never ask again

[ O, ][ Cancel ]
M

5. Check the output of the service in the test client

a. Retrieve

Return parameters

\E% B =
. MName | Type | Value

= %: retrieveSapYry 5b0 10utput SapYxrv5b01BG v
[ verb verb<string ®y
E%; SapYxrvSho1l SapYxrv5b01 '
-] Function Function <string = +' CxIgnore
LI—I Customernumber 1 Customernumber 1<string = + 0000000802
-1 Title Title <string A
[ Centralorderblockforcustomer Centralorderblockforcustomer <string > + Cxlgnore
-3 Expresstrainstation Expresstrainstation <string > +' CxIgnore
[ Trainstation Trainstation<string:> +' CxIgnore
-1 Characterfieldwithfieldlength7 Characterfieldwithfieldength7<string > + CxIgnore
[ R2tzble R2table<string> + Cxlgnore
[ Authorizationgroup Authorizationgroup <string + CxIgnare
[ Industrykey Industrykey <string:> + Cxlgnore
[ Characterfieldoflength 1 Characterfieldoflength 1<string > + Cxlgnore
[ Datacommunicationlineno Datacommunicationlineno<string + Cxlgnore
([ Centralbilingblockforcustomer Centralbilingblockforcustomer <string > + Cxlgnore
- Accountnumberofthemasterrecordwiththe Accountnumberofthemasterrecordwiththefiscaladdress. ..« Cxlgnore
-1 Accountnumberofanalternativepayer Accountnumberofanalternativepayer <string > + Cxlgnore
- Groupkey Groupkey <string > + CxIgnare
i Customeraccountgroup Customeraccountgroup<string > + 0001
[ Customerdassification Customerdassification<string > + Cxlgnore
[ Countrykey Countrykey <string ¥ US
[ Accountnumberofvendororcreditor Accountnumberofvendororcreditor <string > + Cxlgnore
[ Centraldeliveryblockforthecustomer Centraldeliveryblodkforthecustomer <string > + CxIgnare




N software

b. Create

Return parameters

MName

[ExjB: =
E

| Type

Value

----- 1 Expresstrainstation
----- [ Trainstation

---- {1 Autherizationgroup

""" [ Industrykey

""" [ Characterfieldoflength1

""" [ Datacommunicationlineno

""" [ Centralhilingblockforcustomer

""" 1 Groupkey

""" [ customeraccountgroup

""" [ Customerdassification

""" [ Countrykey

""" [ Accountnumberofrenderorcreditor

""" [ Accountnumberofanalternativepayer

""" [ Centraldeliveryblockfor thecustomer

SapYxrv5b01BG

verb<string >

SapYxrv5bo1

Function <string =

Customernumber 1<string =

Title <string>
Centralorderblockforcustomer <string >
Expresstrainstation<string =
Trainstation<string >
Characterfieldwithfieldlength7<string =
R2table <string>

Authorizationgroup <string =
Industrykey <string>
Characterfieldoflength1<string =
Datacommunicationlineno <string>
Centralbilingblockforcustomer <string >

""" [ Accountnumberafthemasterrecordwiththe Accountnumberofthemasterrecordwiththefiscaladdress, .,

Accountnumberofanalternativepayer <string >
Groupkey <string >
Customeraccountgroup <string =
Customerdassification <string >
Countrykey<string >
Accountnumberofvendororcreditor <string =
Centraldeliveryblockforthecustomer <string >
1|

L A A N S A S A R SR UL O IR Y

CxIgnore
0000000815
Mr
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
CxIgnore
0001
CxIgnore
us
CxIgnore
CxIgnore

c. Update — check the EIS.

0. Check that the data in the EIS matches the above output -

Login to the SAP GUI using the credentials for the given SAP server

Execute /o/cwld/home_aep, Click Management tab, Click Cutrent Events button, enter Date of

Event, click Execute
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WebSphere Bl: Current Events

Event Table
3 Event 1D Stat Object Name Verb Key

A total of 15 events were selected from the event table.

] 113 P YXRV5ED1 Update [eleleleleleleleleg

[] 1014 P YXRV5BE1 Create popEEEEsEE———
[] 1015 P YXRV5EBE1 Update poREeeeetf——m——
[] 1016 R SAP4_CUSTOMERMASTER CREATE [OREEEEE32Z—0EB10101
1 1017 R SAP4_CUSTOMERMASTER CREATE [0O0E0000211

] 1018 R SAP4_CUSTOMERMASTERAA CREATE 00000E0032—0001010122
] 1018 R SAP4 CREATE 00pDOEOE32——0001010
[] 1028 P YXRV5B01 Create pogeoEesEs—————
[] 1021 P YXRV5BE1 Create poREeeEst f——m——
[] 1022 P YXRV5BE1 Create peREEEEs I
1 1023 P YXRV5B01 Create 0oEEEEE8 12—
] 1024 P YXRVSBE1 Create pogoeEes T
] 1025 P YXRV5ED1 Create ooppooRg &
[ 1026 P YXRV5ED1 Create poppEEEs T
| 1027 P YXRV5BE1 Update [O0E0UE815

Clearing the sample content

If you have added a test record to the Customer Master table, clean up after this tutorial.
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Chapter 13. Tutorial 9: AEP Interface Inbound
processing

This tutorial demonstrates how the WebSphere Adapter for SAP 7.0.0.0 uses the AEP interface
polling mechanism to retrieve events from the event table with P or ) status in the SAP system.
These events will be processed by the adapter and sent to the configured end-points. After the
events are retrieved and processed, they will be archived in the SAP system.

This tutorial explains how you can configure the adapter for inbound processing; deploy; and test
the module for processing,.

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTAILL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALIL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <IWPS_INSTALIL>/lib ditectory.
When working with WebSphere Process Server on z/OS, add

${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath
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The sapjco3.jar is required to run the New External Service wizard.
<WPS_INSTALIL> represents the WebSphere Process Server installation directory.
Copy CWYAP_SAPAdapterExt.jar to the <IWPS_INSTALIL>/lib directory.

When working with WebSphere Application Server on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY_server_region_classpath.

<WPS_INSTAILIL> represents the WebSphere Process Server installation directory.

Configuring the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration

Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and click Next.
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&= Mew External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: | type filter text

Available Types:

=@ Adapters
o C1es

1 E-mail

Flat File

tte FTP

g 1Ms

EE iseries

JOE 1D Edwards
8] JoBC

E Lotus Domino
F@ COrade

& PeopleSoft

' Siebel

[*

[

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without special coding. During outhound processing, services running on WebSphere
Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the
SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS,

Einish Cancel

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

4= New External Service

Select an Adapter
Select the adapter you want to use,

=
{_J

LT

|

@p IBM WebSphere Adapter for SAP Software (IBM @ 7.0.0.0)
@p IBM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IBM WebSphere Adapter for SAP Software with transaction support

@ < Back ” ﬂexi% Finish

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the
current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3.

#= New External Service

Import a RAR File

Specity a Connector Project name in the Import a RAR File screen and click Next.

Import & resource adapter archive (RAR) from the file system to create a connector project for the @ l
adapter. r

Archive file: C:\WID7\ResourceAdapters\SAP_7.0.0.0VCWYAP_SAPAdapter_Tux.rar

= | CWYAP_SAPAdapter_Tx |

Connectar project:

Target runtime enviroment: |WEI:Sphere Process Server v7.0 w ‘

® e ]

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

# New External Service

Locate the Required Files and Libraries LTX
L4
Connector projects require system-spedific libraries and JAR files,
When deploying the application to a stand-alone server, these files must be configured on the server, Maore ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
sdministrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo'\sapjco-nintel-3.0. 3\sapico 3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.sa)i= | C:\SAPICo'sapico-nintel-3.0. 3\sapjco 3.4l | [Brnwse... ]

Cancel

@ < Back I Hit} |

5. Click Next.
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0. In the Select the Processing Direction screen, select the Inbound radio button and click

Next.

& Mew External Service

Select the Processing Direction

Select the direction of adapter processing at run time.,

Inbound processing passes data from the adapter to your service export.

) Dutbound

Outbound processing passes data from your service import to the adapter.

AN

() < Back “ Mext =

- EX

Cancel

Setting connection properties for the New External Service wizard

You must provide the following information in the Discovery Configuration screen:

User name
Password
Host name

System number
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SAP Client connection

Click Select to change the default Language code from English

Use the drop down option to change the default Code page from 1100.
Select Advanced Event Processing (AEP) as the SAP Interface name.

Click Next.

& New External Service

Specify the Discovery Properties —

Connection properties
SAP system connection information
Host name: = | cwd31.svl.ibm.com |
System number; | 01 |
Client: | 100 |
Language code: | EN (English) | [Select. . ]
Code page: | 1100 v|

The user name and password will not be encrypted and will be stored as plain text,

User name: * | srnandur |

PESSWcIrd: = | EEEEEREE |
SAP interface name: Ad'u'anced event processing (AEP) 3 |

[ ] Change the logging properties for the wizard

@ <gack || me> | Ene
W

Figure: Select AEP astheinterface
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Selecting the Business Objects and services to be used with the adapter

In the Find Objects in the Enterprise System screen, expand AEP node under

—+l
. . . . .
Discovered objects, sclect Discover IDoc From System, then click the #* button.

& New External Service

Find Objects in the Enterprise System ::L

Expand nodes to view and select discovered objects, Use filtering, if necessary, to limit J
number of ohjects displayed. ¥ |

Discovered objects: Selected objects:

= 0 agp

iy |Create or edit filter,
S8l Discover IDoc From System

Figure: Find Objects in the Enterprise System
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Enter Y* in the Filter Properties for Discover IDoc From System screen.

&= New External Service E]
Filter Properties for "Discover IDoc From System’ _}~
Spedfy the properties. -
Object attribute to use for discovery: |Disu:u:wer objects by name b |
Find objects with this pattern: *l“'| Y+ |
IDoc type to use for discovery: |Eiasi|: IDocs W |
Maximum number of objects to retrieve: | 25 W |
(7 [ QK l [ Cancel ]
M,

Figure: Filter Propertiesfor RFC

Click OK.

Expand the Discover IDoc From System node, select YXRV5BO01 and click the
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#+ Mew External Service

Find Objects in the Enterprise System

@ The default number of objects to retrieve is 25. To retrieve more objects, select the filter ::[-J
icon to change the default setting. o

Discovered objects: Selected objects:
|

= 43 aep
= é‘j‘ Discover IDoc From System (filtered)
(D) YSHP_IBDLY_CONFIRM_DECENTRALD1
@ vxrvsB01

Figure: Retrieved IDocs based on search criteria

In Specify the Configuration Parameters for YXRV5BO0Y’, click Deselect All button and then
select only KUNNR (Customer Number 1) field.

The Customer Number 1 is the Primary Key field. Enter the ABAP function module name as
Y_XR_CUSTOMERMASTER_CI.

Click OK.
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&= New External Service @

Specify the Configuration Properties for "YXRV5B0O1'

5

To retrieve inbound event data from SAP, the adapter invokes an ABAP function module written
spedifically for this purpose,

ABAP function module name:* | ¥_¥R_CUSTOMERMASTER_(C1

Attribute names of discovered objects can be generated from either SAP field names or from SAP field
descriptions, which are maore understandable.,

[ ]usze SAP field names to generate attribute names

Specify the appropriate release version. If the release version is not in the list, enter the value by
editing the list. By default, the release version is set to the SAP system release version.

IDoc release version: F0o W

The leaf nodes represent filds in the selected IDoc child segments. Select one ar more nodes to be
used as the primary key for the IDoc for updating or retrieving SAP data.

—+l

S

= [w] ¢ YXRVSEO1
=] < ZIXRVS0(SAP4_CustomerMaster / SAP4_CustomerPartmer)

[] < MSGFM{Function]) —
< KUNNR{Customer Mumber 1}
[] < ANRED(Tit)
[] < AUFSD{Central order black for customer)
[] % BAHME{Express train station)
[] % BAHNS({Train station)
[ 1% BBBNR{Character Field with Field Length 7)
[] < BBSNR(R/2 table)
[] % BEGRU{Authorization Group)
[] % BRSCH(Industry key)
[] < BUBKZ(Character field of length 1}
1< DATLTIData communication line no.) b

|

[ Select All ”Deselect .ﬁ.II]

(7 [ K H Cancel ]
s

Figure: Setting configuration parameters for the IDoc YXRV5BO01 selected

Click Next on the Find objects in the Enterprise System screen.

Generating Business Object definitions and related artifacts

In the Specify Composite Properties screen,
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a) Select the IDoc YXRV5BO01, click Add button under Service operations for selected IDoc
and select Create from the Add Value pop up.

b) Enter the relative folder for the generated Business Object as bodefs.

#= New External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

Configuration properties for wrapper objects
IDocs selected:

YXRV5B01

Remove

Service operations for selected IDoc: ™

Create Add. ..

Remove

Business object namespace: = | http: ffwwwe.ibm, com fxmins fprod fwebsphere fi2cafsap |

Spedfy the relative folder for the generated business object:
Folder: lul| bodefs| |

[ ]Enable dynamic authentication function

Einish Cancel

@ BT
by

Figure: Confignration properties for YXR15B01’

Click Next.

In the Service Generation and Deployment Configuration screen enter the
connection properties and deployment properties.
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& New External Service

Specify the Service Generation and Deployment Properties

Spedfy properties for generating the service and running it on the server,

Service Operations

To modify the names, or add a description to the operations to be generated in the interface file,

dick Edit Operations.

Deployment Properties
How do you want to specify the security credentials?
() Using an existing JAAS alias (recommended)

- B

g

|

o
Edit Operations...

{¥) Using security properties from the activation specification
The properties will be stored as plain text; no encryption is used.

User name: * | srnandur

Password: + | —

) Other

Deploy connector project: With module for use by single application

Spedfy the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection infarmation
[Juse load balancing

To use load balandng, spedify the load balancing properties in the Additional connection configuration panel

under the Advanced tab.

Host name: = | cwd31.5vl.ibm.com

Gateway host: | cwd31,svl.ibm.com

Gateway service: | sapgwil

Client: | 100

Language code: | EM (English)

| lSeIect. = ]

Code page: | 1100

vl

System number: | 01

The user name and password will not be encrypted and will be stored as plain text.

@ <Back |

1K

Cancel

Figure: Service Generation and Deployment Configuration
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Note: You can either enter an Authentication Alias previously created using the
Administrative Console of the WebSphere Process Server or simply enter the username and
password used to login in to the SAP system.

Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select Module radio button and
click Next.

4= New Business Integration Project

Select a Business Integration Project Type

Bk
Select the type of business integration project that you want to create., m

Ieg |Ise a module to integrate business applications and services, A
module can contain any type of component and can be deployed
- on WebSphere Process Server, Mare...

) Mediation module  Use a mediation module to integrate and connect services. A
mediation module can contain mediation flows and can be
A~ deployed on WebSphere ESE or WebSphere Process Server,

@

In the New Module screen, type AEPIN_YXRV5B01 in the Module Name field, and
then click Finish.



WebhSphere. Bl E (=

4= New Module

Create a Module

IUse a module to integrate business applications and services, A module can contain any type of T
component and can be deployed on WebSphere Process Server.,

Module name: | AEPTM_Y¥RV5BO1

LIse default location

Dpen module assembly diagram

@ e [EET) (o

Click Finish on the Specify the Location Properties screen.
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&= New External Service

Specify the Location Properties il
Specify location properties for where you want to save the service, h:lj

Properties for Service

Module: | AEPIN_YXRV5B01 v || New... |

Use the default namespace

Folder: | | [Browse. . ]

Mame: = | SAPInboundInterface |

[[]save business objects to a library

Description: |

@ Mext = [ Einiﬁ [ Cancel

Verify the results.
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=5} AEPIN_YXRVSB01

= 5 [
Err SAPINnboundInterface

@E Dependencies
E’ Integration Logic
= D Data Types

B = bodefs
= Sapxrvshol
(] SapYxrv5b01Z 2%rv51000
(2] Sap¥xrv5b01Z 2xrv52000
(] Sap¥xrv5b01Z 2xrv53000
(2] Sap¥xrv5b01Z Zxrv54000
(2] Sap¥xrv5b01Z Zxrv55000
(2] Sap¥xrv5b01Z 2xrv56000
(2] Sap¥xrv5b01Z Zerv57000
(] SapYxrv5b01Z 2xrv58000
(] SapYxrv5b01Z 2%rv59000
(2] Sap¥xrv5b01Z 2xrv5a000
(] Sap¥xrv5b01Z 2xrv5b000
(2] Sap¥xrv5b01Z 2xrv5c000

= 3 Interfaces
@ SAPInboundInterface
E Transformations

Figure: Artifacts created after the EMD run fore AEP Inbound Module

Generating Reference Bindings

In the Business Integration Perspective of WebSphere Integration Developer, expand the
AEPIN_YXRV5B01 SCA module, and double click the Assembly Diagram.

The Assembly Diagram screen appears with the module‘s Export component in view.
1. To create a new component, click the button of Java component from the Palette.

-] AEPIN_Y¥RV5BO1 - Assembly Diagram 7

R e Palette

[y @ =) 5, @)

(= Favorites @ ﬂp SAPInboundInterface
= Components

'-Té, Untyped Component

P.'j Human Task

'-T',Ji.’, Java

TE_L Mediation Flow

2 Process

B Rule Group
S State Machine

Figure: AEP Inbound interface in the Assembly editor
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2. Click and drag the Java component to add the new component to the Assembly Diagram
screen.

3. Add a Wire between the SAPInboundInterface and the Java component.

(D There is a new element that has been added -

@ ﬂp SAPInboundInterface

DE &

% '-_".El Componentl
L]

Figure: AEP Inbound interface being wired to a target Component(end-point)

4. In the Add Wite screen, click OK.

& Add Wire X

This action will allow the target service to be used in other modules. The
\t') service interface from the export will be added to the target. Do you want to
continue?

[] always create without prompt

| Ok | [ Cancel

Figure: Add Wire Confirmation Dialog

5. Right-click the new component and select Generate Implementation. This creates a Java
component that will act as an endpoint.



WebhSphere. Bl E (=

7 = Add... k
% ik Cc Change Type... r

L]
Generate Export. .. ¥

Generate Implementation k
Select Implementation

Synchronize Interfaces and References.., #
Refactor... »
Merge Components

of Cut
[ copy :
irver Loge | #1b Serv 8

StES | 59 pelete

Figure: Creating Java implementation for the target Component.

0. In the Generate Implementation screen, select the package in which the Java code will be
created and click OK. A Java file in an editor screen is presented.

Edit the Java file if you want to write code to print trace and log messages or Data Object.

Ensure that the package com.ibm.j2ca.base.AdapterBOUtil is imported.

. Hetth generated to support implementation of operation "emitCreateAfterImageSapY¥xrvsb0l" defined for WSDL port type
* named "SAPInboundInterface”.

* The presence of commonj.sdg.DataCObject as the return type and/or as a parameter
* type conveys that it is a complex type. Please refer to the WS5DL Definition for more information
* on the type of input, output and fault(s).

public void emitCreateAfterImageSap¥xrvobOl (
Datalbject emitCreateAfterimageSapY¥xrvob0lInput) {
try {
System.out.println{ndapterBOUtil.serializeDataiject(emitCreatenfterImageSaprrvaOlInputb];
} catch (Exception e)
ff TODO Auto-generated catch block
e.printStackTrace (),

Save the Java file and assembly diagram.

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.



WebhSphere. Bl E (=

Right click on your server node in the Server tab and add the module AEPIN_YXRV5B01 by
selecting Add and Remove Projects.

The project AEPIN_YXRV5B01App will be listed under Available projects.

& Add and Remove Projects [=

Add and Remove Projects
Modify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects: Configured projects:

] AEP RV SB0 1App
nfg AEPOUT _YXRVSED 1App s
(1 ALEIN_ALEREQD LApp s
(E1 ALEOUT_ALEREQO1APD

(E1 BAPI_ADDRESS_UPDATE_WORKUNITADD
(E1 BAPI_CUST_GETDETAIL_INApp

(51 BAPI_CUST_GETDETAILApP

(5 BAPI_GET_DETAIL_RESULTSETApp

IE QI55Kna 1AdrcSampleApp

00088 60-5e|

Add All =

If server is started, publish changes immediately

@ Next Finish ” Cancel

After adding the project, the added project should appear under the Configured projects. Add
the SCA module to the server by clicking on Finish.
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&= Add and Remove Projects

Add and Remove Projects
Modify the projects that are configured on the server

Mowve projects to the right to configure them on the server
Available projects: Configured projects:

- (F AEPOUT_Y¥RVSBO1App & (F APV VRVEO 00
& (B ALEIN_ALEREQO1App

- {F ALEOUT_ALEREQO1App

- () BAPL_ADDRESS_UPDATE_WORKUNITApp
- (B BAPL_CUST GETDETAIL_INApp

& (B BAPL_CUST GETDETAILApp

() BAPL_GET_DETAIL_RESULTSETApp

- l:ﬁ QI55Kna 1AdrcSampleApp

[ Add All »> |

l <+« Remaove All ]

If server is started, publish changes immediately

&

FiT? Cancel

After the module is successfully deployed, you should see the below message on the Console

[10/6/09 22:39:01:562 IST] 0000000c SAFRAODL I com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreWithiid rfc event request ->»»>>>»»> Polling for Events
[10/6/09 22:39:03:906 IST] 0000000c SAPRAODL I com.ibm.j2ca.sap.asp.inbound. SAPREPEventStoreNithid rfc event request -»>»»>3»»»» Polling for Events
[10/6/09 22:39:06:375 IST] 0000000c SAPRAOOL I com.ibm.j2ca.sap.asp. inbound. SAPAEPEventStoreNithiid rfc event request -»»»>>»»»» Polling for Events
[10/6/09 22:39:08:765 IST] 0000000c SAPRAOOL I com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreNithiid rfc event request ->»»>>>»»» Polling for Events
[10/6/09 22:39:11:187 IST] 0000000c SAFRAODL I com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreWithiid rfc event request ->»»>>>»»> Polling for Events
[10/6/09 22:39:13:640 IST] 0000000c SAFRAOOL I com.ibm.j2ca.sap.aep.inbound. SAPARPEvent3toreWithiid rfc event reguest -»»»»>»»y» Polling for Events
[10/6/09 22:39:18:171 IST] 0000000c SAPRAODL I com.ibm.j2ca.sap.asp.inbound. SAPREPEventStoreNithid rfc event request -»>»»>3»»»» Polling for Events
[10/6/09 22:39:21:453 IST] 0000000c SAPRAOOL I com.ibm.j2ca.sap.asp. inbound. SAPAEPEventStoreNithiid rfc event request -»»»>>»»»» Polling for Events
[10/6/09 22:39:23:796 IST] 0000000c SAPRAOOL I com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreNithiid rfc event request ->»»>>>»»» Polling for Events
[10/6/09 22:39:26:093 IST] 0000000c SAFRAODL I com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreWithiid rfc event request ->»»>>>»»> Polling for Events
[10/6/09 22:39:28:703 IST] 0000000c SAFRAOOL I com.ibm.j2ca.sap.aep.inbound. SAPARPEvent3toreWithiid rfc event reguest -»»»»>»»y» Polling for Events
[10/6/09 22:39:31:359 IST] 0000000c SAPRAODL I com.ibm.j2ca.sap.aep.inbound, SAPAEPEventStoreWithiid rfc event request -»>»»>>>>>» Polling for Events

Testing the assembled adapter application

Test the assembled adapter application by posting the events to Event Table. Adapter
continuously polls for the events in this table.

Logon to the SAP system.
Events can be posted to event table by using one of the options.

a) Execute tcode /o/cwld/home_aep, Management tab, Archived Events, click Execute,
select an event, change the Event Status to P, save it, click continue, select the event, click
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Resubmit button. Event will be posted to event table and gets processed by the adapter. This
option is for testing purposes only.

b) Execute tcode XDO01 and follow the below screen shots to create a customer record. After the
customer is created, an event will be queued in the event table.

_III:' Customer Create: Initial Screen

| Account group E |Sn|d-tn party E||
1 Customer | | |

Company code

Sales area
Sales Organization
Distribution Channel

Division

All sales areas...

. jj] ]

Customer's sales areas..

Reference

Customer

Company code

Sales organization

Distribution channel

Reference division

jj]]_

|v]l62]| 2] | %]

Click Continue.
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Custormner Extras Environment System  Help

& 240 IeEe SHE OO0 BE @M
Create Customer: General Data

Edit Goto

| General Data || Company Code Data || Sales Area Data || Additional Component |

Customer

INTERNAL

@ L F're'u'iewl @
Mame

Title Mr =]

Mame |Ste'u'en Smith |
| |

Search terms

Search term 1/2 EE | |

Street address

Street’House number |5DEJ Airport BLVD || |

Postal Code/City 110523 |Burlingame

Country

Region

05 |

Transporation zone

ca |

Elelepeletaneleley

FO box address
PO Box

[ ]

ii. Save the customer record. See in the WebSphere Integration Developer that this event is picked
up by the adapter and processed successtully.

CWYRP_SAPRdap com.ibm.j2ca. sap.aep.inbound. SAPAEPEventStoreWithXid
CWYLP_SLPLdap com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreWithXid
CWYLP_SLPLdap com.ibm.j2ca.=sap.aep.inbound. SAPAFEPEventStoreWithXid
CWYLP_SLPLdap com.ibm.j2ca.=sap.aep.inbound. SAPAFEPEventStoreWithXid
CWYAP_SRPRdap Got the Event ID: 0000000b000000001089
CWYAP_SRPAdap getRecordForEvent: 00000000000000001089

CWYRP_SAPAdap
CWYRP_SRPRdap
SystemCut

CWYARP SAPAdap
CWYARP SAPRdap
CWYRP_SAPRdap
CWYRP_SLPLdap
CWYLF_SLPLdap

[ I i e B I I I S I S IS I

com.ibm.j2ca.sap.serlalizer. SAPREPChjectSerializer ric_event_return:

rfc_event_reguest ->3>3>33B>BR3>
rfc_event request ->>>>>>>>>
rfc_event request ->>>>>>>>>
rfc_event request ->>>>>>>>>

SAPAFRPRecord getNext Archiving the event with Success status

Processed emitCreat

.ibm.j2ca.sap.

.ibm.j2ca.
j2ca.
j2eca.

j2eca.

sap.
zap.
zap.
zap.

.ibm.
.ibm.
.ibm.

aep.
aep.
aep.
aep.
aep.

eAfterImageSap¥Yxrvib0lInput

inbound.SAPAEPEventStoreWich¥id
inbound.SAPAEPEventStoreWithXid
inbound.SAPAEPEventStoreWitchXid
inbound.SAPAEPEventStoreWichXid
inbound.SAPAEPEventStoreWichXid

rfc_event_reguest ->>>3>>>>>>
rfc_event_ reguest ->>>3>>3>>>>
rfc_event_reguest ->3>3>33B>BR3>
rfc_event_reguest ->>>3>3>3>>>>
rfc_event request ->>>>>>>>>

Polling
Polling
Polling
Polling

Executed the Functio

Polling
Polling
Polling
Polling
Polling
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iii. Execute tcode XD02 and follow the below screen shots to update a customer record. After the
customer is updated, an event will be queued in the event table.

v - eareR e T gy v T e

III?'Custnmer Change: Initial Screen A

Customer |F33Ei [ﬂjsteven Smith
Company code |

Sales area
Sales COrganization

Distribution Channel

Division

__jj]

| All sales areas.. | Customer's sales areas. .

4] ImT|E%]ES

W TIPr

iv. Click Continue
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Custorner Edit Goto

Extras Environment System Help

@

2 IH I CAQIEHEIDDL0IRE @I

Change Customer: General Data

| General Data H Company Code Data H Sales Area Data || Additional Component |

Customer

836 Steven Smith

Burlingame

@ 0 F'reviewl Iﬂ
Name

Title | Hr =]
Mame |Ste'u'en Smith |
| |
Search terms
Search term 1/2 |SS || |
Street address
StreetHouse number |BUU Touchton RD)| || |
Postal Code/City 119523 | Burlingame
Country Im USA Region California
Time zone PST

Transportation zone

f@oo0aaaa1|  Region East

PO box address

v. Save the customer record.

vi. See in the WebSphere Integration Developer that this event is picked up by the adapter and

processed successfully.

CWYAP SaPadap
CWYRP_SAPRhdap
CWYRP_SAPhdap
CWYLP_SLPLdap
CWYLP_SLPLdap
CWYRP_ SRPRdap
CWYRP SRPLdap
Systemlut

CWYAP_SAPhdap
CWYLP_SLPLdap
CWYLP_SLPLdap
CWYRP_ SRPRdap
CWYRP SRPLdap
CWYRP_SAPRhdap

HoH O H O H e

com.1bm.JZca.sap.aep.1nbound. SAPAKPEVentStoreWitnXid ric event request ->>»>>>>>>> Folling
com.ikbm.j2ca.sap.asp.inkbound,. SRPAEPEventStoreWichiid rfc_event reguest —»>>>»»>>»> Polling
com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreWithiid rfc event_regquest —»>»>»»>»>»> Polling
Got the Event ID: 00000000000000001081

getRecordForEvent: 00000000000000001091
com.ibm.j2ca.sap.serializer . SAPAEPChjectSerializer rfc event return:
SAPAEPRecord getMNext Archiving the event with Success status
Processed emitUpdateAfterImageSapYxrvSb0lInput
com.ibm.j2ca.sap.aep.inbound.SAPAFEPEventStoreWithXid rfc event_regquest —>>>>>>>>> Polling
com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreWithXid rfc event_regquest ->>>>>>>>> Polling
com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreWichiid rfc_event reguest —>>>>>>>>> Polling
com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreNith¥id rfc event reguest —>>>>>>>>> Polling
com.ibm.j2ca.sap.aep.inbound. SAPAEPEventStoreNich¥id rfc event reguest —>>>>>>>>> Polling
com.ikbm.j2ca.sap.asp.inkbound,. SRPAEPEventStoreWichiid rfc_event reguest —»>>>»»>>»> Polling

Executed the Functi
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Clearing the sample content

If you have added a test record to the Customer Master table, clean up after this tutorial.
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Chapter 14. Troubleshooting AEP

1. Symptom: A ServiceRuntimeException exception is thrown at runtime:

Caused by: com.ibm.websphere.sca.ServiceRuntimeException: Did not find method for native method
‘emitCreateAfterimageSapYXRV5B01'

... 20 more

javax.resource.ResourceException: Caught unexpected unchecked exception while delivering event to endpoint:
$Proxy6@354e354e

at com.ibm.j2ca.extension.eventmanagement.internal.EventSender.deliverEvent(EventSender.java:241)

at com.ibm.j2ca.extension.eventmanagement.internal.EventSender.doSendEvent(EventSender.java:276)

at com.ibm.j2ca.extension.eventmanagement.internal.EventSender.sendEvent(EventSender.java:191)

at com.ibm.j2ca.extension.eventmanagement.internal.EventListSender.sendEvents(EventListSender.java:129)
at com.ibm.j2ca.extension.eventmanagement.internal.EventListSender.run(EventListSender.java:99)

at com.ibm.ejs.j2c.work.WorkProxy.run(WorkProxy.java:419)

at com.ibm.ejs.j2c.work.AsyncWorkProxy.run(AsyncWorkProxy.java:136)

at com.ibm.ws.asynchbeans.J2EEContext.run(J2EEContext.java:761)

at com.ibm.ws.asynchbeans.ExecutionContextimpl.go(ExecutionContextimpl.java:85)

at com.ibm.ejs.j2c.work.AsyncWorkProxy.run(AsyncWorkProxy.java:90)

at com.ibm.ws.util. ThreadPool$Worker.run(ThreadPool.java:1469)

Cause: This is usually caused by wrong BO name or Componenet1Impl which is not generated
successfully.

Resolution:
Verify that the BO name is correct in the event table.

Verify that the componentl is added in the Assembly Diagram and java class Componenet]Impl
was generated.

Run Menu Project, Clean.., clean all projects.

Symptom: Error received attempting to connect to SAP System with EMD

Resolution:

Verify that the connection parameters have been entered correctly
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Chapter 15. Tutorial 10: Sending data from the
SAP system(inbound processing)
and processing it using the ALE-
passthrough interface with a
Generic 1Doc

Sending IDoc data From SAP — ALE Inbound Processing

This tutorial demonstrates how to use New External Service to create a Generic Object for all
IDocs, create an SCA module that uses the WebSphere Adapter (7.0) for SAP Software, deploy
the module to the test environment of WebSphere Integration Developer (7.0).

In this tutorial, we use two IDoc types to test the Generic IDoc type — ALEREQO1 and
MATMASO3.

Scenario

The scenario explains how ALE inbound processing can be used in real business integration case.
An integration developer wants to integrate a legacy system with a SAP ERP system.

Any changes in SAP system should be updated in the legacy system as well.

For example, a new customer record created in SAP should result in a new record legacy system.

The integration with the SAP system is handled by the WebSphere Adapter for SAP Software
whereas the legacy system integration is handled by a proprietary connector.

In this case, the Integration developer has to use the ALE passthrough interface of the adapter in
order to achieve the result.

The ALE passthrough interface can return the changes of SAP in the form of binary content
which helps to configure SAP integration independent of a particular business item like customer
or material, etc.
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71\

SAP user
WebSphere Adapter for SAP
'3 ] Mapping which The
= @ | canunderstand Q | interface
SAPInboundinterfaceexport ”| the IDocs in binary ”| which

content enrich the

content

v 9

Connector to
WPS legacy system

Legacy system

The user creates material information in SAP. The SAP user exit function triggers a matmas01
IDoc to the configured Receiving partner. In this case, the receiving partner is configured to SAP
adapter.

The tutorial only cover the part of the scenario marked in red colored rectangular in the above
picture.

1. The user creates Material information in the SAP system.

2. The user exit function in SAP triggers a Matmas01 IDoc to the adapter. The delivery is
transactional; SAP creates a transaction ID which is used for Assured-event once delivery.

3. The adapter receives a request from the SAP system in the form of an IDoc object. The adapter
converts the IDoc into a Generic Business Object. The Generic Business Object holds the IDoc
content in a binary format.
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4. The business process in WebSphere Process Server routes the Generic Business Object to
subsequent components. In this case, the component is the one which can understand the Idoc in
binary format for example, a WTX mapping.

5. Further in the business process you may want add more components which actual enrich the
data received from adapter. This involves connecting other EIS or having static information. The
enrichment component may or may not be useful depending on the legacy system requirements.

0. The enrichment component, delivers the enriched data to the legacy system.

The whole scenario is configured in asynchronous fashion. Any exception in the subsequent
components should intimate the adapter component in a synchronous fashion so that the IDoc
can be resubmitted from the SAP system.

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTALL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALIL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <WPS_INSTALL>/lib directory.
When working with WebSphere Process Setver on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.
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<WPS_INSTALL> represents the WebSphere Process Server installation directory.
Copy CWYAP_SAPAdapterExt.jar to the <WPS_INSTALL>/lib directory.
When working with WebSphere Application Server on z/OS, add

${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY _server_region_classpath

<WPS_INSTALL> represents the WebSphere Process Server
installation directoryConfiguring the adapter for inbound
processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&= New External Service

Select the Service Type or Registry
p
Select the type of service to create or registry to browse. 3
Filter: |type filter text | B
Available Types;
=@ Adapters ~
e C1es
B E-mail
Flat File
ftr FTP
e IMS
E iSeries
JOE 10 Edwards
[@] 1DBC
E Lotus Damino .
E'@ Crade
& PeopleSoft
‘a7 Siebel "
Description:
Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding, During outhound processing, services running on WebSphere
Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the
SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

T
i

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter and click Next.

d= New External Service

Select an Adapter -
\\I"'\-. ’
o
Select the adapter you want to use, el
L d
A
L1} =
sap IBM WebSphere Adapter for SAP Software (IBM : 7.0.0.0)
IBM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)
b
< 3
© x| ] e

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard eatlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the

current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3.

Specity a Connector Project name in the Import a RAR File and click Next.

#= Mew External Service

Import a RAR File !

_
Impart & resource adapter archive (RAR) from the file system to create a connectar @ I
project for the adapter. |
Archive file: C:\WID_new'\RekourceAdapters\SAP_7.0.0.0\CWYAP_SAPAdapter Tx.rar
Cormector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'|."'.|'EI:|S|:|herE Process Server w7.0 b |

() [ < Back ” Mext = ] Finish

Figure: Import a RAR file screen




WebhSphere. Bl E (=

4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

& New External Service IZHE@
Locate the Required Files and Libraries QL

Connector projects require system-specific libraries and JAR files. Specify the location
of these files. 1—‘

When deploying the application to a stand-alone server, these files must be configured on the server, Mare ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo\sapjco3-nintel-3.0. 2\sapjco3.jar | [Bruwse... ]

System library fille (sapjco3.dll or libsapjco3.so):= | C:'SAP1Co\sapjco3-nintel-3.0. 2 \sapjoo3.dll | |§Bruwse... |

o ey ]
Wy

Figure: Locate the required files and 1.ibraries screen

5. Click Next.

0. In the Select the Processing Direction, select Inbound radio button, then click Next.
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4= New External Service HE”E
Select the Processing Direction ?

Select the direction of adapter processing at run time., ;
(*) Inbound

Inbound processing passes data from the adapter to your service export.

) Dutbound

Quthound processing passes data from your service import to the adapter,

=

) o[ tets ]

Figure: Select the processing direction

Setting connection properties for the New External Service wizard

You must prove the following information in the Discovery Configuration screen:
e User name
e Password
e Host name
e System number
e SAP Client connection

e C(lick Select to change the default Language code from English
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e Use the drop down option to change the default Code page from 1100.

e Sclect ALE pass-through IDoc as the SAP Interface name.

Click Next.

4= New External Service

Specify the Discovery Properties —

Connection properties

SAP system connection information

Host name: = | owd31,5vl.ibm,com |
Systemnumber: | 01 |
Client: 100 |
language code: | EN (English) | [select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: = | srnandur |
Password: . | S—— |
SAP interface name: ‘ALE pass-through [Doc 3 |

[[] change the logging properties for the wizard

Finish Cancel

Figure: Select ALE pass-through IDoc as the interface

Selecting the Business Objects and services to be used with the adapter

Under Find Obijects in the Enterprise System, expand the ALE node, select Generic IDoc

and click the iz

A button to add to the selected objects.
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&= New External Service

Find Objects in the Enterprise System
of objects displayed.

Discovered objects:

= ) AE
O Gereric Do
é.'j_\' Discover IDoc From System
@'j' Discover IDoc From File

Ll

Expand nodes to view and select discovered objects. Use filtering, if necessary, to limit number ::LJ

Selected objects:

|.~5.|:I|:I selected discovered objects to selected ohject

Cancel

Figure: Object Discovery and Selection

In the Configuration Parameters screen, choose the default values and Click OK.
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4= New External Service @
specify the Configuration Properties for 'Generic IDoc’

gy ]

)

The adapter can process the inbound IDoc packet as one business object or send
each IDoc in the packet as an individual business object.

[ ]5end an IDoc packet as one business object

7 [ Of., l [ Cancel
by

Figure: Configuration properties for * Generic IDoc’

Generic IDoc has now been added to the list of Business Objects to be imported.
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#+ Mew External Service

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects, Use filtering, if necessary, to limit number ::LJ
of objects displayed. o

Discovered objects: Selected objects:

=] é;j" ;A—IZE ':Ij_\' Generic IDoc
(@) Generic IDoc
&.'j\' Discover IDoc From System
é@' Discover IDoc From File

@ e [ we ] o
a0

Figure: Selected Generic IDoc added to the Objects to be imported

Click Next

On the Service Generation and Deployment Configuration screen, enter the connection
information. Click Next.
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&= New External Service

Specify the Service Generation and Deployment Properties

Specify properties for generating the service and running it on the server.

Deployment Properties ~
How do you want to specify the security credentials?
(T Using an existing JAAS alias {recommended)

(3) Using security properties from the activation spedfication

The properties will be stored as plain text; no encryption is used.

User name: = | srnandur |
Password: = | PU——— |
() other

Deploy connector project: With module for use by single application R

Specify the settings used to connect to SAP Software at run time:

Connection Properties

SAP system connection information
[Juse load balancing
To use load balancing, specify the load balancdng properties in the Additional connection configuration panel under the Advanced tab.

Host name: = | cwd3L.svl.ibm.com |
RFEC program ID: = | JCOIRFCSERVER3 |
Gateway host: | cwd3t.sul.ibm. com |
Gatenay service: | sapanoi |
client: [ 100 |
Language code: | EN (Engish) | [select... |
Code page: | 1100 v|
System number: |01 |

The user name and password will not be encrypted and will be stored as plain text.

Event persistence configuration

Select this option to retain the events in-memory. This ensures a once-only delivery of the inbound events. If this option is not
selected, performance increases; but there is a risk of losing the events in transit if an unexpected shutdown occurs.

[JEnsure assured-once event delivery (may reduce performance L

schEma name: | |

-

Figure: Service Generation and Deployment Configuration
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Note: You can either enter the Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or enter the username and password used to login in to
the SAP system.

Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select Module radio button and click
Next.

4= New Business Integration Project

Select a Business Integration Project Type

L
Select the type of business integration project that you want to create, m

IJse @ module to integrate business applications and services, A
module can contain any type of component and can be deployed
an WebSphere Process Server, More, ..

) Mediation module Use & mediation module to integrate and connect services, A
mediation module can contain mediation flows and can be
A1 deployed on WebSphere ESE or WebSphere Process Server,

®

Cancel

In the New Module screen, type ALEIN_PASSTHROUGH in the Module Name
field, and then click Finish.
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4= New Module

Create a Module

IUse a module to integrate business applications and services, A module can contain any type of '
component and can be deployed on WebSphere Process Server.,

Module name: | ALEIN_PASSTHROUGH |

LIse default location

Dpen module assembly diagram

® S
v

Click Finish on the Specify the Location Properties screen.
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#= New External Service

Specify the Location Properties Al
Spedfy location properties for where you want to save the service. [DJ

Properties for Service

Module: |.-5.LEIN_F‘.-5.SSTHROUGH v| | Mew, ..

| |

|Use the default namespace
Falder: | | [Brnwse... ]
Mame: " | SAPInboundInterface |

[]save business ohjects to a library

Description: |

e | g ) (o

Verify the results.

o
= Egl Assembly Diagram
% SAPInboundInterface
@E Dependencies
ﬁ Integration Logic
= S Data Types
| SapGenericIDocObiject
= E:l Interfaces
@ SAPInboundInterface
.iE'/ Transformations

Figure: Artifacts created after the EMD run fore ALE pass-through Inbound Module
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Generating Reference Bindings

In the Business Integration Perspective of WebSphere Integration Developer, expand the
ALEIN_PASSTHROUGH SCA module, and double click the Assembly Diagram. The
Assembly Diagram screen appears with the module‘s Export component in view.

1. To create a new component, click the button of Java component from the Palette.

'T:'& ALEIN_PASSTHROUGH - Assembly Diagram &2

< 5% Palette

[:3 'E';" 'Ef,," B, iy

[== Favarites @ % SAPInboundInterface
[-=- Components

'-T',JiL, Untyped Component
45) Human Task

e i%va
TL?L diation Flow
2

E= Rule Group
= State Machine

Figure: ALE pass-through Inbound interface in the Assembly editor

Click and drag the Java component to add the new component to the Assembly Diagram screen.

Add a Wire between the SAPInboundlInterface and the Java component.
(@ There is a new element that has been added

@ ?\'l_HF SAPInboundInterface

@@ ﬂr

% '-_".JiL.l Componentl
L]
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Figure: ALE pass-through Inbound interface being wired to a target Component(end-point)

In the Add Wire screen, click OK.

4 Add Wire X

This action will allow the target service to be used in other modules. The
\'\'/ service interface from the export will be added to the target. Do you want to
continue?

[ ] always create without prompt

| ok [ Cancel

Figure: Add Wire Confirmation Dialog

Right-click the new component and select Generate Implementation. This creates a Java
component that will act as an endpoint.

I o Add... ¢
% ik Ce Change Type... 2

L]
Generate Export... »

Generate Implementation h
Select Implementation

Synchronize Interfaces and References.., #
Refactor... b
Merge Components

af Cut
=) Copy :
rver Logs ¥ih Serv i

Stalus | 99 pelete

Figure: Creating Java implementation for the target Component.

In the Generate Implementation screen, select the package in which the Java code will be
created and click OK. A Java file in an editor screen appears.

Edit the Java file if you may wish to write code to print trace and log messages or Data Object.

Ensure that the package com.ibm.j2ca.base.AdapterBOUtil is imported.
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f Rk
% Method generated to support implementation of operation "executeSapGenericIDocObject” defined for WSDL port type
* named "S5APInboundInterface”.

* The presence of commonj.sdo.DataCbject as the return type and/or as a parameter
* type conveys that it is a complex type. Please refer to the WSDL Definition for more information
* on the type of input, output and fault(s).
poblic wvoid executeSapGenericIDocCbhject |
DataCbject executeSapGenericIDocCbhbjectInput)
try {
System.out.println(AdapterBOUtil.serializeDatadbject (executeSapGenericIDocObjectInput)) ;
} catch (Exception e)

// TODO Auto—generated catch block
e.printStackTrace():
! I

Save the Java file

Save assembly diagram.

Deploying the module in the test environment
After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration

Developer’s Test Client.

Right click on your server node in the Server tab and add the module
ALEIN_PASSTHROUGHbDby selecting Add and Remove Projects.

The project ALEIN_PASSTHROUGHApp will be listed under Available projects.
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Add and Remove Projects
Modify the projects that are configured on the server
==

Maove projects to the right to configure them on the server
Available projects: Configured projects:

- AEPIN_YXRVSBO1App
(51 AEPOLT_Y¥RVSBO14pp
:{j ALEIN_ALEREQD1App Aq,f%}
S] ALEIN_PASSTHROUGHApD
-(§ ALEOUT_ALEREQD1App < Re
{51 BAPI_ADDRESS_UPDATE_WORKUNITApp
(51 BAPI_CUST_GETDETAIL_INApp
-8 BAPI_CUST_GETDETAILApp
- (81 BAPI_GET_DETAIL_RESULTSETApp
I=E| QISSkKna 1AdrcSampleApp

Add Al =

= R R = e R B = B e

If server is started, publish changes immediately

@ Bad et [ Finish ][ Cancel J

After adding the project, the added project should appear under the Configured projects. Add
the SCA module to the server by clicking on Finish.
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&= Add and Remove Projects

Add and Remove Projects =
Modify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects: Configured projects:

& (5 AEPIN_YXRVSBO1App (5 ALV PASSTHROUGHARD
& (5 AEPOUT_Y¥RVSBO1App

& (5 ALEIN_ALEREQO1App

G- {5 ALEOUT_ALEREQO1App

(5 BAPI_ADDRESS_UPDATE_WORKUNITApp
(5 BAPL_CUST_GETDETAIL_INApp

(B BAPL_CUST_GETDETAILApp

Gl (5 BAPL_GET_DETAIL_RESULTSETApp

@ l% QI55Kna1AdrcSampleApp ’

Add All >> |

l <« Remove All ]

If zerver is started, publish changes immediately

@ Back =t | FiniflsE [ Cancel

Testing the assembled adapter application
Launch the SAP GUI
Start the Transaction WE19.
Choose the radio button Existing IDoc.
Select an existing IDoc MATMASO1 that you want to send
Set appropriate values in IDoc.
Select Standard Outbound Processing button
Select Continue in the pop-up box
This creates an ALE inbound event for the ALE inbound application deployed eatlier.

The event should reach the Java end point, indicated by the output of MATMASO1 Business
Object on the console of WebSphere Integration Developer.
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Chapter 16. Tutorial 11: Sending data to SAP
(outbound processing) using the
Queued RFC(gRFC) BAPI Interface

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses this interface to make calls to the
SAP’s native interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector interface to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTALL>/bin directory
(If WebSphere Integration Developer is installed generally the WebSphere Process Server instance
is installed under <WID_INSTALL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy sapjco3.jat to the <WPS_INSTALL>/lib directory.

When working with WebSphere Process Server on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath.

The sapjco3.jar is required to run the New External Service wizard.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Copy CWYAP_SAPAdapterExt.jar to the <WPS_INSTALL>/lib directory.
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When working with WebSphere Application Setver on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY_server_region_classpath

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Configuring the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration

Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and click Next.
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& New External Service

Select the Service Type or Registry
p
Select the type of service to create or registry to browse. 3

Filter: |type filter text

¥

Available Types:

=@ Adapters
L CICS
E<1 E-mail
Flat File
tter FTP
I TS
EE iSeries
JOE 1D Edwards
@ 1oEC
B Lotus Domino
Eﬁé Oracle
& PeopleSoft

o Siebel

>

(£

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedal coding. During outhound processing, services running on WebSphere

Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the

SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

(7 < Back Finish Cancel

Figure: Select the Service Type or Registry screen

2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.
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& New External Service

Select an Adapter

Select the adapter you want to use. .

]|

4

@p IEM WebSphere Adapter for SAP Software (IEM : 7.0.0.0)

IEM WehSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction suppaort

(o [ oge ] e
hA]

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the

current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.

3. Specify the Connector Project name in the Import a RAR File screen and click
Next.
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4= New External Service EI@
!

Import a RAR File

Impart a resource adapter archive (RAR) from the file system to create a connector project for the @ I
adapter. A

Archive file; C:WIDT\ResourceAdapters\SAP_7.0.0.00CWYAP_SAPAdapter_Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |

Target runtime enviroment: |'n.fu'eI:|5|:-here Process Server w70 b |

® =

Figure: Import a RAR file screen

4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.
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# New External Service

Locate the Required Files and Libraries L’i‘x
i
Connector projects require system-spedific libraries and JAR files.
When deploving the application to a stand-alone server, these files must be configured on the server, Mare ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjco3.jar file: = | C:\SAPICo \sapico-nintel-3.0. 3\sapjco3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo \sapjco-nintel-3.0, 3sapjca 3. dil | [Brnwse... ]

® T e [

5. Click Next.

0. In Select the Processing Direction screen, select the Outbound radio button and click Next.
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#= New External Service |Z|E]

Select the Processing Direction

Select the direction of adapter processing at run time,

) Inbound

>

(*) Outbound

=

7 = Back ]MEH =

—
L

Inbound processing passes data from the adapter to yvour service expart.

Quthound processing passes data from your service import to the adapter.

Cancel

Setting connection properties for the External Service wizard

You must provide the following information in the Discovery Configuration screen:

User name

Password

Host name

System number

SAP Client connection

Click Select to change the default Language code from English
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Use the drop down option to change the default Code page from 1100.
Select BAPI as the SAP Interface name.

Click Next.

&+ New External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (Engish) || select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Password: = | B |
5aP interface name: | 1NN - |

] change the logging properties for the wizard

Cancel

@ <Back || Mext> |
h

Figure: Select BAPI astheinterface
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Selecting the Business Objects and services to be used with the adapter
In the Find objects in the Enterprise System screen, click the RFC node. Then click the

g

=+ button.

&= Mew External Service

Expand nodes to view and select discovered objects. Use filtering, if necessary, to

Find Objects in the Enterprise System ::L
limit number of objects displayed. "“J‘

Discovered objects: Selected objects:

) rrC
£3) BOR

Mext = Finish Cancel

Figure: Object Discovery and Selection
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Enter Z_ASYNCBAPI_1 (the name of the BAPI in SAP) in the Filter Properties for ‘RFC’

screen.

#+ Mew External Service

Filter Properties for 'RFC' _’~
Specify the properties. #_
COhject attribute to use for discovery: |Disu:u:wer objects by name w |
Find ohjects with this pattern: = | Z_ASYNCEAPI_1 |
Maximum number of objects to retrieve: | 25 w |
@ | 14 | [ Cancel ]

g7

Figure: Filter Propertiesfor RFC

Click OK.

Expand the RFC node.
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#= New External Service

Find Objects in the Enterprise System
@ The default number of objects to retrieve is 25. To retrieve mare objects, select the filter icon to ::LJ
change the default setting. o
Discovered objects: Selected objects:
a
=40 RFC (fitered)
[RULl7_ASYNCBAPI_1
29 BOR
|.-5.|:||:| selected discovered objects to selected objects,
=

Figure: Retrieved BAPIS based on search criteria

Select the Z_ASYNCBAPI_1 from the metadata tree.

Click the button.

A popup will appear containing the Configuration properties for the Z_ASYNCBAPI_1 object.

Check the Use SAP filed names to generate attributes names checkbox if you want the
Business Object attribute names to be generated using SAP field Names.

You can choose to create attributes in the Business Object for any optional parameter in the

BAPL

Click OK.
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&= New External Service

Specify the Configuration Properties for '7_ASYNCBAPL_1'

Attribute names of discovered objects can be generated from either SAP field names or from SAP field descriptions, which are
more understandable.

[Juse SAP field names to generate attribute names

The selected object has optional RFC import, export, or table parameters. If selected, the optional parameters will be
generated as child objects of the selected object.

!

5

= & Optional parameters
= <3 Optional import parameters
< CUSTOMERCOMPAMYDETAIL
< RETURN
2 CUSTOMERGEMERALDETAIL
2 CUSTOMERADDRESS
< (Optional table parameters

[ Select All “Deselect AII]

@ [ Of,__ H Cancel

]

Figure: Setting configuration parameters for the BAPI Z ASYNCBAPI_1
Click Next

Generating Business Object definitions and related artifacts

In the Specify Composite Properties screen, check the Generate BAPI Business Objects within a

wrapper checkbox.

Optionally, the Business Object folder name could be entered in which the Business Objects are

created. Enter bodefs as the folder name.

Choose Asynchronous Queued RFC for SAP Remote Function Call (RFC) type.
Enter Async_Bapi for the Business object for Service operations field

Associate a Service Operation to the RFC Function Z_ASYNCBAPI_1.

To do this, Click the Add button under Service Operations and select Create and select the
RFC Function for selection operation as Z_ASYNCBAPI_1.
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Choose the configured Queue name on the SAP Server for Select the queue name.
TESTQUEUE is chosen here.

&+ Mew External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

Select the checkbox option to generate BAPI business objects contained in @ wrapper. You are allowed to configure a
maximum number of four BAPI business objects. If you do not select this option, topevel business objects are
automatically generated for each BAPI selected and the adapter internally assigns the Execute operation to it. There is
no limit on the number of BAPI business objects that you can configure.

Generate BAPI business objects within a wrapper

Business object namespace: = | http: ffwweweibm. comfxmins fprodwebsphere fj2cafsap |

Specify the relative folder for the generated business object:
Folder: | bodefs |

[ |Enable dynamic authentication function

SAP Remote Function Call (RFC) type: |.-5.syn|:|'|r|:|nc:us Queued RFC w |

Map service operations to RFC functions

Business object name for service operations: = | Async_Bapi |

Service operations: *

Create Add. ..

Remove

RFC function for selected operation: |2_ASYNCBAPI_1 v |

Select the queus name: |TE5TQLIELIE w |

Cancel

@ [ < Back ] Mnﬁib |

Figure: Soecify Composite Properties

Click Next.

In the Service Generation and Deployment Configuration screen enter the connection
properties and deployment properties.
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d= New External Service

Specify the Service Generation and Deployment Properties

Spedfy properties for generating the service and running it on the server. C

Service Operations

gzgg?jig:e names, or add a description to the operations to be generated in the interface file, dick Edit Edit Operations. ..

Deployment Properties —
How do you want to spedfy the security credentials?
i Using an existing JAAS alias {recommended)

{3} Using security properties from the managed connection factory

The properties will be stored as plain text; no encryption is used,

User name: = | srnandur |

Password: = | [R—— |

() Other

The guality of service to join the transaction provides a higher degree of data integrity, espedally in the event of a failure. As the
adapter only supports local transactions, it must be the only one phase commit capable resource in the transaction. Mare ...

Join the transaction {recommended)

Deploy connector project: |Wiﬂ1 module for use by single application w

Specify the settings used to connect to SAP Software at run time:

Connection Properties —
SAP system connection information -
[Juse load balandng

To use load balandng, specdfy the load balandng properties in the Additional connection configuration panel under the
Advanced tab, F

Host name: = i owd31.sv].ibm.com [

System number: | 01 |

Client: [ 100 |

Language code: | EM (English) | [Select... l

Code page: | 1100 w |

| £

®

[ <Back || Neqt> |
Wy

Figure: Service Generation and Deployment Confignration

Note: You can either use the Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP.

Click Next.
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In the Specify the Location Properties screen, click the New button next to the Module field
to create a new module.

When the New Business Integration Project screen appears, select Module radio button and

click Next.

4= New Business Integration Project

Select a Business Integration Project Type

il
Select the type of business integration project that you want to create. m

IUse a madule to integrate business applications and services. A module
can contain any type of companent and can be deployed on WebSphere
Process Server. More...

") Mediation module Use a mediation module to integrate and connect services, A& mediation
module can contain mediation flows and can be deployed on WebSphere
1] ESE or WebSphere Process Server, Mare...

/A

®

Cancel

In the New Module screen, type BAPI_qRFC_OUT in the Module Name field, and then click

Finish.
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4= New Module

Create a Module -I_._I

IUse a module to integrate business applications and services, A module can contain any type of T
component and can be deployed on WebSphere Process Server.,

Module name: | BAPI_gRFC_ouT]| |

IIse default location

Dpen module assembly diagram

®

ish |
[ F[:ﬁ‘_[_s l [ Cance

Click Finish on the Specify the Location Properties screen.



WebhSphere. Bl E (=

# New External Service

Specify the Location Properties i
Specify location properties for where you want to save the service. h:lj

Properties for Service

Madule: | BAPI_gRFC_OUT v || New..

IUse the default namespace

Folder: | | [Eiruwse. . ]

Mame: = | SAPCuthoundInterface |

[ ]save business objects to a library

Description: |

Verify the results.
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= @'W
=] Assembly Diagram

E_n'? SAPCOuthoundInterface
ﬂ Dependencies
f Imtegration Logic
= ._,'n} Data Types
== bodefs
[:I SapAsync_BapiWrapper
| SapCustomeraddress
= SapCustomerbankdetail
| SapCustomercompanydetail
-l SapCustomergeneraldetail
If] SapReturn
= SapZAsyncbapil
= DuplicateRecordFault
= InvalidRequestFault
(2] MatchesExceededLimitFault
= MissingDataFault
] MultipleMatchingR.ecordsFault
If] PrimarykKeyPairType
(2] RecordMotFoundrault
(2] WBIFault
= .'_i,' Interfaces
@ SAPQutboundInterface
E Transformations

Figure: Artifacts created after the EMD run for the BAPI gRFC Maodule

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module BAPI_qRFC_OUT by
selecting Add and Remove Projects.

The project BAPI_qRFC_OUTApp will be listed under Available projects.
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&= Add and Remove Projects

Add and Remove Projects
Modify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects:

-8 AEPIN_YXRVSBO1App

(&1 AEPOUT_YXRVSBO1App

(5 ALEIN_ALEREQD1App

(5 ALEIN_PASSTHROUGHADD

{8 ALEOUT_ALEREQO 1App

{5y BAPI_ADDRESS_UPDATE_WORKUNITApp
{5y BAPI_CUST_GETDETAIL_INApp

(5 BAPI_CUST_GETDETAILApp

(5} BAPI_GET_DETAIL_RESULTSETApD

=] 5APL_cRFC_OUTARD

(8 QISSKnalAdrcSampleapp

R

If server is started, publish changes immediately

fdd =

Add All ==

Configured projects:

[ Firish J[ Cancel

3. After adding the project. The added project should appear under the Configured projects.
Add the SCA module to the server by clicking on Finish.

#= Add and Remove Projects

Add and Remove Projects

Maodify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects:

(B AEPIN_YXRVSBO1App

(5§ AEPOUT_YXRVSEO 1App

{8 ALEIN_ALEREQO1App

(B ALEIN_PASSTHROUGHADD

{5 ALEOUT_ALEREQO1App

(5 BAPI_ADDRESS_UPDATE_WORKUNITApp
(53 BAPI_CUST_GETDETAIL_INADp

(8 BAPI_CUST_GETDETAILApp

(B BAPI_GET_DETAIL_RESULTSETApp

IE QI55KnaladrcSampleApp

B OE R

If server is started, publish changes immediately

Add All ==

<< Remave Al

Configured projects:

® (5 BAPT gRFC OLTAsD

| Fiq:gh [ Cancel
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Testing the assembled adapter application
Test the assembled adapter application using the WebSphere Integration Developer test client.

Once the module is deployed to the Server, right click the module BAPI_qRFC_OUT from the
Projects view and select Test > Test Module from the pop-up menu.

Enter values as shown in the following figure.

CustomerNumber1 0000000001

» General Properties

+ Detailed Properties

Specify the component, interface, operation, and input parameter values for the Invoke event, then dick the Continue icon in the Events area to run the test.

More...
Configuration: | Default Madule Test w |
Module: |BaP1_grFC_oUT |
Component: | SAPOutboundInterface w |
Interface: | SAPOutboundInterface w |
Operation: | createSapAsync_BapiVWrapper - |

Initial request parameters:
(® value editor () XML editor

o [=| B

Value

| Mame

= %: createSapAsync_BapiWrapperInput Sa
II_- SAPTransactionID *
= %; SapZAsynchapil

= %: SapCustomeraddress
[ customerMumber 1
I Name1
II_: MName2
I Name3
II_: MName4
I ity
I District
11 PoBox
[ POBoxPostalCode
I PostalCode Po
i RegionStateProvinceCou Feg
i CountyCode
I cityCode
[ HouseNumberAndStreet
[ FirstTelephonehumber

>

0000000001

o[efefefe]efa|e]e]a]a]e]a]aiciale]« e

€

(3 To edit values, start typing or press F2,

Figure: Test Client Screen

3. Click the Continue button = .

When the Select Deployment screen appears, select the WebSphere Process Server to which you
added the project and click the Finish button.
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4. If security is enabled, type in the username and password in the popup User Login screen that
appears and click OK.

#= User Login - Default Module Test

Security is enabled on the selected runtime environment(s).
Sign in to continue the test,

ser ID:*
| Edmin |

Password: =

[ ]Use the authentication settings in the preference and never ask again

[ O, H Cancel ]
i

5. Check the output of the service in the test client

Value Editor | XML Source

EE= =
| Mame Type | Value
= % createSapAsync BapiWrapperQu,,.; Saph v
1 saPTransactionID = + 091ECC9705284ACCABEBOBFD
%: SapZasyncbapil LV

6. Check the data in the EIS to ensure it matches expected values

Clearing the sample content

Nothing is required to clean up after this tutorial.
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Chapter 17. Tutorial 12: Sending data from SAP
system (INBOUND processing)
using gRFC BAPI

Following sections explain inbound scenarios for the BAPI interface.

Configuration prerequisites
Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTALL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directoty.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <WPS_INSTALL>/lib directory.
When working with WebSphere Process Server on z/OS, add
${WAS_INSTALL_ROOT}/lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Copy CWYAP_SAPAdapterExt.jar to the <WPS_INSTALL>/lib directory.
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When working with WebSphere Application Setver on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY_server_region_classpath.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Configuring the adapter for inbound processing

Run the New External Service wizard to generate business objects, services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration.
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&= New External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: |type filter text

¥

Available Types;

=@ Adapters
o CIcs
£ E-mail
Flat File
fte FTP
I IMS
EE iSeries
JOE 1D Edwards
[@] JoBC
B Lotus Domino .
E'@ Orade
& PeopleSoft

' Siebel

[>

(£

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding. During outhound processing, services running on WebSphere

Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the

SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

T
w

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

&= Mew External Service

Select an Adapter
Select the adapter you want to use. ]

o

a

@p IEM Websphere Adapter for SAP Software (IEM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction support

7 [ < Back ” Mexfz l Finish
W

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the

current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3. Specify the Connector Project name in the Import a RAR File screen and click
Next.

# New External Service

Import a RAR File !

=
Import a resource adapter archive (RAR) from the file system to create a connector @ I
project for the adapter. |
Archive file: C:\WID_new'\RekourceAdapters\SAP_7.0.0.0VCWYAP_SAPAdapter Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'|."'.n'el:u5|:uhere Process Server v7.0 b |

@ [ <ok J|_ mext> Einist

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

#= New External Service |:||E|r>__<|
Locate the Required Files and Libraries :L

Connector projects require system-specific libraries and JAR files. Specify the location
of these files. I—‘

When deploying the application to a stand-alone server, these files must be configured on the server. Mare ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjood.jar file: = | C:\SAPICo \sapico3nintel-3.0, 2\sapjco3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo\sapjoo3-nintel-3.0, 2\sapjco3.dil | |§Brnwse... |

TN T
by

Figure: Locate the required files and 1.ibraries screen

5. Click Next.
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6. In the Select the Processing Direction screen, select Inbound radio button, then
click Next.

d= New External Service |:||E|[z|
Select the Processing Direction ?

Select the direction of adapter processing at run time. ;

Inbound processing passes data from the adapter to your service expaort.

() Outbound

Cuthound processing passes data from your service impart to the adapter.

=

':':’:' [ < Back ” Mext = l

Setting connection propertiesfor the External Servicewizard
You must provide the following information in the Discovery Configuration screen:
User name
Password
Host name
System number

SAP Client connection
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Click Select to change the default Language code from English
Use the drop down option to change the default Code page from 1100.
Select BAPI as the SAP Interface name.

Click Next.

& New External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (English) | | select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Passwﬂrd' = | s+ 55+ |

saP interface name: | (1T ARG |

[ ]change the logging properties for the wizard

Cancel

@ <gack || mext> |
53

Figure: Select BAPI asthe interface
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Selecting the Business Objects and services to be used with the adapter

=

Under Find Obijects in the Enterprise System, click RFC node. Then click the #" button.

&= New External Service

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects, Use filtering, if necessary, to ::I-.J
limit number of objects displayed. o

Discovered objects: Selected objects:

&) rrC
£3) BOR

Mext = Einish Cancel

Figure: Object Discovery and Selection
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Enter Z_ASYNCBAPI_1 (the name of the BAPI in SAP) in the Filter Properties for ‘RFC’ screen.

&= New External Service

Filter Properties for "RFC’ _’~
Specify the properties, q_
Object attribute to use for discovery: |Disc|:|ver objects by name W |
Find ohjects with this pattern: = | Z_ASYNCEAPI_1 |
Maximum number of objects to retrieve: | 25 w |
@ [ i | [ Cancel ]

g

Figure: Filter Propertiesfor RFC

Click OK.

Expand the RFC node.
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#= New External Service

Find Objects in the Enterprise System
@ The default number of objects to retrieve is 25. To retrieve mare objects, select the filter icon to ::LJ
change the default setting. o
Discovered objects: Selected objects:
a
=40 RFC (fitered)
[RULl7_ASYNCBAPI_1
29 BOR
|.-5.|:||:| selected discovered objects to selected objects,
=

Figure: Retrieved BAPIS based on search criteria

Select the Z_ASYNCBAPI_1 from the metadata tree.

Click the button.

A popup will appear containing the Configuration properties for the Z_ASYNCBAPI_1 object.

Check the Use SAP filed names to generate attributes names checkbox if you want the
Business Object attribute names to be generated using SAP field Names.

You can choose to create attributes in the Business Object for any optional parameter in the

BAPL

Click OK.
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&= New External Service

Specify the Configuration Properties for '7_ASYNCBAPL_1'

Attribute names of discovered objects can be generated from either SAP field names or from SAP field descriptions, which are
more understandable.

[Juse SAP field names to generate attribute names

The selected object has optional RFC import, export, or table parameters. If selected, the optional parameters will be
generated as child objects of the selected object.

!

5

= & Optional parameters
= <3 Optional import parameters
< CUSTOMERCOMPAMYDETAIL
< RETURN
2 CUSTOMERGEMERALDETAIL
2 CUSTOMERADDRESS
< (Optional table parameters

[ Select All “Deselect AII]

@ [ OE l Cancel ]

Figure: Setting configuration parameters for the BAPI Z ASYNCBAPI_1

Click Next.

Generating Business Object definitions and related artifacts

1. In the Specify Composite Properties screen, select Create as the operation, bodefs as the
folder name for the Business Objects generated and choose the RFC Function Call Type as
Asynchronous Transactional/Queued RFC.
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#= New External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

The inbound BAFT interface enables the adapter to act as an RFC server. This allows an RFC dient on the SAP
gystem to invoke an RFC-enabled function through the adapter to the endpoint. Assodate the RFC-enabled function
name below with an endpoint operation,

Operations: | Create W |

Business object namespace: = | http: ffwww . ibm. comxmins fprodfwebsphere fi2cafsap |
Specify the relative folder for the generated business object:

Falder: | bodefs |
[ ]Enable dynamic authentication function

SAP Remote Function Call (RFC) type: |Asynd1ru:unu:uus Transactional /(Queued RFC w |

Cancel

I:?:I < Back ] Mett = |

Figure: Specify Composite Properties

2. Click Next.

3. In the Service Generation and Deployment Configuration screen enter the connection
properties and deployment properties.
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&= New External Service

Service Generation and Deployment Configuration :
A o,
Specify properties for generating the service and running it on the server, :D -

>

Service Operations

To_mndify ﬂje names, or add a description to the operations to be generated in the interface file, dick Edit Operations...
Edit Operations.

Deployment Properties
How do you want to specify the security credentials?
() Using an existing JAAS alias (recommended)

(%) Using security properties from the activation spedfication

The security properties will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Password: s [semeeees |

) other

Deploy connector project: |Wiﬂ'| module for use by single application w |

Specify the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection information
[ Use load balancing

To use load balandng, specify the load balancing properties in the Additional connection configuration panel
under the Advanced tab.

Host name: = | cwd31.svl.ibm.com

RFC program ID:= | JCO3RFCSERVER3

Gateway service: | sapgwil

|
|
Gateway host: | cwd31.svl.ibm.com |
|
|

Client: | 100

Language code: | ENM (English) | [5elect... ]

Code page: | 1100 w |

System number: | 01 |

The user name and password will not be encrypted and will be stored as plain text.

i€

Cancel

@ [ <Back || mpt= |
W

Figure: Service Generation and Deployment Confignration
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Note: You can either enter Authentication Alias already previously using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP system.

4. Click Next.

5. In the Specity the Location Properties screen, click the New button next to the Module field to
create a2 new module.

6. When the New Business Integration Project screen appears, select the Module radio button
and click Next.

4= New Business Integration Project

Select a Business Integration Project Type

L
Select the type of business integration project that you want to create, m

IIse @ module to integrate business applications and services, A
module can contain any type of component and can be deployed
on WebSphere Process Server. More. ..

i) Mediation module  Use a mediation module to integrate and connect services. A
mediation module can contain mediation flows and can be
A~ deployed on WebSphere ESE or WebSphere Process Server,

7. In the New Module screen, type BAPI_qRFC_IN in the Module Name field, and
then click Finish.
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#= Mew Module

Create a Module J_._l

IUse a module to integrate business applications and services. A module can contain any type of T
component and can be deployed on WebSphere Process Server,

Module name: | BAPI_gRFC_IN |

Use default location

Open module assembly diagram

8. Click Finish on the Specity the Location Properties screen.
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#+ Mew External Service

Specify the Location Properties

4]}
Specify location properties for where you want to save the service. h:lj
Properties for Service
Module: |BAPI_qRFC_IN v || New...

IUse the default namespace

Folder: | | [Eiruwse. . ]

Mame: = | SAPInboundInterface |

[ ]save business objects to a library

Description: |

® T = e

Wy

9. Verify the results.
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EBEUEAPT qrRFC_IN
= E-'S] Assembly Diagram
?\'l_HF SAPInboundInterface
I-E,_,“'I Dependencies
f Integration Logic
= :1 Data Types
== bodefs
= SapCustomeraddress
= SapCustomerbankdetail
= SapCustomercompanydetail
= SapCustomergeneraldetail
I':] SapReturn
= SapZasynchapil
If] SapZasynchapi 1Wrapper
= .j, Interfaces
@ SAPInboundInterface
E Transformations

Figure: Artifacts created after the EMD run fore BAPI gRFC Inbound Module

Generating Reference Bindings

In the Business Integration Perspective of WebSphere Integration Developer, expand the
BAPI_qRFC_IN SCA module, and double click the Assembly Diagram. The Assembly Diagram
screen appears with the module‘s Export component in view.

1. To create a new component, click the button of Java component from the Palette.

=) BAPI_gRFC_IM - Assembly Diagram 52

{  =F Palette

NEEEN G

(= Favorites @ ?ﬁp SAPInboundInterface
(= Components

'-T'é, ntyped Component

P:j Human Task

'-T'é’, Java

TE_L Mediation Flow

52 Process

B Rule Group
S State Machine

Figure: BAPI gREC Inbound interface in the Assembly editor

Click and drag the Java component to add the new component to the Assembly Diagram screen.

Add a Wire between the SAPInboundlInterface and the Java component.
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(L) There is & new element that has been added -

@ ?\'|_np SAPInboundInterface

@@ ﬂr

% I}ﬂ Componentl
L]

Figure: BAPI Inbound interface being wired to a target Component(end-point)

In the Add Wite screen, click OK.

4 Add Wire E3
9 ) This action wil allow the target service to be used in other modules. The
\{f) service interface from the export will be added to the target. Do you want to
continue?
[ ] always create without prompt

Pook [ Cancel

Figure: Add Wire Screen

2. Right-click the new component and select Generate Implementation. This creates a
Java component that will act as an endpoint.
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7 =r Add... k
% ik Cc Change Type... L

[ ]
Generate Export. .. L

Select Implementation !

Synchronize Interfaces and References. ., *
Refactor... L
Merge Components

of Cut
[i=| Copy
rver Logs | 47k Sery 8

Stals | ¢ pelete

Figure: Creating Java implementation for the target Component.

i

In the Generate Implementation screen, select the package in which the Java code will be
created and click OK. A Java file in an editor screen appears.

Edit the Java file if you may wish to write code to print trace and log messages or Data Object.

Ensure that the package com.ibm.j2ca.base.AdapterBOUtil is imported.

* Method generated to support implementation of operation "emitCreatelAfterImageSapZhsynchapilWrapper” defined for WSDL port type
* named "SAPInboundInterface”.

* The presence of commonj.sdo.DataObject as the return type and/or as a parameter
* type conveys that it is a complex type. Please refer to the WSDL Definition for more information
* on the type of input, output and fault(s).
public void emitCreateAfterImageSapZisynchapilWrapper |
Datalbject emitCreateAfterImageSapZisynchapilWrapperInput)
try {
System.out.println (AdapterBOUtil.serializelatatbject (emitCreatekfterImageSapZhsynchbapilWrapperInput))
} catch (Exception e)
e.printStackTrace();

Save the Java file

Save assembly diagram.
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Deploying the module in the test environment
Test the assembled adapter application using the WebSphere Integration Developet’s Test Client.

Right click on the server and add the module BAPI_qRFC_IN by selecting Add and remove
projects in WebSphere Integration Developer. You will see the project BAPI_qRFC_INApp
listed under Available projects.

&= Add and Remove Projects £ @@

Add and Remove Projects
Modify the projects that are configured on the server

Mowe projects to the right to configure them on the server
Available projects: Configured projects:

":@ AEPIN_YXRVSE01App

: E1 AEPOUT_YXRVSBO 1400 e
5 ALEIN_ALEREQD1App

- {8 ALEIN_PASSTHROUGHAPD

(5 ALEOUT_ALEREQO1App e

(5 BAPI_ADDRESS_UPDATE_WORKUNITApp

(5 BAPI_CUST_GETDETAIL_INApp

(5 BAPI_CUST_GETDETAILApp

- (5 BAPI_GET_DETAIL_RESULTSETApp

RSl BAPL_qRFC_INADp [

- (5 BAPI_qRFC_OUTApp

- l% QIS5Kna 1AdrcSampleApp

B e

Add All ==

If server is started, publish changes immediately

@ Bad ext = Finish H Canicel

After adding the project, the added project should appear under the Configured projects. Add the
SCA module to the server by clicking on Finish.



WebhSphere. Bl E (=

4~ Add and Remove Projects

Add and Remove Projects =
Modify the projects that are configured on the server

Move projects to the nght to configure them on the server
Available projects: Configured projects;

-(F3 AEPIN_YXRVSBO1App H (5 B4PT gRFC_Manp
(B AEPOUT _YXRVSBO 1App -
(B ALEIN_ALEREQD1App
(B ALEIN_PASSTHROUGHApD
(5 ALEOUT_ALEREQO1App
(5 BAPI_ADDRESS_UPDATE_WORKUNITApp
(5 BAPI_CUST_GETDETAIL_INApp

(5 BAPI_CUST_GETDETAILApp

-(H1 BAPI_GET_DETAIL_RESULTSETApp :
(1 BAPI_gRFC_OUTApp L
'E QISSKna 1AdrcSampleApp

B e

(2]

Add Al >> |

2]

2]

’ << Remove All ]

If server is started, publish changes immediately

(:?:Z' Bad Next = Ein Cancel

Testing the assembled adapter application
Launch the SAP GUI.

Define the destination in the sending system to enable qRFC communication. Use transaction
SM59 to define the destination.

Register a RFC destination for gqRFC. Use transaction SMQS. In the first screen, you will see a list
of previously registered destinations. To register a new destination, choose REGISTRATION.



TGN software

qRFC Monitor (Qg

Scheduler)

(B &aE ]

Echeduler Information

Scheduler Status:

Last Update (Every 2 Hinutes)
Hamg of AS Growp (DEFAULT = A1)
Husber of Entries Displayed
Host 10 :

IRACTINE

09-15-2005 (217 40
DEFALLT

16

saperplh_OWL_8a

w Rogister wihout ackvation || Deregistration || TREC Monitor || GRFC Monfor |

Joeosstinatien ] mhm[m nax mtiss|states [mctcombste |

[ 108 | CWLOSERVER R L1 tH\ETI'-'EI | saperpls_ovl_Bd
] 108 | HENRYSERVER R 1 [ INACTIVE] & saperpd5_OYL_Ba
[J1e8|1sL sAP TEST R 1 (10 INACTIVE| @ saperpds_DYL_pe
[} 108 | HATUSERVER R X 1 {11 INACTIVE] @ saperpas_OYL_0a
O 108 | wavEeM R 1 1] INACTIVE] @ saperpes_OvL_gg
(m IW'RFLI-I' ] 1 6e IRACTIVE [:] saperpes L 68
O malnﬂ:.u: R 1 [ INACTIVE| @ saparpl5_ErrL_pa
O 100 | ReCsERvER R 1 [ INACTIVE] @ saperpds_DYL_0o
[ 100 | SANSERVER R 1 {1 IKACTIVE] © saperpds_DL_id
[} 106 | SARATHRFCSERVER R 1 [ INACTIVE] @ saperpd5_OvL_pe
[ 196 | santaseaveR R 1 [ INAETIVE] & |saperpoB_tvi_od
[} 108 | SAmMAcERVERT R 18 [ INACTIVE] & saperpss_OYL_Be
[} 190 | WELSERVER R 1 {11 INACTIVE] @ saperpds_OfL_p&

gRFC Monitor (QOUT Scheduler)

| Reaqistration || Reaqister without activation || Deregistration || TRFC Monitor || QRFC Monitar

Scheduler Information

Scheduler Status: INACTIVE

Last Update (Every 2 Minutes) 11-20-2008 10:59:45

qu:E’Destination Registration

L

HO Destination |MYRFCDESTINﬁTION|
| MAXCONN 1
1| g e 60 | Runtine|status |Act Con
— | NO_TRFC
1 = |_| ilg] INACTIVE ]
1 ilg] INACTIVE ]
1 T ™ ilg] INACTIVE ]
[ |100 | MATUSERVER R X ilg] INACTIVE ]

Enter the value for the RFC destination, MYRFCDESTINATION in the example.

Register a queue name. Invoke transaction SMQR. In the first screen, you will see a list of

registered queue names.
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gRFC Monitor (QIN Scheduler)

Reaqistration || Reaqister without activation || Deregistration || gRFC Monitor

Scheduler Information

Scheduler Status : Inactv.

Last Update (Every 2 Minutes) 09-19-2008 00:21:40

Name of AS Group (DEFAULT = Al11): DEFAULT

Number of Entries Displayed 5

Host ID : saperpdd_DYL_BO

Number of Active Connections ]

C1.|Queue name Type |Mode|Max. Runtime|Attempts|Pause|Destination with LOGON Data
{100 |ABC R D ilg] pEEe 300
| 108 |ALEERTQUEUE R D 6B 2] e]ele] 300
| 108 | SARATHOUEUE R D ilg] pEEae 300

Click Registration to add the new queue name.

gRFC Monitor (QIN Scheduler)

| Reaqistration || Reaqister without activation || Deregistration || gRFC Monitor

Scheduler Information
Scheduler Status : Inactv.
Last Update (Every 2 Minutes) 11-19-2008 05:02:21
Nfll:l:’ Clueue Registration
L
Ho Queue Name [TESTQUEUE
N9 Exemope D
— MAXTIME g0 -
Y UsErRDEST Destination witl
mg NRETRY
—1 TDELAY 300
1
1
!
|:1-|;||:>m-mﬂuutut | R | 2] | 3]s} | (31615} | 300 |

At this point, your queue is setup and ready for use.
Invoke transaction SE37.

You need to have a new BAPI that initializes the queue and invokes the original BAPI and sends
the result to the queue. So in EMD, you discover Z_ASYNCBAPI_1 but execute
Z_QRFCBAPI_INBOUNDI1 from SE37 to send to the queue.
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Function Builder: Display Z2_QRFCBAPI_INBOUND1
0 7 | 3 e ) e P =5 D 1 0 s - T

Function module |Z_ORFCBAPI_INBOUND1 | Active
Attibutes  Import | Expot , Changing , Tables , Exceptions (TN TTT o

Ll elm] (2] [alce] [ ]

FUNCTION Z_ORFCBAPI_INBOUNDT.

P

*"*"Local Interface:
" IMPORTING

= VALUE (CUSTOMERND) TYPE BAPICUSTOMER_ID-CUSTOMER
= VALUE (RFCDEST) TYPE RFCDES-RFCDEST
= VALUE (QUEUENAME) TYPE TRFCOQOUT-QNAME

DATA: BAPI_CUSTOMERADDRESS LIKE BAPICUSTOMER_O4,
BAPI_CUSTOMERGENERALDETAIL LIKE BAPICUSTOMER_KNAT,
BAPI_CUSTOMERCOMPANYDETAIL LIKE BAPICUSTOMER_BS,
BAPI_RETURN LIKE BAPIRETT,
BAPI_CUSTOMERBANKDETAIL LIKE BAPICUSTOMER_0Z OCCURS @ WITH HEADER LIME.

CALL FUNCTION ‘TRFC_QUEUE_INITIALIZE®

CALL FUNCTION 'BAPI_CUSTOMER_GETDETAILZ'

EXPORTING

CUSTOMERND = CUSTOMERNO
*  COMPANYCODE =

IMPORTING
CUSTOMERADDRESS = BAPI_CUSTOMERADDRESS
CUSTOMERGENERALDETAIL = BAPI_CUSTOMERGENERALDETAIL
CUSTOMERCOMPANYDETAIL = BAPI_CUSTOMERCOMPANYDETAIL
RETURN = BAPI_RETURN

TABLES
CUSTOMERBANKDETAIL = BAPI_CUSTOMERBANKDETAIL.

* Making ORFC BAPI call.
CALL FUNCTION 'TRFC_SET_QOUEUE_MAME®
EXPORTING
ONAME = QUEUENAME .

CALL FUNCTION 'Z_ASYNCBAPI_1'
in background task
destination RFCDEST

EXPORTING
CUSTOMERADDRESS = BAPI_CUSTOMERADDRESS
CUSTOMERGENERALDETAIL = BAPI_CUSTOMERGEMERALDETAIL
CUSTOMERCOMPANYDETAIL = BAPI_CUSTOMERCOMPANYDETAIL
RETURN = BAPI_RETURN

TABLES
CUSTOMERBANKDETAIL = BAPI_CUSTOMERBANKDETAIL.
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Now, press F8 to execute this BAPI
Test Function Module: Initial Screen

Test for function group ZSANTEST

Function module Z_0RFCBAPI_IMNBOUND1
Uppercase/Lowercase

RFC target sys: SARMASERVER

CUSTOMERND 0AEAEE00H1T
RFCDEST SARMASERVER
| QUEUENANE SARMAQUEUE]]

Here, you need to enter the queue name and the RFC destination

Invoke the Outbound queue monitor using transaction SMQ1

=
Program Edit Goto System Help

B anoan BE @ e

qRFC Monitor (Outbound Queue)

Client 108

Clueue Name E |
Queue Destination |*

Waiting Queues Cnly |_|

) ) 5
To view the specified queue, choose Execute

Double Click the queue name to see the LUWs.

100 | AR 2_ASYNCRAPI 1 G0-24-2008 |04:30:31 |J00.Server eeuld set find server Emetion MDY COTAFTSEQT TR4G0A
100 | AN Z_ASYNCBAPI_1 09-24-2008 |04:39:38 |Transaction recorded CFNAFTSEQSI0AE04
189 | AN .-"‘""""*.",‘w L £9-28-2008 |04:40.15 |Transaction recorded L
] ]

e il jm Display LUW 2 SARNASERVER £0-28-2008 |64:40.20 |Transaction recorded BEIAFTSED TBAS0C

Back F1

Pagsible Entrios. F4

Dedug LUW 8

Retresh L]
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Double click on Execute LUW(F6) to execute logical unit of work
The SAP system will send the LUW to the destination once it is alive.

In the console of WebSphere Integration Developer, you could see the BAPI Business Object
printed (as we entered a print statement in the Component implementation above).

Clearing the sample content

Nothing is required to clean up after this tutorial.
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Chapter 18. Tutorial 13: Generating ALE Audit
IDocs per packet (Inbound
processing ALE Interface)

Following sections explain inbound scenarios for the ALE interface where the ALE Audit are
generated per packet rather than per IDOC.

Configuration prerequisites
Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTALL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALIL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Server v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <WPS_INSTALL>/lib directory.
When working with WebSphete Process Server on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY_server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.



WebhSphere. Bl E (=

Copy CWYAP_SAPAdapterExt.jar to the <WPS_INSTALL>/lib directory.

When working with WebSphere Application Setver on z/OS, add
${WAS_INSTALL_ROOT} /lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY _server_region_classpath.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Configuring the adapter for inbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&= New External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: |type filter text

¥

Available Types;

=@ Adapters
o CIcs
£ E-mail
Flat File
fte FTP
I IMS
EE iSeries
JOE 1D Edwards
[@] JoBC
B Lotus Domino .
E'@ Orade
& PeopleSoft

' Siebel

[>

(£

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding. During outhound processing, services running on WebSphere

Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the

SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

T
w

Figure: Select the Service Type or Registry screen
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1.

Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

# Mew External Service

Select an Adapter
Select the adapter you want to use. "5

]|

el

@p IEM WebsSphere Adapter for SAP Software (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction support

() [ < Back ” Mex]z l Finish
W

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the
current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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2. Specity a Connector Project name in the Import a RAR File screen and proceed by
clicking on Next.

# New External Service

Import a RAR File !

=
Import a resource adapter archive (RAR) from the file system to create a connector @ I
project for the adapter. |
Archive file: C:\WID_new'\RekourceAdapters\SAP_7.0.0.0VCWYAP_SAPAdapter Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'|."'.n'el:u5|:uhere Process Server v7.0 b |

@ [ <ok J|_ mext> Einist

Figure: Import a RAR file screen
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3. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

#= New External Service |:||E|r>__<|
Locate the Required Files and Libraries :L

Connector projects require system-specific libraries and JAR files. Specify the location
of these files. I—‘

When deploying the application to a stand-alone server, these files must be configured on the server. Mare ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjood.jar file: = | C:\SAPICo \sapico3nintel-3.0, 2\sapjco3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo\sapjoo3-nintel-3.0, 2\sapjco3.dil | |§Brnwse... |

TN T
by

Figure: Locate the required files and 1.ibraries screen

4. Click Next.
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5. In the Select the Processing Direction screen, select Inbound radio button, then
click Next.

d= New External Service |:||E|[z|
Select the Processing Direction ?

Select the direction of adapter processing at run time. ;

Inbound processing passes data from the adapter to your service expaort.

() Outbound

Cuthound processing passes data from your service impart to the adapter.

=

':':’:' [ < Back ” Mext = l

Setting connection propertiesfor the New External Service wizard
You must provide the following information in the Discovery Configuration screen:
User name
Password
Host name
System number

SAP Client connection
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Click Select to change the default Language code from English
Use the drop down option to change the default Code page from 1100.
Select ALE as the SAP Interface name.

Click Next.

& Mew External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31,svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (English) || select... |
Code page: | 1100 v|

The user name and password will not be encrypted and will be stored as plain text,

User name: * | srnandur |

Passmord: [ |

4P interfece name: | |

[ ]change the logging properties for the wizard

Cancel

|\'£'z| < Eack ” Mext = ]

Figure: Select ALE asthe interface
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Selecting the Business Objects and services to be used with the adapter

Under Find Objects in the Enterprise System, expand the ALE node, click Discover IDoc From
System.

# Mew External Service

Find Objects in the Enterprise System
Expand nodes to view and select discovered objects. Use filtering, if necessary, to limit number of ::LJ
objects displayed. o
Discovered objects: Selected objects:
7@
= & AE

@'._3\' Discover IDoc From System

é.'_j_\' Discover IDoc From File

Figure: Object Discovery and Selection

g

Click the #™ button.

Enter Alereq01 (the name of the ALE in SAP system) in the Filter Properties for ‘Discover
IDoc From System’ screen.
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Click OK.

# New External Service [E

Filter Properties for 'Discover IDoc From System’ _’-
Specify the properties, =
-

Ohject attribute to use for discovery: Disccw‘er objects b

Find objects with this pattern: = | orders05® |
IDoc type to use for discovery: |Eiasiu: IDocs W |
Maximum number of objects to retrieve; |25 b |
'.rf.' [ K J [ Cancel

Figure: Filter Properties for ‘Discover IDoc from Systens

Expand Discover IDoc From System node.

Select ORDERSO05 and click the £

button.
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4= New External Service |:|E”Z|

Find Objects in the Enterprise System

@ The default number of ohjects to retrieve is 25, To retrieve more objects, select ::l_J
the filter icon to change the default setting. o

Discovered objects: Selected objects:
= EEE

B &) ALE
= t;@' Discover IDoc From System (filtered)

RJowoeso: |

- c?ﬁ' Ciscover IDoc From File

(7

Figure: Discovered ORDERSO5 IDoc

In the Configuration Parameters screen, choose the default values and click OK.
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d= New External Sigvice
Configuration Properties for 'ORDERS05' v
ey

Specfy configuration properties for the selected object. o |-
L i

Attribute names of discovered objects can be generated from either SAP field names or from SAP field
descriptions, which are maore understandable.

[ Ju=e SAP field names to generate attribute names!

The adapter can process the inbound IDoc packet as one business object or send each IDoc in the packet
as an individual business object.

[ ]send an IDoc packet as one business object

The adapter can directly exchange IDocs with components that have IDoc parsing capabilities.
[ ]send IDoc with unparsed data record

The IDoc type selected has unreleased segments. To use unreleased segments, it is recommended that
you set the release version to Unreleased. For more information on IDocs, see the SAP transaction code
webl,

|
IDoc release version:= | Unreleased i !

(7 Ok l [ Cancel

Figure: Setting configuration parameters for the ALE selected

ORDERSO05 has now been added to the list of Business Objects to be imported.
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e ———
d= New External Service |-_||E||z|
Find Objects in the Enterprise System

Expand nodes to view and select discovered objects, Use filtering, if necessary, to ::I-\_._,_J

limit number of objects displayed. o
Discovered objects: Selected objects:

= & Ak (0 ORDERSDS

= ,Zﬂ | Discover IDoc From System (filtered)
(@) ORDERS0S
&+-£9) Discover IDoc From File

@ <Back || Mext> | Eni

Figure: Selected ALE added to the Objects to be imported

Click Next.

Generating Business Object definitions and related artifacts
1. In the Specify Composite Properties screen, select the Service operation as Create.

2. Add MessageType=ALEREQ); MessageCode=; MessageFunction=; as IDoc Identifiers for the
service operation by clicking on Add button.

3. Enter bodefs as the name of the relative folder for the generated Business Object.
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#* Mew External Service

Specify Composite Properties

IDocs selected

-+

5

-~ < ORDERS0S

Specify properties that apply to all selected objects.

Configure IDoc inbound service operations -

- BX

Properties:

For the IDoc selected, select existing service operations or type and
enter new ones in the field below

Service operation:= | Create L

Ensure IDocs corresponding to selected identifiers have been
configured for outhound processing from SAP, for the receiving
partners assocated with RFC Program ID

IDoc Identifiers for the service operation: *

MessageType=0RDERS; MessageCode=; Me

Remove

£ |

[

Business object namespace:= | http:/fwewewe.ibm. comfxmins/prod websphere fi2ca/sap |

Specify the relative folder for the aenerated business ohject:

Folder: |

[ 1Enable dynamic authentication function

® Bk _textz ] oo
Figur : Specify Composite properties
4. Click Next

5. In the Service Generation and Deployment Configuration screen enter the connection
properties and deployment properties.
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d= New External Service

Specify the Service Generation and Deployment Properties :
Specify properties for generating the service and running it on the server, ‘L.b:);
Deployment Properties — ”
How do you want to specify the security credentials?
(") Using an existing JAAS alias (recommended)
& dawva At I fo¥'s} lia
() Using security properties from the activation spedfication
The properties will be stored as plain text; no encryption is used.
User name: = | srnandur |
Password: * | e |
() Other
Deploy connector project: With module for use by single application ~
Specify the settings used to connect to SAP Software at run time:
Connection Properties
SAP system connection information -
[ use load balancing
To use load balancing, specify the load balancng properties in the Additional connection configuration panel under the Advanced tab.,
Host name: = | owd31.svl.ibm.com |
RFC program ID: = | JCO3RFCSERVERS |
Gateway host: | owd31.svl.ibm.com |
Gateway service: ! sapgwill |
Client: | 100 |
Language code: | EM (English) | lSeIect. 7 J
Code page: | 1100 v|
System number: | 01 |
The user name and password will not be encrypted and will be stored az plain text.
Event persistence configuration
Select this option to retain the events in-memory. This ensures a once-only delivery of the inbound events, If this option is not
selected, performance increases; but there is a risk of losing the events in transit if an unexpected shutdown occurs.
[CEnsure assured-once event delivery (may reduce performance): 1
-
@ (o ] o

Figure: Service Generation and Deployment Configuration
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NOTE: You can either enter Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to

login in to the SAP system. Also enter the REFCProgramID (as shown in figure). This must have
been already configured in the SAP system.

6. Click Advanced button, click ALE event status configuration and check the
options ALE update status and Send ALEAUD per packet.

+ =

Additional connection configuration

ALE event status cuﬁﬁguraﬁun

Properties to configure packet error handling and to enable updates of SAP system audit
records,

|:| Ignore IDoc packet errors
ALE update status
Send ALEAUD per packet

Selective update: | |

Status message code: | |

Success code: * ! 55 S |
Failure code: * |r51 » |
Success text: + i_.ﬂ._p_plil:aﬁnn document posted |
Failure text: + i_.ﬂ._p_plil:aﬁnn document not posted |

)

(o J s ][ o

7. Click Next.

8. In the Specify the Location Properties screen, click the New button next to the Module field
to create a new module.

9. When the New Business Integration Project screen appears, select Module radio button and
click Next.
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4= New Business Integration Project

Select a Business Integration Project Type

L
Select the type of business integration project that you want to create, m

@Mnduleg IJse @ module to integrate business applications and services, A
module can contain any type of component and can be deployed
— 1] an WebSphere Process Server, More, ..
[

) Mediation module Use & mediation module to integrate and connect services, A
mediation module can contain mediation flows and can be
1~ deployed on WebSphere ESE or WebSphere Process Server,

7. In the New Module screen, type ALEIN_ALEAUDPERPACKET in the
Module Name field, and then click Finish.

4= New #ﬂdule

Create a Module

IUse & module to integrate business applications and services, & module can contain any '
type of component and can be deployed on WebSphere Process Server.,

Ise default location

1
i i mrkensrens : - F F ¥ T Broice

7 Finish H Cancel ]
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10. Click Finish on the screen.

# New External Mervice

Specify the Location Properties o
Specify location properties for where you want to save the service, h‘:L'

Properties for service

Module: | ALEIN_ALEAUDPERPACKET v | [New...|

Namespace:; | s rALEIN. ALERLFERFALRE] fasHinboundinierrace |

Use default namespace

Falder: | | [ Browse... ]

Mame: = | SAPInboundInterface |

[ ]5ave business objects to a library

Likirary: Mes

Description: |

@ Mext = [ Einish ][ Cancel ]

11. Verify the results.
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%jects

=521 ALEIN_ALEAUDPERPACKET

f E-@m

Lo Enr SAPInboundInterface

P ﬁ Dependencies

: E’ Integration Logic
=3 E Data Types

o | SaplDocControlRecord
= SapClrders0s
= SapOrders05DataRecord
--[2] SapOrders05E2addilonl
~[2J sapOrdersD5E2cublboon
2] sapOrders05E2cucfgoo3
“-[2] 5apOrders05E2cuins002
~[Z] sapOrders0SE2cuprton2
fd SapOrders05E 2curef
-[Z] SapOrders0SE2cuvalon2
) sapOrders05E2edc01
i-[2] SapOrders0SE2edc02
~[2J SapOrders05E2edcn3
2] sapOrders05E2edcn4
--[Z] 5apOrders05E2edcs
~~[2] SapOrders05E2edc0s000
[2] sapOrders0SE2edc07000
-[Z] sapOrders0SE2edc17
(2] sapOrders05E2edc18
i-[Z] SapOrders05E2edc19
-[& SapOrders05E2edcal
+[2] 5apOrders05E2edcti
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[C] 5apOrders05E2edkt2001
% (2] SapOrders05E2ed|37004
[2] SapOrders0SE2ed|3a
- [2] SapOrders05E2ed39000
2] SapOrders05E2ed|44004
-[2] SapCrdersDSE2edp01007
(2] 5apOrders05E2edp02001
[C] SapOrders05E2edp03
[Z] 5apOrders05E2edp04001
(=] SapOrders05E2edp05002
(2] SapOrders05E2edp17001
- [2] SapOrders05E2edp18001
2] 5apOrders05E2edp15002
-[2] SapCrdersDSE2edp20001
(2] 5apOrders05E2edp35000
[C] SapOrders05E2edpai0ns
| SapOrders05SE2edpa3
(] SapOrders05SE2edpadin
(2] SapOrders05E2edps5000
- [2] SapOrders05E2edpt1001
2] SapOrders05E2edpt2001
-[_] SapOrders05E2eds01
(2] 5apOrders05E2txth 1001
[C] SapOrders05E2txip1
[C] 5apOrders05DocE0
= -fj Interfaces
: @ SAPInboundInterface
iﬂ Transformations

Generating Reference Bindings

In the Business Integration Perspective of WebSphere Integration Developer, expand the
ALEIN_ALEAUDPERPACKET SCA module, and double click the Assembly Diagram. The
Assembly Diagram screen appears with the module‘s Export component in view.

1. To create a new component, click the button java component from the Palette.
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{25 AL[:%N_ALEAUDF‘EF‘.PACI{EI' - Assembly Diagram 53

¢ 5F Palette
NEEEN)
E!:- Fa-'u:uriéés
. .[,Eb Components

EEI:_I: Untyped Component
. 45) Human Task

| @ ?'|_np SAPInboundInterface

: '-_E"g Java
: TE_I_. Mediation Flow

2. Click and drag the java component to add the new component to the Assembly Diagram screen.

3. Add a Wire between the SAPInboundInterface and the Java component.

% @ﬂﬁer@@.@fmm

@ ﬂp SAPInboundInterface %@ Companent1
L]

4. In the Add Wire screen, click OK.

# Add Wire X
This action will allow the target service to be used in other modules. The

¢ "
\t,) service interface from the export wil be added to the target. Do you want to
continue?

[ ] always create without prompt

| ok [ Cancel

Figure: Add Wire Confirmation Dialog

Right-click on the new component and select Generate Implementation. This creates a Java

component that will act as an endpoint.
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. = Add. .. 4
‘% ik Cc Change Type... r

- T
Generate Export... r

Select Implementation !

Synchronize Interfaces and References.., #
Refactor... »

Merge Components

of Cut

=| Copy

]

irver Loge | #1b Serv

Status

¥ Delete

Figure: Creating Java implementation for the target Component.

In the Generate Implementation screen, select the package in which the Java code will be
created and click OK. A Java file in an editor screen appears.

Edit the Java file if you may wish to write code to print trace and log messages or Data Object.

Ensure that the package com.ibm.j2ca.base.AdapterBOUtil is imported.

I # Method generated to support implementation of operation "emitCreateAfterImageSapOrders05"™ defined £
* named "S5APInboundInterface™.

* The presence of commonj.sdo.DataCbject as the return type and/or as a parameter
* type conveys that it is a complex type. Please refer to the WSDL Definition for more information
* on the type of input, output and fanlt(s).

= public void emitCreateAfterImageSapOrders05 |
DataCbject emitCreatebhfterImageSapOrders05Input) {
try {
System. out.println (AdapterBCUtil. serzalizeDatadbject (emitCreateAfterImageSapOrders0SInput) ) ;
} catch t (=5 B
J/ TODO Ruto-generated catch block
e.printStackTrace ()} ;

// To get or set attributes for DataObject emitCreateAfterImageSapOrders0SInput, use the APIs as 3
ff To set a string attrib

ute in emitCreateAfterImageSapOrders05Input, use emitCreatelAfterImageSapO

// To get a string attribute in emitCreateAfterImageSapOrders05I1
ff To set a dataObject attribute in emitCreatedfterImageSapOrder
a

/i To get

1t, use emitCreateAfterImageSapd
Input, use emitCreateAfterImage
dataCbject attribute in emitCreatelAfterImageSapOrdersdSInput, use emitCreateAfterImage

Save the Java file

Save assembly diagram.
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Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module
ALEIN_ALEAUDPERPACKET by selecting Add and Remove Projects.

The project ALEIN_ALEAUDPERPACKETApp will be listed under Available projects.

&= Add and Remove Projects |L|
Add and Remove Projects —
Maodify the projects that are configured on the server —
=3
Maove projects to the right to configure them on the server
Available projects: Configured projects:
[FR=] ALEIN_ALEAUDPERPACKETApp k
| Add >
| Add All >
If server is started, publish changes immediately
3] Bac Mext [ Einish l [ Cancel ]

After adding the project, the added project should appear under the Configured projects. Add the
SCA module to the server by clicking on Finish.
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4= Add and Remove Projects

Add and Remove Projects =
Muodify the projects that are configured on the server

Move projects to the right to configure them an the server
Available projects: Configured projects:

® (5 ALEIN_ALEAUDPERFACKETADD

If server is started, publish changes immediately

(7 Back lext Finish H Cancel J

Testing the assembled adapter application
Launch the SAP GUI.
Start the Transaction WE20.

Open the appropriate partner profile and set the packet size for the message type configured
during EMD.
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@ 9B e CHE Dhon DR @m

Partner profiles

Partner |Descripﬁon | %
(] Partner Type BP Benefits provid:E s
[J Partner Type GP Business PartnE TY— B ey ﬂ
(7 Partnier Type KU Customer Agent ZKHAN | Zafrulla KHAN
(] Partner Type LI Vendor Lang. EN English
= 173 Pariner Type LS Loagical system
ADAPTERLS L3 for SAP ada
AMITHLS Amit Agra Gupti
AMITHALS Anitha Krishnag
BETAQZ logical system { Outbound parmtrs.
BUGFESTY Logical System Partner Role|Message Type  |Messageva |MessageFu [Test ﬁ‘
DESTALE ALE destinatior| ALEREQ T T O
DYLCLWT100 Loagical system S i i e
JCO30RDEAL LSforJoo 3tes| (|| MATMAS | I | O
LSJW Logical System ORDERS 001 : | O [=]
LSRZ01 Logical System 1 ZDEBMAS el
MATLS matu LS
el e R EDD/— 6D |
MAVEEN naveen testing [=] EE_!E! =
| || I3 W s E1 B
| a7

In the Partner Profiles screen, double click on ALEREQ listed under Outbound parmtrs.

Change the Packet Size to 3 and select the radio button Collect IDocs and select the option
Collect IDocs. Click Save.

g 398 CHQ I CHE f0o0 BE @B
Partner profiles: Outbound parameters

Partner Ma. JCOZ0RDEAL LS for Jco 3 tesing %
Fartn Type E| Logical system M
Partner Role |_|
2 Message Type |m Purchase order / order
Message code Be1
Message function |_| [Test
Outbound Options
B
Receiver port ,WDRT ] Transactional RFC idoc PORT FOR JCO3RFCSERVY
Pack. Size 3 ]
[¥] Queue Processing Rule Mame |CDNSTAHT:EDI UEUE
Output Mode
O Transfer IDoc Immed. Output Mode 4 E
® CollectIDocs =]
| alz

Start the Transaction WE19.
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Choose the radio button Existing IDoc.

Select an existing IDoc ORDERSO05 that you want to send

Set appropriate values in IDoc.

Select Standard Outbound Processing button.

Change the No. of IDocs to be generated to any number. Select Continue in the pop-up box.

Note: If packet size is configured as 3 in SAP system and No. of IDocs to be generated is 6 then,
it means that we are trying to send 2 packets. Hence 2 ALEAUD will be generated.

Start the transaction WEO2. This opens the browser IDoc List. Give appropriate value for
Creation On and click execute.

The next screen shows the Outbound IDocs and Inbound IDocs.
6 Outbound IDocs with packet size as 3 will result in 3 ALEAUD.

This creates an ALE inbound event for the ALE inbound application deployed eatlier.
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Chapter 19. Tutorial 14: ALE Audit support for
Pass through IDocs (Generating
ALEAUD per IDoc for ALE Pass
through IDocs)

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTALL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALIL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Setver v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <WPS_INSTALL>/lib directory.
When working with WebSphere Process Setver on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Copy CWYAP_SAPAdapterExt.jar to the <WPS_INSTALL>/lib directory.
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When working with WebSphere Application Setver on z/OS, add
${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY_server_region_classpath.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Configuring the adapter for inbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service.

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&= New External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: |type filter text

¥

Available Types;

=@ Adapters
o CIcs
£ E-mail
Flat File
fte FTP
I IMS
EE iSeries
JOE 1D Edwards
[@] JoBC
B Lotus Domino .
E'@ Orade
& PeopleSoft

' Siebel

[>

(£

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding. During outhound processing, services running on WebSphere

Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the

SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

T
w

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

&= New External Service |:.®

Select an Adapter

L
=
Select the adapter you want to use, ek
i d
Y
L1} =
@P IEM WebSphere Adapter for SAP Software (IEM : 7.0.0.0)
IBM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)
b,

[
[/

T

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard eatlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the
current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3. Specify a Connector Project name in the Import a RAR File screen and click Next.

#= New External Service

Import a RAR File !

=
Import a resource adapter archive (RAR) from the file system to create a connectar @ I
project for the adapter. A
Archive file: C:\WID_new'RekourceAdapters\SAP_7.0.0.0\CWYAP_SAPAdapter Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'|."'.|'EI:|S|:|herE Process Server v7.0 o |

(£ [ < Back ” Mext = Finish

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

#= New External Service |:||E|r>__<|
Locate the Required Files and Libraries :L

Connector projects require system-specific libraries and JAR files. Specify the location
of these files. I—‘

When deploying the application to a stand-alone server, these files must be configured on the server. Mare ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjood.jar file: = | C:\SAPICo \sapico3nintel-3.0, 2\sapjco3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo\sapjoo3-nintel-3.0, 2\sapjco3.dil | |§Brnwse... |

TN T
by

Figure: Locate the required files and 1.ibraries screen

5. Click Next.
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0. In the Select the Processing Direction screen, select Inbound radio button, then click Next
button.

d= New External Service |:||E|[E|

Select the Processing Direction ?

Select the direction of adapter processing at run time., ;

Inbound processing passes data from the adapter to your service export,

) Outbound

CQuthound processing passes data from your service import to the adapter.

=

':'E':' [ < Back ” Mext =

Figure: Select the processing direction

Setting connection properties for the New External Service wizard

You must provide the following information in the Discovery Configuration screen:

User name
Password
Host name

System number
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SAP Client connection
Click Select to change the default Language code from English
Use the drop down option to change the default Code page from 1100.

Select ALE Pass-through IDoc as the SAP Interface name.
Click Next.

&+ New External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (Engish) || select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srmandur |
Password: = | FU— |
SAP interface name: |.-5.LE pass-through IDoc 3 |

] change the logging properties for the wizard

Finish Cancel

Figure: Select ALE pass-through 1Doc as the interface
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Selecting the Business Objects and services to be used with the adapter

Under Find Obijects in the Enterprise System, expand the ALE node, select Generic IDoc

and click the i===i button to add to the selected objects.

#+ Mew External Service

Find Objects in the Enterprise System
Expand nodes to view and select discovered objects. Use filtering, if necessary, to limit number ::L__J
of objects displayed. o
Discovered objects: Selected objects:
BB
= & AE

©
é‘j' Discover IDoc From System
é;.‘]_\' Discover IDoc From File

)

|.-5.|:||:| selected discovered objects to selected object

Figure: Object Discovery and Selection

In the Configuration Parameters screen, choose the default values and click OK.
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4= New External Service @
specify the Configuration Properties for 'Generic IDoc’

gy ]

)

The adapter can process the inbound IDoc packet as one business object or send
each IDoc in the packet as an individual business object.

[ ]5end an IDoc packet as one business object

7 [ Of., l [ Cancel
by

Figure: Configuration properties for * Generic IDoc’

Generic IDoc has now been added to the list of Business Objects to be imported.
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#+ Mew External Service

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects, Use filtering, if necessary, to limit number ::LJ
of objects displayed. o

Discovered objects: Selected objects:

=] é;j" ;A—IZE ':Ij_\' Generic IDoc
(@) Generic IDoc
&.'j\' Discover IDoc From System
é@' Discover IDoc From File

@ e [ we ] o
a0

Figure: Selected Generic IDoc added to the Objects to be imported

Click Next.

On the Service Generation and Deployment Configuration screen, enter the connection
information.
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&= New External Service

Specify the Service Generation and Deployment Properties

Specify properties for generating the service and running it on the server.

Deployment Properties ~
How do you want to specify the security credentials?
(T Using an existing JAAS alias {recommended)

(3) Using security properties from the activation spedfication

The properties will be stored as plain text; no encryption is used.

User name: = | srnandur |
Password: = | PU——— |
() other

Deploy connector project: With module for use by single application R

Specify the settings used to connect to SAP Software at run time:

Connection Properties

SAP system connection information
[Juse load balancing
To use load balancing, specify the load balancdng properties in the Additional connection configuration panel under the Advanced tab.

Host name: = | cwd3L.svl.ibm.com |
RFEC program ID: = | JCOIRFCSERVER3 |
Gateway host: | cwd3t.sul.ibm. com |
Gatenay service: | sapanoi |
client: [ 100 |
Language code: | EN (Engish) | [select... |
Code page: | 1100 v|
System number: |01 |

The user name and password will not be encrypted and will be stored as plain text.

Event persistence configuration

Select this option to retain the events in-memory. This ensures a once-only delivery of the inbound events. If this option is not
selected, performance increases; but there is a risk of losing the events in transit if an unexpected shutdown occurs.

[JEnsure assured-once event delivery (may reduce performance L

schEma name: | |

-

Figure: Service Generation and Deployment Configuration
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NOTE: You can either enter Authentication Alias previously created using the Administrative

Console of the WebSphere Process Server or enter the username and password used to login in to
the SAP.

Also enter the RECProgramlID (as shown in figure). This must have been already configured in
the SAP system.

Click the Advanced tab and in ALE event status configuration select ALE update status.

- Oy

ALE event status configuration -
Properties to configure packet error handling and to enable updates of SAP system audit records.
|:| Ignore IDoc packet errors
[FIALE update status
[Jsend ALEAUD per packet

Selective update: | |

Status message code:

Success code: = i 55 w |
T
|

|
Failure code: = | 51 - '
Success text: = i?pplicatinn document posted |
Failure text: * | Application document not posted |
Click Next.

In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select Module radio button and
click Next.
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4= New Business Integration Project

Select a Business Integration Project Type

L
Select the type of business integration project that you want to create, m

IJse @ module to integrate business applications and services, A
module can contain any type of component and can be deployed
an WebSphere Process Server, More, ..

) Mediation module Use & mediation module to integrate and connect services, A
mediation module can contain mediation flows and can be
1~ deployed on WebSphere ESE or WebSphere Process Server,

In the New Module screen, type ALEIN_PASSTHOUGHAUDITPERIDOC in the Module
Name field, and then click Finish.
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4= New Module

Create a Module

Use a medule to integrate business applications and services, & module can contain any type
of companent and can be deployed on WebSphere Process Server, D

Module name: | ALEIN_PASSTHOUGHAUDITPERIDOC |

IUse default location

| 1
AL g JrEsPace = T et LS —hd s STOWSE.

Open module assembly diagram

7 Mext [ Eirish ][ Cancel

Verify results.

Projects Me

= ';g ALEIM PASSTHOUGHAUDITPERIDOC
=55 Assembly Diagram
: : % SAPInboundInterface
v ﬁ Dependencies
i L;,,'?E Integration Logic
= 5 Data Types
(= SapGenericlDocObject
= .L_f,' Interfaces
- @ SAPInboundInterface
“o 2 Transformations
= 8 cwyaP_saPAdapter Tx

Figure: Artifacts created after the EMD run for ALE pass-through Inbound Module

Generating Reference Bindings

In the Business Integration Perspective of WebSphere Integration Developer, expand the
ALEIN_PASSTHROUGHAUDITPERIDOC SCA module, and double click on the
Assembly Diagram. The Assembly Diagram screen appears with the module’s Export
component in view.

1. To create a new component, click the button of Java component from the Palette.
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'9%ALE{N_PASEHGUGHAUDH‘PERIDOC - Assembly Diagram £

-2 Palette

: [:3 &‘L 'Ew'. E-LJ ﬁ il .
. (= Favorites @ E‘;ﬁ SAPInboundInterface

[= Components

'Pdi., Untyped Component
42] Human Task

E,ﬂ'g Java

Figure: ALE pass-through Inbound interface in the Assembly editor

Click and drag the java component to add the new component to the Assembly Diagram screen.

Add a Wire between the SAPInboundlInterface and the Java component.
(D) There is a new element that has been added ¢

@ ?\'|_np SAPInboundInterface

Figure: ALE pass-through Inbound interface being wired to a target Component(end-
point)

In the Add Wite screen, click OK.
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4= Add Wire

This action will allow the target service to be used in other modules. The
\tf) service interface from the export will be added to the target. Do you want to
continue?

[ ] always create without prompt

| ok [ Cancel

Figure: Add Wire Confirmation Dialog

Right-click on the new component and select Generate Implementation. This creates a Java
component that will act as an endpoint.

n = Add... r
% b Ce Change Type... r

L]
Generate Export... »

Generate Implementation h
Select Implementation

Synchronize Interfaces and References... ¥
Refactor... r
Merge Components

af Cut
=] Copy :
rver Logs ¥ih Serv i

Stalus | 99 pelete

Figure: Creating Java implementation for the target Component.

In the Generate Implementation screen, select the package in which the Java code will be
created and click OK. A Java file in an editor screen appears.

Edit the Java file if you may wish to write code to print trace and log messages or Data Object.

Ensure that the package com.ibm.j2ca.base.AdapterBOUtil is imported.
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Method generated to support implementation of operation "executeSapGenericIDocObject” defined for WSDL port type
nop

named "S5AFInboundInterface”.

The presence of commonj.sdo.DataCbject as the return type and/or as a parameter

type conveys that it is a complex type. Please refer to the WSDL Definition for more information
on the type of input, output and fault(s).

2N T T T T T

poblic wvoid executeSapGenericIDocCbhject |
DataCbject executeSapGenericIDocObjectInput) {
try {
System.out.println(AdapterBOUtil.serializeDatadbject (executeSapGenericIDocObjectInput)) ;
} catch (Exception e) {
/f TODO Ruto-generated catch block
e.printStackTrace():

: I

Save the Java file

Save assembly diagram.

Deploying the module in the test environment
After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration

Developer’s Test Client.

Right click on your server node in the Server tab and add the module
ALEIN_PASSTHOUGHAUDITPERIDOC by selecting Add and Remove Projects.

4= Add and Remove Projects

Add and Remove Projects %
Modify the projects that are configured on the server

Move projects to the right to configure them on the server
Available projects: Configured projects;

& (B ALEINV PASSTHOLIGHALDIT,

!d\
|

If server is started, publish changes immediately

7 Mext Finish ] [ Cancel
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Testing the assembled adapter application
Launch the SAP GUL
Start the Transaction WE19.
Choose the radio button Existing IDoc
Select an existing IDoc ALEREQO1 that you want to send
Set appropriate values in IDoc.
Select Standard Outbound Processing button
Select Continue in the pop-up box

Start the transaction WEO2. This opens the browser IDoc List. Give appropriate value for
Creation On and click execute.

The next screen shows the Outbound IDocs and Inbound IDocs.
An ALEAUD packet is generated for each outbound IDoc.
This creates an ALE inbound event for the ALE inbound application deployed eatlier.

The event should reach the Java end point, indicated by the output of ALEREQO1 Business
Object on the console of WebSphere Integration Developer.
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Chapter 20. Tutorial 15: Sending data from SAP
(INBOUND processing) using tRFC
BAPI

Following sections explain inbound scenarios for the BAPI interface.

Configuration prerequisites

Note: If you have previously configured prerequisites, skip this step and move to the next step.

After you create the connector project, you must add the required external dependencies into the
project. SAP Java Connector interface is an external dependency that the adapter has for
connecting to the SAP software application. The adapter uses this interface to make calls to the
SAP native interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector interface to the imported
project. All external libraries and JAR files must first be copied to the appropriate locations on
WebSphere Process Server:

Copy the dependency library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTALL>/bin
directory (If WID is installed generally the WebSphere Process Server instance is installed under
<WID_INSTALL_DIR>/runtimes/bi_v7).

(For z/OS users) add the *.so libraries to the <WAS_INSTALL>/lib directory.

(Windows users) Install the msvep71.dll and msver71.dll files in the Windows system path.

You need the sapjco3.dll file to run the EMD wizard.

Copy sapjco3.jat to the <WPS_INSTALL>/lib directory.

(For z/OS users) add ${WAS_INSTALL_ROOT} /lib/sapjco3.jar to
WAS_SERVER_ONLY _server_region_classpath

You need the sapjco3.jar file to run the EMD wizard.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.
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Copy CWYAP_SAPAdapterExt.jar to the <WPS_INSTALL>/lib directory.

(For z/OS users) add ${WAS_INSTALL_ROOT}/lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY_server_region_classpath

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Configuring the adapter for inbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&= New External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: |type filter text

¥

Available Types;

=@ Adapters
o CIcs
£ E-mail
Flat File
fte FTP
I IMS
EE iSeries
JOE 1D Edwards
[@] JoBC
B Lotus Domino .
E'@ Orade
& PeopleSoft

' Siebel

[>

(£

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding. During outhound processing, services running on WebSphere

Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the

SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

T
w

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

# Mew External Service

Select an Adapter
Select the adapter you want to use.

~=
'::__J'

]|

el

@p IEM WebsSphere Adapter for SAP Software (IBM : 7.0.0.0)

IEM WehSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction support

() [ < Back ” Mex]z l Finish
W

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the

current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3. Specify a Connector Project name in the Import a RAR File screen and click
Next.

# New External Service

Import a RAR File !

=
Import a resource adapter archive (RAR) from the file system to create a connector @ I
project for the adapter. |
Archive file: C:\WID_new'\RekourceAdapters\SAP_7.0.0.0VCWYAP_SAPAdapter Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |
Target runtime enviroment: |'|."'.n'el:u5|:uhere Process Server v7.0 b |

@ [ <ok J|_ mext> Einist

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

#= New External Service |:||E|r>__<|
Locate the Required Files and Libraries :L

Connector projects require system-specific libraries and JAR files. Specify the location
of these files. I—‘

When deploying the application to a stand-alone server, these files must be configured on the server. Mare ...

Spedfy the location of the files required to access the SAP server. You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjood.jar file: = | C:\SAPICo \sapico3nintel-3.0, 2\sapjco3.jar | [Brnwse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo\sapjoo3-nintel-3.0, 2\sapjco3.dil | |§Brnwse... |

TN T
by

Figure: Locate the required files and 1.ibraries screen

5. Click Next.
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6. In the Select the Processing Direction screen, select Inbound radio button, then
click Next button.

d= New External Service |:||E|[z|
Select the Processing Direction ?

Select the direction of adapter processing at run time. ;

Inbound processing passes data from the adapter to your service expaort.

() Outbound

Cuthound processing passes data from your service impart to the adapter.

=

':':’:' [ < Back ” Mext = l

Setting connection propertiesfor the New External Service wizard
You must provide the following information in the Discovery Configuration screen:
User name
Password
Host name
System number

SAP Client connection
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Click Select to change the default Language code from English
Use the drop down option to change the default Code page from 1100.
Select BAPI as the SAP Interface name.

Click Next.

& New External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (English) | | select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Passwﬂrd' = | s+ 55+ |

saP interface name: | (1T ARG |

[ ]change the logging properties for the wizard

Cancel

@ <gack || mext> |
53

Figure: Select BAPI asthe interface
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Selecting the Business Objects and services to be used with the adapter

=

Under Find Objects in the Enterprise System, click on RFC node. Then click the #™ button.

4 Mew External Service

Find Objects in the Enterprise System ::L

Expand nodes to view and select discovered objects. Use filtering, if necessary, to
limit number of objects displayed. >

Discovered objects: Selected objects:

) rrC
£3) BOR

Mext = Finish Cancel

Figure: Object Discovery and Selection



WebhSphere. Bl E (=

Enter Z_ASYNCBAPI_1 (the name of the BAPI in SAP) in the Filter Properties for ‘RFC’
screen.

#= Mew External Service

Filter Properties for "RFC’ -
Spedfy the properties.
Object attribute to use for discovery: |Disu:u:w’er objects by name b4 |
Find ohjects with this pattern: = | Z_ASYNCBAPI_1 |
Maximum number of objects to retrieve: | 25 b4 |
@ | (. | [ Cancel l
My

Figure: Filter Propertiesfor RFC

Click OK.

Expand the RFC node.

#$= New External Service

Find Objects in the Enterprise System ::L

The default number of objects to retrieve is 25. To retrieve more objects, select the filter icon to
change the default setting. > |

Discovered objects: Selected objects:

=-£3) RFC (filtered)

i)}z AsvyMNCBAPT 1

) por

Ly

|Add selected discovered objects to selected objects.

Figure: Retrieved BAPIS based on search criteria
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Select the Z__ ASYNCBAPI_1 from the metadata tree.

Click the i===i button.
A popup will appear containing the Configuration properties for the Z_ASYNCBAPI_1 object.

Check the Use SAP filed names to generate attributes names checkbox if you want the
Business Object attribute names to be generated using SAP field Names.

You can choose to create attributes in the Business Object for any optional parameter in the
BAPIL

Click OK.

#= Mew External Service

Specify the Configuration Properties for 'Z_ASYNCBAPL_1'

Attribute names of discovered objects can be generated from either SAP field names or from SAP field descriptions, which are
more understandable.

[Juse 5AP field names to generate attribute names

The selected object has optional RFC import, export, or table parameters. If selected, the optional parameters will be
generated as child objects of the selected object.

-+
5

= < Optional parameters
= < Optional import parameters
< CUSTOMERCOMPANYDETAIL
< RETURN
< CUSTOMERGEMERALDETAIL
< CUSTOMERADDRESS
<» Optional table parameters

[ Select All “Deselect AII]

@ | OE [ Cancel ]

Figure: Setting configuration parameters for the BAPI *Z_ASYNCBAPI_1’

Click Next.
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Generating Business Object definitions and related artifacts

In the Specify Composite Properties screen, select Create as the operation, bodefs as the folder
name for the Business Objects generated and choose the RFC Function Call Type as
Asynchronous Transactional/Queued RFC.

#= New External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

The inbound BAFT interface enables the adapter to act as an RFC server. This allows an RFC dient on the SAP
gystem to invoke an RFC-enabled function through the adapter to the endpoint. Assodate the RFC-enabled function
name below with an endpoint operation,

Operations: | Create W |
Business object namespace: = | http: ffwww . ibm. comxmins fprodfwebsphere fi2cafsap |
Specify the relative folder for the generated business object:

Falder: | bodefs |

[ ]Enable dynamic authentication function

SAP Remote Function Call (RFC) type: |Asynd1ru:unu:uus Transactional /(Queued RFC w |

@ <t ][ e ]

Figure: Specify Composite Properties

Click Next.

In the Service Generation and Deployment Configuration screen enter the connection
properties and deployment properties.
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&= New External Service

Service Generation and Deployment Configuration :
A o,
Specify properties for generating the service and running it on the server, :D -

>

Service Operations

To_mndify ﬂje names, or add a description to the operations to be generated in the interface file, dick Edit Operations...
Edit Operations.

Deployment Properties
How do you want to specify the security credentials?
() Using an existing JAAS alias (recommended)

(%) Using security properties from the activation spedfication

The security properties will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Password: s [semeeees |

) other

Deploy connector project: |Wiﬂ'| module for use by single application w |

Specify the settings used to connect to SAP Software at run time:

Connection Properties
SAP system connection information
[ Use load balancing

To use load balandng, specify the load balancing properties in the Additional connection configuration panel
under the Advanced tab.

Host name: = | cwd31.svl.ibm.com

RFC program ID:= | JCO3RFCSERVER3

Gateway service: | sapgwil

|
|
Gateway host: | cwd31.svl.ibm.com |
|
|

Client: | 100

Language code: | ENM (English) | [5elect... ]

Code page: | 1100 w |

System number: | 01 |

The user name and password will not be encrypted and will be stored as plain text.

i€

Cancel

@ [ <Back || mpt= |
W

Figure: Service Generation and Deployment Confignration
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Note: You can either enter Authentication Alias previously created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP system. Also enter the REFCProgramID (as shown in figure). This must have
been already configured in the SAP system.

Click Next

In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select Module radio button and
click Next.

4= New Business Integration Project

Select a Business Integration Project Type |

Select the type of business integration project that you want to create., m

IUse a module to integrate business applications and services. A
module can contain any type of component and can be deployed
on WebSphere Process Server, More, .,

) Mediation module Use a mediation module to integrate and connect services. A
mediation module can contain mediation flows and can be
A deployed on WebSphere ESE or WebSphere Process Server,

®

In the New Module screen, type BAPI_tRFC_IN in the Module Name field, and
then click Finish.
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#= New Module

Create a Module

IUse @ module to integrate business applications and services, A module can contain '
any type of component and can be deployed on WebSphere Process Server, D

Module name: | BAPT_tRFC_IN |

Lse default location

Locakiar | E GrESPaces \GapsammeEsipRFL_ il 1 Drowse. ..

Dpen module assembly diagram

@ Mext [ Finish J[ Cancel

Click Finish on the Specify the Location Properties screen.

4= New External Service I:Iri ”z|

Specify the Location Properties

i
Specify location properties for where you want to save the
SErvice.
Properties for service
Module: |BAPI_tRFC_IN v | [rew... |
Use default namespace
Falder: | | [Ernwse. 5 ]

MName: * | SAPInboundInterface |

[ ]5ave business objects to a library

|ilEpaes
iGrat

Description: |

@ Mext [ Einish H Cancel

Verify the results.
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=32 BAPI_tRFC_IN
= ‘f'fﬂ Assembly Diagram
p SAPInboundInterface
& Dependencies
.;'-'E" Integration Logic
= -._.ﬁ Data Types
o | SapCustomeraddress
| SapCustomerbankdetail
fd SapCustomercompanydetail
2 SapCustomergeneraldetail
If] SapReturn
= SapZasynchapil
= SapZAsyncbapi1Wrapper
= ._'L_i,i Interfaces
: @ SAPInboundInterface
; qu_,_' Transformations

Figure: Artifacts created after the EMD run fore BAPI tRFC Inbound Module

Generating Reference Bindings

In the Business Integration Perspective of WebSphere Integration Developer, expand the
BAPI_tRFC_IN SCA module, and double click on the Assembly Diagram. The Assembly
Diagram screen appears with the module‘s Export component in view.

1. To create a new component, click the button of Java component from the Palette.

|71 BAPI_RFC_IN - Assembly Diagram 57

% { 5% Palette
NEEEE

_ (== Favorites

- (= Components

{ L2, Untyped Component
4=] Human Task

@ ﬁp SAPInboundInterface

'-_l'._l"gg Java
Figure: BAPI tREC Inbound interface in the Assembly editor

2. Click and drag the Java component to add the new component to the Assembly Diagram

screen.

3. Add a wire between the SAPInboundInterface and the Java component.
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(L) There is & new element that has been added -

@ ?\'|_np SAPInboundInterface

@@ ﬂr

% I}ﬂ Componentl
L]

Figure: BAPI Inbound interface being wired to a target Component(end-point)

4. In the Add Wire screen, click OK.

4 Add Wire E3
9 ) This action wil allow the target service to be used in other modules. The
\{,) service interface from the export will be added to the target. Do you want to
continue?
[ ] always create without prompt

Pook [ Cancel

Figure: Add Wire Screen

5. Right-click the new component and select Generate Implementation. This creates
a Java component that will act as an endpoint.
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7 =r Add... k
% ik Cc Change Type... L

[ ]
Generate Export. .. L

Generate Implementation k
Select Implementation

Synchronize Interfaces and References. ., *
Refactor... L
Merge Components

of Cut
[i=| Copy
rver Logs | 47k Sery 8

Stals | ¢ pelete

Figure: Creating Java implementation for the target Component.

i

In the Generate Implementation screen, select the package in which the Java code will be
created and click OK. A Java file in an editor screen appears.

Edit the Java file if you may wish to write code to print trace and log messages or Data Object.

Ensure that the package com.ibm.j2ca.base.AdapterBOUtil is imported.

* Method generated to support implementation of operation "emitCreateAfterImageSapZhsyncbapilWrapper" defined for WSDL port type
* named "SAPInboundInterface”.
* The presence of commonj.sdo.Datalbject as the return type and/or as a parameter
* type conveys that it is a complex type. Please refer to the WSDL Definition for more information
* on the type of input, output and fault(s).
public void emitCreateAfterImageSapZisynchapilWrapper |
Datalbject emitCreatehifterImageSapZisynchapilWrapperInput)
try {
System.out.println(AdapterBOUtil.serializeDatalbject (emitCreatelifterImageSapZhsyncbapilWrapperIinput));
} catch (Exception e)
e.printStackTrace(};

Save the Java file

Save assembly diagram.



WebhSphere. Bl E (=

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module BAPI_qRFC_IN by
selecting Add and Remove Projects.

The project BAPI_qRFC_INApp will be listed under Available projects.

4= Add and Remove Projects X |r._||E||z|
Add and Remove Projects =
Modify the projects that are configured on the server —
==}
Move projects to the right to configure them on the server
Available projects: Configured projects:
@-(Fy ALEIN_ALEAUDPERPACKE
& (5 ALEIN_PASSTHOUGHALD! [ ey
MEYEAPT tREC TNADD =
| addals»
& | %
If server is started, publish changes immediately
@ < Back Mext [ Finish ] [ Cancel ]

After adding the project, the added project should appear under the Configured projects. Add
the SCA module to the server by clicking on Finish.



WebhSphere. Bl E (=

i e ——
4= Add and Remove Projects |_.|E||g|
Add and Remove Projects =

Modify the projects that are configured on the server

E—l
Move projects to the right to configure them on the server
Available projects: Configured projects:
- (5 ALEIN_ALEAUDPERPACKE & ([ BAPT RFC INAnp

- (5 ALEIN_PASSTHOUGHALD:

o oaddall=> |

[ << Remove All ]

£ - | *

If server is started, publish changes immediately

(7 < Back Mext [ Finish ][ Cancel ]

Testing the assembled adapter application
Launch the SAP GUI.
Start the transaction SE 3.

Enter the function module name as Z_ASYNCBAPI_INBOUNDI1 click execute (F8).
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|& 340 ©OQ CHE Dton BE Om
Function Builder: Initial Screen

2] 1 /5[] [ BB Reassian. |

Function Module |z_ASYNCEAPI_INEOUND1 [=

l¢¢ Display | [ change | [D) Create |

a7
Give appropriate values to the fields CUSTOMERNO and RFCDEST. Click execute.
le ! " IH e@Q DHE Dnon OF OF
Test Function Module: Initial Screen
|@ Debugging || Test data directory |
Test for function group ZFG_TESTGROUP E
Function module Z_ASYNCEAPI_INBOUNDA E
Uppercase/Lowercase
RFC target sys:
Import paramsters fB1ue
CUSTOMERNO 1
RFCDEST JCOZRFCSERVER
=
[]
| a7

In the console of WebSphere Integration Developer, you could see the BAPI Business Object
printed (as we entered a print statement in the Component implementation above).
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Chapter 21. Tutorial 16: Sending data to an
SAP system (Outbound processing)
using tRFC BAPI

Following sections explain inbound scenarios for the BAPI interface.

Configuration prerequisites

Note: You do not have to perform this step if you have already done so for another scenario.

After you create the connector project, you must add the required external dependencies into the
project. The SAP Java Connector (JCo) interface is an external dependency that the adapter
requires in order to connect to SAP systems. The adapter uses SAP JCo to call SAP’s native
interfaces.

Use WebSphere Integration Developer to add the SAP Java Connector library to the imported
project. You must copy all external libraries and JAR files to the appropriate locations on the
WebSphere Process Server:

Copy the native library (sapjco3.dll or libsapjco3.so files) to the <WPS_INSTALL>/bin directory
(If the WebSphere Process Server v7.0 bundled with WebSphere Integration Developer v7.0 is
used, it will be installed at <WID_INSTALL_DIR>/runtimes/bi_v7).

When working with WebSphere Process Server v7.0 on z/OS , add the *.so libraries to the
<WPS_INSTALL>/lib directory.

When working with WebSphere Integration Developer v7.0 on Windows, ensure that msvep71.dll
and msver71.dll exist in the Windows system path.

The sapjco3.dll file is required to run the New External Service wizard.
Copy the sapjco3.jar file to the <WPS_INSTALL>/lib directory.

When working with WebSphere Process Setver on z/OS, add
${WAS_INSTALL_ROOT} /lib/the sapjco3.jar file to
WAS_SERVER_ONLY _server_region_classpath

The sapjco3.jar is required to run the New External Service wizard.

<WPS_INSTALL> represents the WebSphere Process Server installation directory.
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Copy CWYAP_SAPAdapterExt.jar to the <WPS_INSTALL>/lib directory.

When working with WebSphere Application Setver on z/OS, add
${WAS_INSTALL_ROOT} /lib/ CWYAP_SAPAdapterExt.jar to
WAS_SERVER_ONLY _server_region_classpath

<WPS_INSTALL> represents the WebSphere Process Server installation directory.

Configuring the adapter for outbound processing

Run the New External Service wizard to generate Business Objects, Services, and configuration
to be used in this tutorial.

After opening WebSphere Integration Developer, the default perspective is usually Business
Integration
Start the New External Service wizard by choosing: File-> New -> External Service

1. Select Adapters > SAP from the Select the Service Type of Registry screen and
click Next.
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&+ New External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse.

Filter: | type filter text

¥

Available Types:

=@ Adapters

o CICS

B E-mail

Flat File

ftp FTP

I IMS

Ei iseries

JOE 1D Edwards
[@ JoBC

E Lotus Domino
Eﬁé Oracle

& Peoplesoft

‘o Siebel

—

(>

[ £

Description:

Creates a service to access the SAP server using WebSphere® Adapter for SAP Software. You can
create service-oriented integrated processes, which can interact and exchange information with the
SAP Server, without spedial coding, During outhound processing, services running on WebSphere

Process Server or WebSphere Enterprise Service Bus use the adapter to perform operations on the

SAP EIS. During inbound processing, these services use the adapter to receive events from the SAP
EIS.

I3

I Cancel

Figure: Select the Service Type or Registry screen
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2. Select the IBM WebSphere Adapter for SAP Software with transaction support
(IBM: 7.0.0.0) from the Select an Adapter screen and click Next.

&= New External Service

Select an Adapter
Select the adapter you want to use,

-~
‘:J

o

E

@p IEM WebSphere Adapter for SAP Software (IEM : 7.0.0.0)

IBM WebSphere Adapter for SAP Software with transaction support (IBM : 7.0.0.0)

IEM WebSphere Adapter for SAP Software with transaction support

7 [ < Back H Mex{z l Finish
W

Figure: Select an Adapter screen

Note: If you have run the New External Service wizard earlier using the IBM
WebSphere Adapter for SAP Software with transaction support in the
current workspace, you can choose one from a list of configurations cached by
WebSphere Integration Developer.

Select the correct configuration by expanding the IBM WebSphere Adapter for
SAP Software with transaction support node.
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3. Specify a Connector Project name in the Import a RAR File screen and proceed by
clicking on Next.

&= New External Service El[z|
I

Import a RAR File

Import a resource adapter archive (RAR) from the file system to create a connector project for the @ l
adapter. A

Archive file; CWIDT\ResourceAdapters\SAP_7.0.0.0VCWYAP_SAPAdapter_Tx.rar
Connector project: = | CWYAP_SAPAdapter_Tx |

Target runtime enviroment: |'|."'.|'EI:|5|:-herE Process Server w7.0 b |

® e |

Figure: Import a RAR file screen
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4. In the Locate the Required Files and Libraries screen, provide the location of the
sapjco3.jar file and the sapjco3.dll or libsapjco3.so files.

#= New External Service

Locate the Required Files and Libraries ('Tﬁ.
Connector projects require system-specific libraries and JAR files.
When deploving the application to a stand-alone server, these files must be configured on the server, Mare ...

Specify the location of the files required to access the SAP server, You might first need to contact your SAP system
administrator to download these files from the SAP Web site,

SAP sapjcod.jar file: = | C\SAPICo\sapjco-nintel-3.0, 3\sapjco3.jar | [Browse... ]

System library file (sapjco3.dll or libsapjco3.so):= | C:\SAPICo'sapjco-nintel-3.0. 3\sapjco3.di | [Brnwse... ]

® <o | g ]

5. Click Next.
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0. In the Select the Processing Direction screen, select Outbound radio button and click Next.

&= New External Service |Z|E]

Select the Processing Direction ?
Select the direction of adapter processing at run time., ;
) Inbound

Inbound processing passes data from the adapter to your service export.

=

(%) Qutbound

Quthound processing passes data from your service import to the adapter,

AN

® <o [ mes ]

Setting connection properties for the New External Service wizard
You must provide the following information in the Discovery Configuration screen:
User name
Password
Host name
System number

SAP Client connection
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Click Select to change the default Language code from English
Use the drop down option to change the default Code page from 1100.
Select BAPI as the SAP Interface name.

Click Next.

&+ New External Service

Specify the Discovery Properties

Connection properties

SAP system connection information

Host name: = | cwd31.svl.ibm.com |
Systemnumber: | 01 |
Client: | 100 |
Language code: | EN (Engish) || select... |
Code page: | 1100 v

The user name and password will not be encrypted and will be stored as plain text.

User name: * | srnandur |

Password: + | EEm—— |

saP interface name: | E1T G |

] change the logging properties for the wizard

Cancel

@ <Back || Mext> |
h

Figure: Select BAPI astheinterface
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Selecting the Business Objects and services to be used with the adapter

—+l

In the Find objects in the Enterprise System screen, click RFC node. Then click the >
button.

&= Mew External Service

Expand nodes to view and select discovered objects. Use filtering, if necessary, to

Find Objects in the Enterprise System ::L
limit number of objects displayed. "“J‘

Discovered objects: Selected objects:

) rrC
£3) BOR

Mext = Finish Cancel

Figure: Object Discovery and Selection

Enter bapi_bank_* (the name of the BAPI in SAP) in the Filter Properties for ‘RFC’ screen.
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#= New External Service

Filter Properties for 'RFC’
Specify the properties.

Object attribute to use for discovery: Dizcover objects by name

Find objects with this pattern: = | bapi_bank_* |
Maximum number of objects to retrieve: |25 W |
(7 k. l [ Cancel ]

Figure: Filter Propertiesfor RFC

Click OK.

Expand the RFC node.

Select the BAPI_BANK CHANGE from the metadata tree.

Click the f= button.

A popup will appear containing the Configuration properties for the BAPI_BANK _CHANGE
object.

Check the Use SAP filed names to generate attributes names checkbox if you want the
Business Object attribute names to be generated using SAP field Names.

You can choose to create attributes in the Business Object for any optional parameter in the
BAPI. Click OK.
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#= Mew External Service k

Configuration Properties for 'BAPI_BANK_CHANGE' N

Specify configuration properties for the selected object. .:1\_)},
Attribute names of discovered objects can be generated from either SAP field names or from SAP field descriptions, which ca i
are more understandable.

[Juse sAP field names to generate attribute names

c= the ter case of SAP field names to oenerate business obiect atiribute names

The selected object has optional RFC import, export, or table parameters, If selected, the optional parameters will be
generated as child objects of the selected object.

-+l
T

= =8 Optional parameters
[ < Optional import parameters L
#-[+] < Optional export parameters

[

7 Ok ” Cancel ]

Click OK.
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# New External Service

Find Objects in the Enterprise System
Expand nodes to view and select discovered objects, Use filtering, if necessary, to :::LJ

limit number of objects displayed. o
Discovered objects: Selected objects:
o A El:l i
=R RFC (filtered) (@) BAPI_EANK_CH%E

--(0) BAPT_BANK_CHAMGE

() BAPI_BANK_CREATE

(@) BAPI_BANK_GETDETAILL §

() BAPI_BANK_GETLIST s

() BAPI_BANK_SAVEREPLICA

() BAPI_BANK_STATEMENT _EXEC
(@) BAPI_BANK_STATEMENT _GET
&9 BoR

@ | <Back || Mext> | = Erien

Similarly add BAPI_BAND_CREATE, BAPI_BANK_GETDETAIL, BAPI_BANK_GETLIST
and BAPI_BANL_SAVEREPLICA.
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4= New External Service

- B

objects displayed.

Find Objects in the Enterprise System

Expand nodes to view and select discovered objects. Use filtering, if necessary, to limit number of

Discovered objects:

=3 RFC (filtered)

(@) BAPT_BANK_CHANGE

(@) BAPI_BANK_CREATE

() BAPI_BANK_GETDETAL

(D) BAPI_BAMK_GETLIST

() BAPL_BANK_SAVEREPLICA

(D) BAPI_BAMK_STATEMENT EXEC
- (D) BAPI_BANK_STATEMENT_GET
®-3) BOR

(2] |1+]

Selected objects:

() BAPI_BANK_CHANGE
() BAPI_BANK_CREATE
(D) BAPI_BANK_GETDETAL
(D) BAPI_BANK_GETLIST
() BAPI_BANK_SAVEREPLICA

[ < Back ]L__h__lext:- ] Firish

Cancel

Click Next.
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#= New External Service

Specify Composite Properties
Specify properties that apply to all selected objects.

Select the checkbox option to generate BAFI business objects contained in a wrapper, You are allowed to configure a
maximum number of four BAPI business objects. If you do not select this option, topdevel business ohjects are
automatically generated for each BAPI selected and the adapter internally assigns the Execute operation to it. There
iz no limit on the number of BAPI business objects that you can configure.

[ ] Generate BAPI business objects within a wrapper

Business object namespace: * | http: ffwww.ibm. comfxminsfprod fwebsphere fi2cafsap |
Specify the relative folder for the generated business object:

Falder: | |
[ ]Enable dynamic authentication function

Asynchronous Transactional RFC w |

SAP Remote Function Call (RFC) type:

3] [ < Back ][ Mext =

Finish Cancel

In the Service Generation and Deployment Configuration screen enter the connection
properties and deployment properties.
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d= New External Service

Specify the Service Generation and Deployment Properties

Spedfy properties for generating the service and running it on the server. C

Service Operations

gzgg?jig:e names, or add a description to the operations to be generated in the interface file, dick Edit Edit Operations. ..

Deployment Properties —
How do you want to spedfy the security credentials?
i Using an existing JAAS alias {recommended)

{3} Using security properties from the managed connection factory

The properties will be stored as plain text; no encryption is used,

User name: = | srnandur |

Password: = | [R—— |

() Other

The guality of service to join the transaction provides a higher degree of data integrity, espedally in the event of a failure. As the
adapter only supports local transactions, it must be the only one phase commit capable resource in the transaction. Mare ...

Join the transaction {recommended)

Deploy connector project: |Wiﬂ1 module for use by single application w

Specify the settings used to connect to SAP Software at run time:

Connection Properties —
SAP system connection information -
[Juse load balandng

To use load balandng, specdfy the load balandng properties in the Additional connection configuration panel under the
Advanced tab, F

Host name: = i owd31.sv].ibm.com [

System number: | 01 |

Client: [ 100 |

Language code: | EM (English) | [Select... l

Code page: | 1100 w |

| £

®

[ <Back || Neqt> |
Wy

Figure: Service Generation and Deployment Confignration

Note: You can cither enter Authentication Alias already created using the Administrative
Console of the WebSphere Process Server or simply enter the username and password used to
login in to the SAP.

Click Next.
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In the Specify the Location Properties screen, click the New button next to the Module field to
create a new module.

When the New Business Integration Project screen appears, select Module radio button and

click Next.

4= New Business Integration Project

Select a Business Integration Project Type

il
Select the type of business integration project that you want to create. m

IUse a madule to integrate business applications and services. A module
can contain any type of companent and can be deployed on WebSphere
Process Server. More...

") Mediation module Use a mediation module to integrate and connect services, A& mediation
module can contain mediation flows and can be deployed on WebSphere
1] ESE or WebSphere Process Server, Mare...

/A

®

Cancel

In the New Module screen, type BAPI_qRFC_OUT in the Module Name field, and then click

Finish.
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4= New Module

Create a Module

IUse a module to integrate business applications and services, & module can contain any type of y |
component and can be deployed on WebSphere Process Server.

Module name: | BAPI_tRFC_OUT |

Ise default location

QAo | C lerkspaces \sapsamples \BAPT HRFC OL Browse...

Cpen module assembly diagram

&

Mext = Finish J [ Cancel

Click Finish on the Specify the Location Properties screen.
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4= New External Service

Specify the Location Properties AR
Specify location properties for where you want to save the service. [DJ

Properties for service

Module:  |BAPI_tRFC_OUT v | [New... |
NaiTeeraee: | httn://BAFT_tRFC OUT/SAPOutboundInterface 1 |

Use default namespace
Folder: | | [Ernwse...]
MName: * | SAPOutboundInterface1 |

[ ]save business objects to a library

LitiFars Now

Description: |

@ Mext = [ Finish ][ Cancel

Click Finish.

Verify the Results.
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=12 BAPI_tRFC_OUT
E]?Sl Assembly Diagram
& SAPCutboundInterface 1
lﬁ: Dependencies
ﬁ' Integration Logic
= ._'n} Data Types
f = DuplicateRecordFault
b InvalidRequestFault
[] MatchesExceededLimitFault
= MissingDataFault
ol MultipleMatchingRecordsFault
: I:l PrimarykeyPairType
(2] RecordNotFoundFault
= SapBankAddress
: = SapBankAddress1
- [] sapBankAddress 1575336843
(] SapBankAddress 194118585
= SapBankAddress 1x
- [C] sapBankAddress215898317
~[2) SapBankAddress711313654
= SapBankAddressx
= SapBankDetail
[7J SapBankDetail378239927
- [C] sapBankDetail998161649
= SapBankDetailx
= SapBankList
ol SapBapiBankChange
~[2] SapBapiBankCreate

i--[Z] SapBapiBarkCreate
; SapBapiBankGetdetail
b = SapBapiBankGetlist
= SapBapiBankSavereplica
I':] SapReturn
[2) SapReturn203510914
-[C] SapReturn333888311
[C] SapReturn447512479
-[2] SapReturn519647390

[ weTFault
= .E\,' Interfaces %
i @ SAPOutboundInterfacel

: 18 = .
.1_', Transformations

Figure: Artifacts created after the EMD run for the BAPI gRFC Module

The WSDL file generated during the New External Service wizard run shows that more than
four BAPIs can be selected at the same time.



software

251 _ADDRESS_UPDATE_WORK |25 BAPI_ADDRESS_UPDATE '35 BAPI_tRFC_OUT - Asse [ sapouthoundinterface 52 - ™2 =ilE.
%ﬁ% version="1.0" encoding="UTF-8"?><wsdl:definitions name="5APOutboundInterfacel.wsdl" targetNamespac #
mad Do

<xsd:= ma elementFormDefault="gualified" targetNamespace="http://com/ibm/j2ca/fault/afcfault™ xmln

<xsd:include schemalocation="MissingDataFault.xsd"/>
<xsd:include schemalocation="InvalidReguestFault.xsd"/>
<{xsd:schema>
<xsd:schema elementFormDefault="gualified" targetNamespace="http://BAPI tRFC_CUT/S5APCutboundInterfac
<xsd:import pamespace="http://com/ibm/j2ca/fault/afcfault"/>
<xsd:import namespace="http://www.ibm.com/zmlns/prod/websphere/j2ca/sap/sapbapibankcreate”™ schemal
<xsd:import nams 1/ fwww . ibm. com/xmlns/prod/websphere/j2ca/sap/sapbapibanksavereplica™ sc
<mad:import o :/fwww.ibm. com/xmlns/prod/websphere/j2ca/sap/sapbapibankgetdetail™ sche:
<xsd:import :/fwww . ibm. com/xmlns/prod/websphere/j2ca/sap/sapbapibankchange™ schemal
ame = e="http://www.ibm.com/xmlns/prod/websphere/j2ca/sap/sapbapibankgetlist” schema
<xsd:element name="executeSapBapiBankChange™>

<xsd:import namesp

<xsd:complexType>
<xsdissquence>
<xsd:element name="executeSapBapiBankChangeInput"”™ type="bonsl:SapBapiBankChange™/>
</xsd:complexType>
</xsd:element>
<xsd:element name="executeSapBapiBankChangeResponse™>
<xsd:complexType>
sxsdiseguence>
<xsd:element name="executeSapBapiBankChangeQutput™ type="bonsl:SapBapiBankChange"/>
</xsd:complexType>
</xsd:;
<xS

-lements

ielement name="MissingDataFault element™ nillable="true" type="bons3:MissingDataFault"/>

) — | &

Deploying the module in the test environment

After completing the New External Service wizard, an SCA module gets generated with EIS
Import or Export options. This module must be installed in the WebSphere Integration
Developer’s Test Client.

Right click on your server node in the Server tab and add the module BAPI_qRFC_IN by
selecting Add and Remove Projects.

The project BAPI_qRFC_INApp will be listed under Available projects.
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&= Add and Remove Projects |:|E”Z|

Add and Remove Projects
Maodify the projects that are configured on the server
=—

Maove projects to the right to configure them on the server
Available projects: anﬁ&ed projects:

-(f} _ADDRESS_UPDATE_WOF E (§ BAPL (RFC_OUTARD
-5 ALEIN_ALEALUDPERPACKE
-5y ALEIN_PASSTHOUGHALID! s
-(F] BAPI_ADDRESS_LIPDATE_
-(F] BAPI_tRFC_INApp

L

[ AddAl ==

[ << Remaove All ]

< T— 3

If server is started, publish changes immediately

@ < Back =t [ Finish ][ Cancel J

Click Finish.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and services
currently available in your area. Any reference to an IBM product, program, or service is not
intended to state or imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any IBM intellectual
property right may be used instead. However, it is the uset's responsibility to evaluate and verify
the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You
can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquities, in

writing, to:
IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku

Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
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PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions of
the publication.

IBM may make improvements and/or changes in the product(s) and/or the program(s) described
in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and
do not in any manner serve as an endorsement of those Web sites.

The materials at those Web sites are not part of the materials for this IBM product and use of
those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i)
the exchange of information between independently created programs and other programs
(including this one) and (ii) the mutual use of the information which has been exchanged, should
contact:

IBM Corporation Department
274A/SOM1 294 Route 100

Somers, NY 10589-0100 U.S.A.

Information concerning non-IBM products was obtained from the suppliers of those products,
their published announcements or other publicly available sources. IBM has not tested those
products and cannot confirm the accuracy of performance, compatibility or any other claims
related to non-IBM products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To
illustrate them as completely as possible, the examples include

the names of individuals, companies, brands, and products. All of these names are fictitious and
any similarity to the names and addresses used by an actual business enterprise is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate
programming techniques on various operating platforms. You may copy, modify, and distribute
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these sample programs in any form without payment to IBM, for the purposes of developing,
using, marketing or distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply
reliability, serviceability, or function of these programs.

If you are viewing this information softcopy, the photographs and color illustrations may not

appear.

Programming interface information

Programming interface information, if provided, is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that obtain the
services of this program's tools.

However, this information may also contain diagnosis, modification, and tuning information.
Diagnosis, modification and tuning information is provided

to help you debug your application software.
Warning:

Do not use this diagnosis, modification, and tuning information as a programming interface
because it is subject to change.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International
Business Machines Corporation in the United States, other countries, or both. These and other
IBM trademarked terms are

marked on their first occurrence in this information with the appropriate symbol (® or ™),
indicating US registered or common law trademarks owned by IBM at the time this information

was published. Such trademarks

may also be registered or common law trademarks in other countries. A complete and current list
of IBM trademarks is available on the Web at http://www.ibm.com/legal /copytrade.shtml

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Screens are trademarks of Microsoft Corporation in the United States, other
countries, or both.


http://www.ibm.com/legal/copytrade.shtml�
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Java and all Java based trademarks and logos are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.*

UNIX is a registered trademark of The Open Group in the United States and other countries.
Other company, product, or service names may be trademarks or service marks of others.

This product includes software developed by the Eclipse Project (http://www.eclipse.otg).



	Chapter 1. Introduction 
	Chapter 2. Hardware and software prerequisites
	Chapter 3. Installing the adapter
	Deployment prerequisites
	Configuring the Authentication Alias on the process server

	Chapter 4. Tutorial 1:  Retrieving data from SAP (outbound processing) using the simple BAPI Interface 
	Business Case 
	Scenario
	Configuration prerequisites
	Configuring the adapter for outbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts

	Deploying the module in the test environment
	Testing the assembled adapter application  
	Clearing the sample content

	Chapter 5. Tutorial 2:  Updating data in SAP (outbound processing) using the BAPI Work Unit Interface 
	Business Case
	Scenario
	Configuration prerequisites
	Configuring the adapter for outbound processing 
	Setting connection properties for the External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts

	Deploying the module in the test environment
	Testing the assembled adapter application  
	Clearing the sample content

	Chapter 6. Tutorial 3:  Sending data to an SAP system (outbound processing) using the BAPI ResultSet Interface 
	Business Case
	Scenario
	Configuration prerequisites
	Configuring the adapter for outbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts

	Deploying the module in the test environment
	Testing the assembled adapter application  
	Clearing the sample content

	Chapter 7. Tutorial 4:  Sending data from SAP (INBOUND processing) using BAPI 
	Business Case
	Scenario
	Configuration prerequisites
	Configuring the adapter for inbound processing 
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts
	Generating Reference Bindings


	Deploying the module in the test environment
	Testing the assembled adapter application  
	Clearing the sample content

	Chapter 8. Tutorial 5 Sending Structured Query to SAP – Query Outbound Processing
	Configuration prerequisites
	Configuring the adapter for outbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts

	Deploying the module in the test environment
	Testing the assembled adapter application  
	Clearing the sample content

	Chapter 9. Tutorial 6:  Sending data from an SAP system (inbound processing) using the ALE Interface
	Sending IDoc data From SAP – ALE Inbound Processing
	Configuration prerequisites
	Configuring the adapter for inbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts
	Generating Reference Bindings


	Deploying the module in the test environment
	Testing the assembled adapter application  

	Chapter 10. Tutorial 7: Sending data to an SAP system (Outbound processing) using the ALE Interface
	Sending IDoc data to SAP – ALE Outbound Processing
	Scenario
	Configuration prerequisites
	Configuring the adapter for outbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 

	Deploying the module in the test environment
	Testing the assembled adapter application 

	Chapter 11. Preparing to run through the AEP tutorial
	Configuration prerequisites
	Extracting the sample files
	Triggering of events in the SAP System

	Chapter 12. Tutorial 8:  AEP Interface outbound processing 
	Configuration prerequisites
	the adapter for outbound processing 
	Setting connection properties for the External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts

	Deploying the module in the test environment
	Testing the assembled adapter application  
	Clearing the sample content

	Chapter 13. Tutorial 9: AEP Interface Inbound processing 
	Configuration prerequisites
	Configuring the adapter for outbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts
	Generating Reference Bindings


	Deploying the module in the test environment
	Testing the assembled adapter application 
	Clearing the sample content

	Chapter 14. Troubleshooting AEP
	Chapter 15. Tutorial 10: Sending data from the SAP system(inbound processing) and processing it using the ALE-passthrough interface with a Generic IDoc
	Sending IDoc data From SAP – ALE Inbound Processing
	Scenario
	Configuration prerequisites
	<WPS_INSTALL> represents the WebSphere Process Server installation directoryConfiguring the adapter for inbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Reference Bindings


	Deploying the module in the test environment
	Testing the assembled adapter application  

	Chapter 16. Tutorial 11:  Sending data to SAP (outbound processing) using the Queued RFC(qRFC) BAPI Interface 
	Configuration prerequisites
	Configuring the adapter for outbound processing 
	Setting connection properties for the External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts

	Deploying the module in the test environment
	Testing the assembled adapter application  
	Clearing the sample content

	Chapter 17. Tutorial 12:  Sending data from SAP system (INBOUND processing) using qRFC BAPI 
	Configuration prerequisites
	Configuring the adapter for inbound processing 
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts
	Generating Reference Bindings


	Deploying the module in the test environment
	Testing the assembled adapter application  
	Clearing the sample content

	Chapter 18. Tutorial 13:  Generating ALE Audit IDocs per packet (Inbound processing ALE Interface)
	Configuration prerequisites
	Configuring the adapter for inbound processing 
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts
	Generating Reference Bindings


	Deploying the module in the test environment
	Testing the assembled adapter application  

	Chapter 19. Tutorial 14:  ALE Audit support for Pass through IDocs (Generating ALEAUD per IDoc for ALE Pass through IDocs)
	Configuration prerequisites
	Configuring the adapter for inbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 
	Generating Reference Bindings


	Deploying the module in the test environment
	Testing the assembled adapter application  

	Chapter 20. Tutorial 15:  Sending data from SAP (INBOUND processing) using tRFC BAPI
	Configuration prerequisites
	Configuring the adapter for inbound processing 
	Selecting the Business Objects and services to be used with the adapter 
	Generating Business Object definitions and related artifacts
	Generating Reference Bindings


	Deploying the module in the test environment
	Testing the assembled adapter application  

	Chapter 21. Tutorial 16:  Sending data to an SAP system (Outbound processing) using tRFC BAPI
	Configuration prerequisites
	Configuring the adapter for outbound processing 
	Setting connection properties for the New External Service wizard
	Selecting the Business Objects and services to be used with the adapter 

	Deploying the module in the test environment

	Notices 

